Table of Contents

Introduction ............................................................................................................................................... 12

System Requirements and Product Support ................................................................................... 12

About This User Guide ....................................................................................................................... 13

Important Notes .................................................................................................................................. 14

Installation ........................................................................................................................................... 14
  Windows® ........................................................................................................................................ 14
  Mac® OS X® ...................................................................................................................................... 15
  Unlocking the MPC Software ............................................................................................................. 16

MPC Hardware Overview .................................................................................................................... 17

MPC Renaissance ............................................................................................................................... 17
  Top Panel ........................................................................................................................................ 17
  Front Panel ...................................................................................................................................... 23
  Rear Panel ....................................................................................................................................... 23

MPC Studio .......................................................................................................................................... 25
  Top Panel ........................................................................................................................................ 25
Quick Start / Tutorial ................................................................................................................................ 31

Starting Up ............................................................................................................................................... 31

Creating a Drum Kit .................................................................................................................................... 32

Recording a Drum Sequence .................................................................................................................... 33

Organizing Samples and Editing Note Events ...................................................................................... 34

Making Basic Sound Edits ........................................................................................................................ 36

Recording a Bass Track ............................................................................................................................... 37

Creating a Song ......................................................................................................................................... 41

Exporting the Song ................................................................................................................................... 41

Other Features Explained ......................................................................................................................... 42

Step Sequencer .......................................................................................................................................... 42

Drum Loops and Chop Mode .................................................................................................................. 43

Pad Muting and Track Muting .................................................................................................................. 46

Sample Recording ..................................................................................................................................... 48

Sample Editing .......................................................................................................................................... 49

Recording Automation with the Q-Link Knobs ......................................................................................... 50

Using MPC as a Plugin ............................................................................................................................. 51
General Features................................................................................................................................ 53
Adjusting the Controls..................................................................................................................... 53
Program Types ................................................................................................................................ 55
  About Programs ............................................................................................................................ 55
  Drum Programs ............................................................................................................................ 55
  Keygroup Programs ....................................................................................................................... 57
  Plugin Programs ............................................................................................................................ 59
  MIDI Programs ............................................................................................................................. 63
Browsers .......................................................................................................................................... 64
  File Browser ................................................................................................................................ 64
  Expansion Browser ....................................................................................................................... 67
Mode Tab Section ........................................................................................................................... 69
Transport Section ........................................................................................................................... 73
Grid View ......................................................................................................................................... 77
  Entering and Editing Note Events ............................................................................................... 82
  Recording Automation ................................................................................................................ 85
  Manually Entering and Editing Automation ............................................................................. 88
List View .......................................................................................................................................... 89
  Entering and Editing Events ......................................................................................................... 91
  Entering Automation .................................................................................................................... 94
  Editing Automation ...................................................................................................................... 94
Software Menus ............................................................................................................................ 95
  File Menu ................................................................................................................................... 95
  Edit Menu ................................................................................................................................... 98
  Metronome Menu ....................................................................................................................... 106
  Time Correct Menu .................................................................................................................... 107
  Tools Menu ................................................................................................................................ 109
  View Menu ................................................................................................................................ 110
  Help Menu ................................................................................................................................ 111
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Mode</td>
<td>112</td>
</tr>
<tr>
<td>Q-Link Section</td>
<td>113</td>
</tr>
<tr>
<td>Program Mode</td>
<td>114</td>
</tr>
<tr>
<td>FX Mode</td>
<td>116</td>
</tr>
<tr>
<td>Pad Bank Section</td>
<td>117</td>
</tr>
<tr>
<td>Sequence Section</td>
<td>118</td>
</tr>
<tr>
<td>Track Section</td>
<td>120</td>
</tr>
<tr>
<td>Drum Programs and Keygroup Programs</td>
<td>121</td>
</tr>
<tr>
<td>MIDI Programs</td>
<td>121</td>
</tr>
<tr>
<td>Plugin Programs</td>
<td>123</td>
</tr>
<tr>
<td>Program Channel Strip</td>
<td>124</td>
</tr>
<tr>
<td>Project Information</td>
<td>126</td>
</tr>
<tr>
<td>Program Edit Mode</td>
<td>129</td>
</tr>
<tr>
<td>Master Section</td>
<td>131</td>
</tr>
<tr>
<td>Simultaneous Play Section (Drum Programs Only)</td>
<td>133</td>
</tr>
<tr>
<td>Mute Target Section (Drum Programs Only)</td>
<td>133</td>
</tr>
<tr>
<td>Keygroup Play Modes Section (Keygroup Programs Only)</td>
<td>134</td>
</tr>
<tr>
<td>Key Group Section (Keygroup Program Only)</td>
<td>135</td>
</tr>
<tr>
<td>Edit Layers Section</td>
<td>137</td>
</tr>
<tr>
<td>Filter Section</td>
<td>141</td>
</tr>
<tr>
<td>Anatomy of an Envelope</td>
<td>143</td>
</tr>
<tr>
<td>Pad Play Modes Section (Drum Programs Only)</td>
<td>144</td>
</tr>
<tr>
<td>Velocity Sensitivity Section</td>
<td>145</td>
</tr>
<tr>
<td>LFO Section</td>
<td>146</td>
</tr>
<tr>
<td>Controller Mod Section (Keygroup Program Only)</td>
<td>147</td>
</tr>
<tr>
<td>Insert Effects Section</td>
<td>148</td>
</tr>
<tr>
<td>Pad/Keygroup Audio Route Section</td>
<td>149</td>
</tr>
<tr>
<td>Program Edit Mode for MIDI Programs and Plugin Programs</td>
<td>149</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Program Mixer Mode</td>
<td>150</td>
</tr>
<tr>
<td>Show/Hide Buttons</td>
<td>151</td>
</tr>
<tr>
<td>Routing</td>
<td>152</td>
</tr>
<tr>
<td>Levels</td>
<td>152</td>
</tr>
<tr>
<td>Pad (Drum Programs only)</td>
<td>153</td>
</tr>
<tr>
<td>Panning</td>
<td>153</td>
</tr>
<tr>
<td>Mute and Solo</td>
<td>153</td>
</tr>
<tr>
<td>Automation (Program Channel strip only)</td>
<td>154</td>
</tr>
<tr>
<td>Effects</td>
<td>155</td>
</tr>
<tr>
<td>Insert Effects</td>
<td>155</td>
</tr>
<tr>
<td>Send Effects</td>
<td>155</td>
</tr>
<tr>
<td>Track Mixer Mode</td>
<td>156</td>
</tr>
<tr>
<td>Show/Hide Buttons</td>
<td>157</td>
</tr>
<tr>
<td>Program Assignment</td>
<td>158</td>
</tr>
<tr>
<td>Levels</td>
<td>159</td>
</tr>
<tr>
<td>Panning</td>
<td>161</td>
</tr>
<tr>
<td>Mute and Solo</td>
<td>162</td>
</tr>
<tr>
<td>Automation (Program Channel strips only)</td>
<td>163</td>
</tr>
<tr>
<td>Effects</td>
<td>164</td>
</tr>
<tr>
<td>Insert Effects</td>
<td>164</td>
</tr>
<tr>
<td>Send Effects</td>
<td>164</td>
</tr>
<tr>
<td>Master Effects</td>
<td>165</td>
</tr>
<tr>
<td>Track View Mode</td>
<td>166</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Sequence Mode</td>
<td>168</td>
</tr>
<tr>
<td>Triggering Sequences</td>
<td>169</td>
</tr>
<tr>
<td>Sequence Playlist</td>
<td>169</td>
</tr>
<tr>
<td>Pad Bank Section</td>
<td>170</td>
</tr>
<tr>
<td>Next Sequence Section</td>
<td>171</td>
</tr>
<tr>
<td>Project Information</td>
<td>172</td>
</tr>
<tr>
<td>Sample Record Mode</td>
<td>173</td>
</tr>
<tr>
<td>Setting Up to Record with MPC Renaissance</td>
<td>174</td>
</tr>
<tr>
<td>Waveform Display</td>
<td>175</td>
</tr>
<tr>
<td>Record Controls</td>
<td>176</td>
</tr>
<tr>
<td>Threshold</td>
<td>176</td>
</tr>
<tr>
<td>Record Arm</td>
<td>176</td>
</tr>
<tr>
<td>Input Source</td>
<td>177</td>
</tr>
<tr>
<td>Input Monitor</td>
<td>177</td>
</tr>
<tr>
<td>Sample Length</td>
<td>177</td>
</tr>
<tr>
<td>Sample Rec and Sample Stop</td>
<td>178</td>
</tr>
<tr>
<td>Direct Record</td>
<td>179</td>
</tr>
<tr>
<td>Project Information</td>
<td>180</td>
</tr>
</tbody>
</table>
## Appendix

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard Shortcuts</td>
<td>238</td>
</tr>
<tr>
<td>File Menu</td>
<td>239</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>239</td>
</tr>
<tr>
<td>Time Correct Menu</td>
<td>240</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>240</td>
</tr>
<tr>
<td>View Menu</td>
<td>241</td>
</tr>
<tr>
<td>Transport Controls</td>
<td>241</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>241</td>
</tr>
<tr>
<td>Effects and Parameters</td>
<td>242</td>
</tr>
<tr>
<td>Reverbs</td>
<td>242</td>
</tr>
<tr>
<td>Delays</td>
<td>247</td>
</tr>
<tr>
<td>Flangers</td>
<td>253</td>
</tr>
<tr>
<td>Chorus</td>
<td>254</td>
</tr>
<tr>
<td>Autopans</td>
<td>255</td>
</tr>
<tr>
<td>Tremolos</td>
<td>256</td>
</tr>
<tr>
<td>Phasers</td>
<td>257</td>
</tr>
<tr>
<td>HP (High-Pass) Filters</td>
<td>258</td>
</tr>
<tr>
<td>LP (Low-Pass) Filters</td>
<td>260</td>
</tr>
<tr>
<td>Parametric EQs</td>
<td>262</td>
</tr>
<tr>
<td>Distortions</td>
<td>264</td>
</tr>
<tr>
<td>Compressors</td>
<td>267</td>
</tr>
<tr>
<td>Bit Reducers</td>
<td>271</td>
</tr>
<tr>
<td>Other</td>
<td>272</td>
</tr>
</tbody>
</table>
Introduction

Thanks for choosing the MPC! Fusing Akai Professional's legendary MPC layout and workflow with the power of your computer, MPC software is an unrivaled instrument for music production.

**MPC Renaissance** is a fully integrated hardware-software system, allowing you to create using classic hardware controls and an integrated pop-up display, while its exclusive MPC software empowers you with unprecedented, expandable production capabilities on your Mac or PC.

**MPC Studio** offers the most streamlined MPC experience yet. At under one-inch thin, with low-profile controls and a brushed aluminum body, it’s made to move. MPC Studio merges real MPC pads, iconic workflow, and the same MPC software used by MPC Renaissance to give you a fully integrated portable production solution.

Welcome to the MPC family.

The Akai Professional Team

System Requirements and Product Support

For complete system requirements, compatibility information, and product registration, visit the Akai Professional website: [akaipro.com](http://akaipro.com).

For additional support, visit [akaipro.com/support](http://akaipro.com/support).
About This User Guide

This manual was written to help you get familiar with the MPC hardware and software. For consistency and to help prevent confusion, the terminology throughout is based on the MPC parameter names. You will find the various terms explained in the Appendix > Glossary chapter at the end of this manual.

We also used a uniform set of symbols to show topics of particular interest or significance:

**Information:** Important or helpful information on a given topic.

**Hardware:** How to use a software feature with your MPC hardware’s controls. Note that these paragraphs are not the only parts of the manual that mention the MPC hardware!

All buttons, controls, and parameters are highlighted in **bold** characters throughout the manual.

**Examples:**
- Press the **Prog Edit** button.
- Turn the **Level** dial.
- Click the **Trig** menu.

Specific settings or values are indicated in **italic** characters.

**Examples:**
- The **Velocity** ranges from 0 to 127.
- Set your **Sample Play** to One-Shot or Note-On.
- Click the **Pad Audio Route** menu, and select **Out 1,2**.

Some parts of this manual refer to other relevant chapters or sections, which are cited in **bold**, **italic**, **blue** characters. Click the text to skip immediately to that section.

**Examples:**
- Read the **Important Notes** section before proceeding.
- For more information about installing the necessary drivers and software, please see the **Installation** section.
- To learn more about using send effects, please see the **Effects > Send Effects** chapter.
**Important Notes**

- Read the included *Akai Professional Safety & Warranty Manual* before using the MPC hardware.
- Before getting started and connecting devices to the MPC hardware or turning the hardware on/off, make sure all devices are switched off.
- Before connecting the MPC hardware to your computer, install the drivers and software. Visit akaipro.com to download the latest versions (recommended), or insert the included DVD. Refer to the *Installation* section for more information.

**Installation**

Before installing the MPC software, make sure your computer meets the system requirements described at akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin.

**Windows®**

**From a DVD:**

1. Power on your computer and operating system, and insert the DVD into your DVD drive. If you have enabled the Autostart function in Windows, the installer will start automatically and you can proceed with Step 5 below. If not, please proceed as follows:
2. Launch the Explorer or open the window *My Computer*.
3. Double-click the icon for the drive that holds the DVD.
4. Double-click the *MPC* installer icon. This launches a special installation program.
5. Follow the on-screen instructions.

**Important:** After installing the MPC software, you need to unlock the program on your computer. Please refer to *Unlocking the MPC Software*. 
From a downloaded installer file:
1. Open the folder where the downloaded .zip file is located.
2. Double-click the file to extract it.
3. Double-click the MPC installer icon. This launches a special installation program.
4. Follow the on-screen instructions.
   **Important**: After installing the MPC software, you need to unlock the program on your computer. Please refer to *Unlocking the MPC Software*.

**Mac® OS X®**

From a DVD:
1. Power on your computer and operating system, and disable any system activity monitoring software or extension. Then, insert the DVD into your computer’s DVD drive.
2. If required, double-click the MPC icon to view the DVD’s contents.
3. Double-click the MPC installer icon. This launches a special installation program.
4. Follow the on-screen instructions.
   **Important**: After installing the MPC software, you need to unlock the program on your computer. Please refer to *Unlocking the MPC Software*.

From a downloaded installer file:
1. Open the folder where the downloaded .zip file is located.
2. Double-click the file to extract it.
3. Double-click the MPC installer icon. This launches a special installation program.
4. Follow the on-screen instructions.
   **Important**: After installing the MPC software, you need to unlock the program on your computer. Please refer to *Unlocking the MPC Software*. 
Unlocking the MPC Software

Follow these steps to unlock the MPC software before using it.

1. Connect your MPC hardware to a USB port on your computer. If you are using MPC Renaissance, connect it to a power source, too.
2. Power on the MPC hardware.
3. Open the MPC software.
4. In the dialogue box that appears, click Unlock Now.
5. Enter your information in the window that appears.
6. If your computer is connected to the Internet, click Unlock Now, and enjoy your MPC!
   If your computer is not connected to the Internet, follow these additional steps:
7. Click Use Web Form.
8. The window that appears will have your name, serial number, and software ID number. Click Save Details to save this information as a .txt file, or copy the information from each field into another file of your choosing.
9. On a computer connected to the Internet, go to authorizations.akaipro.com/MPC, enter the copied information, and click Unlock My MPC.
10. Copy the unlock code from the window that appears.
11. In your MPC software, go to the window from Step 5 and click Enter Code.
12. Enter your name and the unlock code generated by the webpage.
13. Click Unlock, and enjoy your MPC!
MPC Hardware Overview

This chapter explains the features and functions of your MPC hardware: the MPC Renaissance or the MPC Studio.

MPC Renaissance

Top Panel
Navigation and Data Entry Controls

1. **Display:** This LCD shows all the information relevant to MPC Renaissance’s current operation. Much of this information is also shown in the software. Use the **Cursor Buttons** to navigate through the display, and use the **Data Dial**, and +/- buttons to adjust the currently selected setting/parameter. Use the **Mode** buttons to change what page is shown, and use the **Function Buttons** to change what tab is shown.

   **Note:** You can adjust the display contrast by holding down **Shift** and turning the **Data Dial**.

2. **Function Buttons:** Press one of these buttons to select its corresponding tab, shown above the button in the display.

3. **Cursor Buttons:** Use these buttons to navigate through the fields of menus and options shown in the display.

4. **Data Dial:** Use this dial to scroll through the available menu options or adjust the parameter values of the selected field in the **Display**.

5. **-/+:** Press these buttons to increase/decrease the value of the selected field in the display.

6. **Numeric Keypad:** If the selected field in the **Display** is a number, use these numbered buttons as a standard numeric keypad to enter a value. Press the keypad's **Enter** to enter it.

7. **Undo / Redo:** Press this button to undo your last action. Hold down **Shift** and press this button to redo the last action you undid.

Pad and Q-Link Knob Controls

8. **Q-Link Knobs:** Use these touch-sensitive knobs to adjust various parameters and settings. The LEDs surrounding each knob indicate the knob’s current position.

9. **Q-Link Trigger:** Hold this button down, then touch one of the **Q-Link Knobs** to make that knob’s parameter’s value jump to its minimum or maximum (depending on the Trig parameter in the software).

10. **Pads:** Use these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). To disable (or re-enable) these lights, press **Pad Assign** then **F6 (Velo Col)**.
11. **Pad Bank Buttons:** These 4 buttons switch among Pad Banks A–H. Between these 8 banks with 16 pads per bank, you can access up to 128 MIDI events using the pads.

12. **Pad Assign / Pad Copy:** Press this button to assign a sample to a pad. In the display, the 4 x 4 grid that appears represents the 16 pads. Use the **Cursor Buttons** to navigate through the grid, and use the **Data Dial** or +/- buttons to select a Program (when the Program field is highlighted) or a sample (when a pad is highlighted).

You can use this button to copy the samples and parameters from one pad to another. Hold **Shift** and press this button to open the **Copy Pad** window. In the **From Pad** field, press the "source" pad. Use the **Cursor Buttons** to select the **To Pad** field, and then press the "destination" pads. Press **F5 (Do It)**—the samples and parameters will be copied automatically from the source pad to the destination pad.

13. **Full Level / Half Level:** Press this button to activate/deactivate Full Level. When activated, the pads always play back at a maximum velocity (127), no matter how hard or soft you press them.

Hold down **Shift** and press this button to activate/deactivate Half Level. When activated, the pads always play back at half-velocity (63).

14. **16 Level:** Press this button to activate/deactivate 16 Level. When activated, the last pad that was pressed will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed a specific value (ascending in value from the lowest to highest pad), regardless of how hard you press each pad. In the software, in the window that appears, click the **Type** menu to select the parameter: **Velocity**, **Tune**, **Filter**, **Layer**, **Attack**, or **Decay**.

You can change the pad by clicking the **Pad** drop-down menu in the window that appears. Alternatively, you can press and hold the **16 Level** button, press the desired pad, and then release both.

15. **Note Repeat / Latch:** Hold this button down and press a pad to retrigger that pad’s sample at a rate based on the current Tempo and Time Correct settings (the available Time Correct settings will appear in the display, which you can select with the **Function Buttons**). Hold down **Shift** and press this button to latch the Note Repeat feature. Alternatively, press the **Note Repeat** button twice in succession. When latched, the button does not need to be held down for Note Repeat to be activated. Press **Note Repeat** once more to unlatch it.
Mode / View Controls

16. **Shift**: Hold this button down to access some buttons' secondary functions (indicated by orange writing). You can also double-press it to “latch” it for a few seconds. To unlatch it, press it once more or wait a few seconds for it to unlatch automatically.

17. **Main / Track**: Press this button to enter Main Mode in the display and software. Hold down Shift and press this button to enter Track View Mode in the display and software.

18. **Browser / Save**: Press this button to view the File Browser in the display. Hold down Shift and press this button to save the current Project (including its samples, Programs, Sequences, and Songs).

19. **Prog Edit / Q-Link**: Press this button to enter Program Edit Mode in the display and software. Hold down SHIFT and press this button to assign a parameter to a Q-Link Knob: use the Cursor Buttons to select the desired Q-Link Knob, then use the Data Dial or +/- buttons to select the desired parameter.

20. **Prog Mix / Track Mix**: Press this button to enter Program Mixer Mode in the display and software. Hold down Shift and press this button to enter Track Mixer Mode in the display and software.

21. **Seq Edit / Effects**: Press this button to enter Sequence Edit Mode. Hold down Shift and press this button to enter the Effects page on the hardware, where you can select and route effects as well as edit effects’ parameters.

22. **Sample Edit / Sample Rec**: Press this button to enter Sample Edit Mode in the display and software. Hold down Shift and press this button to enter Sample Record Mode in the display and software.

23. **Song / Other**: Press this button to enter Song Mode in the display and software. Hold down Shift and press this button to enter MIDI Control Mode, which lets you edit various MIDI parameters for the pads, Q-Link Knobs, and certain buttons on your hardware while in this mode.

24. **Step Seq**: Press this button to enter Step Sequence Mode in the display and software.

25. **Next Seq**: Press this button to enter Next Sequence Mode in the display and software.

26. **Track Mute / Pad Mute**: Press this button to enter Track Mute Mode in the display and software. Hold Shift and press this button to enter Pad Mute Mode in the display and software.
27. **Window / Full Screen:** When this button is lit, it means the selected field in the display contains additional functions; press this button to access them. Use the Function Buttons, Cursor Buttons, and Data Dial or +/- buttons to execute (or cancel) these additional functions.

   Hold **Shift** and press this button to switch between Full Screen and Half Screen Modes in the software. In Full Screen Mode, the workspace occupies the whole window. In Half Screen Mode, the parameter controls (Q-Link Knobs, pads, Sequence and Track information, Project Information, etc.) are shown underneath the workspace.

28. **Project / Folder 1:** Press this button to view only Project files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 1 shortcut.

29. **Sequence / Folder 2:** Press this button to view only Sequence files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 2 shortcut.

30. **Program / Folder 3:** Press this button to view only Program files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 3 shortcut.

31. **Sample / Folder 4:** Press this button to view only Sample files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 4 shortcut.

32. **No Filter / Folder 5:** Press this button to view all files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 5 shortcut.

**Transport and Recording Controls**

33. **Play:** Press this button to play the Sequence from the audio pointer’s current position.

34. **Play Start:** Press this button to play the Sequence from its start point.

35. **Stop:** Press this button to stop playback.

36. **Rec:** Press this button to record-arm the Sequence. Press **Play** or **Play Start** to start recording. Recording in this way (rather than using **Overdub**) erases the events of the current Sequence. After the Sequence plays through once while recording, **Overdub** will be enabled.

37. **Overdub:** Press this button to enable Overdub, which allows you to record note events in a Sequence without overwriting any previously recorded note events. You can enable Overdub either before or during recording.

38. < / > ( |=< / >|): Use these buttons to move the audio pointer left/right, one step at a time. Hold **Locate** and press one of these buttons to move the audio pointer to the previous/next event in the Sequence Grid.
39. **<< / >> (Start / End):** Use these buttons to move the audio pointer left/right, one bar at a time. Hold Locate and press one of these buttons to move the audio pointer to the start or end of the Sequence Grid.

40. **Locate:** Hold this button down to activate the secondary functions of the < / > and << / >> buttons (i.e., |< / >| and Start / End, respectively).

41. **Erase:** As a Sequence is playing, hold this button down and press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your Sequence without having to stop playback.

42. **Tap Tempo:** Press this button in time with the desired tempo to enter a new tempo (in BPM) in the software.

**I/O and Level Controls**

43. **Mic In / Phono In Switch:** Use this switch to select the Mic In or Phono In jacks on the rear panel. If you are using a mic or other line-level audio source connected to the Mic In jacks, select Mic In. If you are using a phono-level device like a turntable connected to the Phono In jacks, select Phono In.

44. **Rec Gain:** Use this knob to adjust the gain of the incoming signal from the Mic In or Phono In jacks on the rear panel. Monitor the recording level by viewing the level meter (LEDs) above the Mic In / Phono In Switch. Be careful when setting this knob at higher levels, which can cause the signal to distort.

45. **Direct Mon:** Use this knob to adjust the balance between the Input and Comp signals in the headphones. The Input signal consists of the Mic In or Phono In jacks—turn the knob all the way to Input for zero-latency direct monitoring. The Comp signal is the normal software playback. When not recording, we recommend turning this knob all the way to the Comp position.

46. **Main Volume:** Use this knob to adjust the volume level of the Stereo Out jacks.

47. **Vintage Mode:** Press this to toggle through the available Vintage Modes. The MPC3000 and MPC60 settings emulate the sounds of those classic MPCs, while the Other setting emulates the sound of vintage sampling drum machines. When none of the LEDs are lit, Vintage Mode is off.
Front Panel

1. **Footswitch Inputs:** Connect optional 1/4" TS footswitches to these inputs.

2. **Mix Knob:** Use this knob to adjust the balance between the **Main** and **Assign** signals in your headphones. The **Main** signal is the **Stereo Outs**. The **Assign** signal is the **Assignable Mix Outs 1 and 2**.

3. **Headphones:** Connect your headphones (not included) to one of these standard TRS outputs (1/8" or 1/4"). Use the **Mix Knob** to determine what signal is heard in the headphones.

4. **Headphones Volume:** Use this knob to adjust the headphone volume.

Rear Panel

1. **Power Input:** Connect a 12V DC, 2A power adapter (center pin positive) to this jack then into an electrical outlet.

2. **Power Adapter Restraint:** You can secure a power adapter cable to this restraint to prevent it from accidentally unplugging.

3. **Power Switch:** Turns MPC Renaissance’s power on/off.

4. **Computer USB Port:** Use the included USB cable to connect this high-retention-force USB port to an available USB port on your computer. This connection allows MPC Renaissance to send/receive MIDI and audio data to/from the MPC software.

5. **USB Hub Outputs:** You can connect additional USB devices (controllers, hard drives, etc.) to these powered, high-speed USB 2.0 ports. In addition to being an audio interface, these ports allow MPC Renaissance to function as a powered USB hub when it is powered on.
6. **Stereo Out**: Connect these 1/4” TRS outputs to your speaker system (not included). The signal sent out of these outputs is the main mix. In the MPC software, you can set what is routed to these outputs in the Program Mixer tab, by selecting 1,2 as the **Out** for one pad or multiple pads.

7. **Assignable Mix Out**: Connect these 1/4” TRS outputs to an external mixer (not included). The signal sent from these outputs is full-volume (0 dB). In the MPC software, you can set what is routed to these outputs in the Program Mixer tab, by selecting 3,4 as the **Out** for one pad or multiple pads.

8. **S/PDIF In/Out**: Use standard RCA cables to connect these jacks to devices that can send/receive digital audio.

9. **Mic In**: Connect an external sound source or microphone to these jacks using standard 1/4” TRS or XLR cables. Make sure to set the **Mic / Line Switch** appropriately.

10. **Mic / Line Switch**: Set this switch appropriately for the device you connected to the **Mic In** jacks. If your sound source is a microphone, set it to **Mic**. If your sound source is a line-level device, like an external mixer or keyboard, set it to **Line**.

11. **Phantom Power Switch**: This switch activates and deactivates phantom power. When activated, phantom power supplies +48V to both **Mic In** inputs. Please note that most dynamic microphones do not require phantom power, while most condenser microphones do. Consult your microphone’s documentation to find out whether it needs phantom power.

12. **Phono In**: Connect these RCA inputs to an external sound source (e.g., a turntable, CD player, etc.). Make sure to set the **Phono / Line Switch** appropriately.

13. **Phono / Line Switch**: Flip this switch to the appropriate position, depending on the device connected to the **Phono In** jacks. If you are using phono-level turntables, set this switch to **Phono** to provide the additional amplification needed for phono-level signals. If using a line-level device, such as a CD player or sampler, set this switch to **Line**.

14. **Ground Terminal**: If you connected a phono-level turntable to the **Phono In** jacks and are hearing a low hum or buzz, this could mean that the turntable is not grounded. If the turntable has a grounding wire, connect it to this terminal. **Note**: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be connected to the grounding terminal.

15. **MIDI In**: Use a five-pin MIDI cable to connect the MIDI Out of an optional external MIDI device to the **MIDI In** of MPC Renaissance.

16. **MIDI Out**: Use a five-pin MIDI cable to connect the **MIDI Out** of MPC Renaissance to the MIDI In of an optional external device.
Power and I/O

1. **Computer USB Port**: Use the included USB cable to connect this high-retention-force USB port to an available USB port on your computer. This connection allows MPC Studio to send/receive MIDI and audio data to/from the MPC software.

2. **Power Switch**: Turns MPC Studio’s power on/off.

3. **MIDI In**: Use the included 1/8”-MIDI adapter and a five-pin MIDI cable to connect the MIDI Out of an optional external MIDI device to the **MIDI In** of MPC Studio.

4. **MIDI Out**: Use the included 1/8”-MIDI adapter and a five-pin MIDI cable to connect the **MIDI Out** of MPC Studio to the MIDI In of an optional external device.

   **Important**: Do **NOT** connect audio devices (e.g., headphones, monitors, etc.) to the 1/8” **MIDI In** or **MIDI Out** jacks. Use the included 1/8”-MIDI adapters to connect MIDI devices only.

Navigation and Data Entry Controls

5. **Display**: This LCD shows all the information relevant to MPC Studio’s current operation. Much of this information is also shown in the software. Use the **Cursor Buttons** to navigate through the display, and use the **Data Dial**, and +/- buttons to adjust the currently selected setting/parameter. Use the **Mode** buttons to change what page is shown, and use the **Function Buttons** to change what tab is shown.

   Press and hold **Shift** and turn the **Data Dial** to adjust the contrast of the display.

6. **Function Buttons**: Press one of these buttons to select its corresponding tab, shown above the button in the display.

7. **Cursor Buttons**: Use these buttons to navigate through the fields of menus and options shown in the DISPLAY.

8. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field in the display.

9. **+-/+**: Press these buttons to increase/decrease the value of the selected field in the display.

10. **Numeric**: If the selected field in the display is a number, you can press **Numeric** and use the pads as a standard numeric keypad to enter a value. The numbers are printed in green above the pads.

11. **Undo / Redo**: Press this button to undo your last action. Hold down **Shift** and press this button to redo the last action you undid.
12. **Q-Link Knobs:** Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control one column of parameters at a time. Use the **Scroll Knob** above them to change which column or row of parameters they currently control.

In modes where the display shows a "4 x 4" array of parameters, you will see an additional indicator on the top or left side of the array, indicating the currently controlled row/column.

The Q-Link Knobs control **columns** of parameters in Main Mode, Program Edit Mode, Track View Mode, Sample Edit Mode, and Step Sequence Mode.

The Q-Link Knobs control **rows** of parameters in Program Mixer Mode and Track Mixer Mode.

13. **Scroll Knob:** Use this knob to change which column of parameters the Q-Link Knobs currently control.

14. **Q-Link Trigger:** Hold this button down, then touch one of the Q-Link Knobs to make that knob’s parameter’s value jump to its minimum or maximum (depending on the Trig parameter in the software).

15. **Pads:** Use these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). To disable (or re-enable) these lights, press **Pad Assign** then **F6 (Velo Col).**

If the selected field in the display is a number, you can press **Numeric** and use the pads as a standard numeric keypad to enter a value. The numbers are printed in green above the pads.

16. **Pad Bank Buttons:** These 4 buttons switch among Pad Banks A–H (press and hold **Shift** to access Banks E–H). Between these 8 banks with 16 pads per bank, you can access up to 128 MIDI events using the pads.
17. **Pad Assign / Pad Copy:** Press this button to assign a sample to a pad. In the display, the 4 x 4 grid that appears represents the 16 pads. Use the Cursor Buttons to navigate through the grid, and use the Data Dial or +/- buttons to select a Program (when the Program field is highlighted) or a sample (when a pad is highlighted).

You can use this button to copy the samples and parameters from one pad to another. Hold Shift and press this button to open the Copy Pad window. In the From Pad field, press the "source" pad. Use the Cursor Buttons to select the To Pad field, and then press the "destination" pads. Press F5 (Do It)—the samples and parameters will be copied automatically from the source pad to the destination pad.

18. **Full Level / Half Level:** Press this button to activate/deactivate Full Level. When activated, the pads always play back at a maximum velocity (127), no matter how hard or soft you press them. Hold down Shift and press this button to activate/deactivate Half Level. When activated, the pads always play back at half-velocity (63).

19. **16 Level:** Press this button to activate/deactivate 16 Level. When activated, the last pad that was pressed will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at the values shown in the diagram on the right, regardless of how hard you press them. In the software, in the window that appears, click the Type menu to select the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay.

You can change the pad by clicking the Pad drop-down menu in the window that appears. Alternatively, you can press and hold the 16 Level button, press the desired pad, and then release both.

20. **Note Repeat / Latch:** Hold this button down and press a pad to retrigger that pad’s sample at a rate based on the current Tempo and Time Correct settings (the available Time Correct settings will appear in the display, which you can select with the Function Buttons). Hold down Shift and press this button to latch the Note Repeat feature. Alternatively, press the Note Repeat button twice in succession. When latched, the button does not need to be held down for Note Repeat to be activated. Press Note Repeat once more to unlatch it.

**Mode and View Controls**

21. **Shift:** Hold this button down to access some buttons’ secondary functions (indicated by orange writing). You can also double-press it to “latch” it for a few seconds. To unlatch it, press it once more or wait a few seconds for it to unlatch automatically.

22. **Main / Track:** Press this button to enter Main Mode in the display and software. Hold down Shift and press this button to enter Track View Mode in the display and software.
23. **Browser / Save**: Press this button to view the File Browser in the display. Hold down Shift and press this button to save the current Project (including its samples, Programs, Sequences, and Songs).

24. **Prog Edit / Q-Link**: Press this button to enter Program Edit Mode in the display and software. Hold down Shift and press this button to assign a parameter to a Q-Link Knob, use the Cursor Buttons to select the desired Q-Link Knob, then use the Data Dial or -/+ buttons to select the desired parameter.

25. **Prog Mix / Track Mix**: Press this button to enter Program Mixer Mode in the display and software. Hold down Shift and press this button to enter Track Mixer Mode in the display and software.

26. **Seq Edit / Effects**: Press this button to enter Sequence Edit Mode. Hold down Shift and press this button to enter the Effects page in the display, where you can select and route effects as well as edit effects’ parameters.

27. **Sample Edit / Sample Rec**: Press this button to enter Sample Edit Mode in the display and software. Hold down Shift and press this button to enter Sample Record Mode in the display and software.

28. **Song / Other**: Press this button to enter Song Mode in the display and software. Hold down Shift and press this button to enter MIDI Control Mode, which lets you edit various MIDI parameters for the pads, Q-Link Knobs, and certain buttons on your hardware while in this mode.

29. **Step Seq**: Press this button to enter Step Sequence Mode in the display and software.

30. **Next Seq**: Press this button to enter Next Sequence Mode in the display and software.

31. **Track Mute / Pad Mute**: Press this button to enter Track Mute Mode in the display and software. Hold Shift and press this button to enter Pad Mute Mode in the display and software.

32. **Window / Full Screen**: When this button is lit, it means the selected field in the display contains additional functions; press this button to access them. Use the Function Buttons, Cursor Buttons, and Data Dial or -/+ buttons to execute (or cancel) these additional functions. Hold Shift and press this button to switch between Full Screen and Half Screen Modes in the software. In Full Screen Mode, the workspace occupies the whole window. In Half Screen Mode, the parameter controls (Q-Link Knobs, pads, Sequence and Track information, Project Information, etc.) are shown underneath the workspace.

33. **Project / Folder 1**: Press this button to view only Project files in the File Browser. Hold down Shift and press this button to select the File Browser’s Folder 1 shortcut.
34. **Sequence / Folder 2:** Press this button to view only Sequence files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 2 shortcut.

35. **Program / Folder 3:** Press this button to view only Program files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 3 shortcut.

36. **Sample / Folder 4:** Press this button to view only Sample files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 4 shortcut.

37. **No Filter / Folder 5:** Press this button to view all files in the File Browser. Hold down **Shift** and press this button to select the File Browser’s Folder 5 shortcut.

**Transport and Recording Controls**

38. **Play:** Press this button to play the Sequence from the audio pointer’s current position.

39. **Play Start:** Press this button to play the Sequence from its start point.

40. **Stop:** Press this button to stop playback.

41. **Rec:** Press this button to record-arm the Sequence. Press **Play** or **Play Start** to start recording. Recording in this way (rather than using **Overdub**) erases the events of the current Sequence. After the Sequence plays through once while recording, Overdub will be enabled.

42. **Overdub:** Press this button to enable Overdub, which allows you to record note events in a Sequence without overwriting any previously recorded note events. You can enable Overdub either before or during recording.

43. **< / > ( |< / >| )** Use these buttons to move the audio pointer left/right, one step at a time. Hold **Locate** and press one of these buttons to move the audio pointer to the previous/next event in the Sequence Grid.

44. **<< / >> (Start / End):** Use these buttons to move the audio pointer left/right, one bar at a time. Hold **Locate** and press one of these buttons to move the audio pointer to the start or end of the Sequence Grid.

45. **Go To:** Hold this button down to activate the secondary functions of the<br>**< / >** and **<< / >>** buttons (i.e., **|< / >|** and **Start / End**, respectively).

46. **Erase:** As a Sequence is playing, hold this button down and press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your Sequence without having to stop playback.

47. **Tap Tempo:** Press this button in time with the desired tempo to enter a new tempo (in BPM) in the software.
Quick Start / Tutorial

This chapter should help you to familiarize yourself with some basic MPC features. To get the most out of this tutorial, we recommend reproducing each of the described steps.

The MPC hardware’s display reflects what it is controlling in the software, but due to space and character limitations, the hardware display is slightly different (e.g., parameter names may be abbreviated, the layout may be different or spread across multiple tabs, etc.).

Hardware:

- You can navigate through the MPC hardware display by using the MPC hardware’s Cursor Buttons. When a parameter is selected, you can change it by turning the hardware’s Data Dial or using the +/- buttons.

- When the MPC hardware display shows a series of parameters that cannot be selected with the Cursor Buttons, that means it is showing you what the Q-Link Knobs are controlling. When you touch a Q-Link Knob, the parameter’s name and setting will appear in the upper-right corner of the hardware display. Turn the knob to adjust it (If the Q-Link Knob does not control any parameter in the display, this area will show the Q-Link Knob number and no text).

MPC Studio users: MPC Studio’s Q-Link Knobs control one column of parameters at a time. Whenever this manual instructs you to use the Q-Link Knobs to adjust parameters, you can use the Scroll Knob (above the Q-Link Knobs) to move through the different columns.

On the following pages we will create a short song to show you important aspects of using the MPC software in conjunction with the MPC hardware. Let’s get started!

Starting Up

1. Power on your computer, and make sure the MPC hardware driver and software are both properly installed on your computer.

2. Connect your MPC hardware to your computer with a standard USB cable and power it on. After that, open the MPC software.

   Now, you’re ready to go!
Creating a Drum Kit

Let's start by making a simple drum kit.

![Browser display of the MPC hardware.](image)

**Hardware:**

1. Press the **Browser** button and use **Cursor Buttons** to navigate to where your drum sounds are located:
   - Use the **Up** or **Down Cursor Buttons** to move through a list
   - Use the **Right Cursor Button** to enter a selected folder,
   - Use the **Left Cursor Button** to go to the previous folder.

2. To preview a selected sound, press the **F3** button (**Play**). You can also activate the **Auto Preview** option with the **F2** button (**Auto**).

3. First, let's load a bass drum. Press **Pad 1** to select it. The pad will be lit in green. Navigate to a bass drum sample you like and press **F6** (**Open**) to assign it to the selected pad. Now, you can press Pad 1 to play the bass drum sample.

4. To create a simple drum set, repeat the above steps for other pads. We recommend loading a snare drum, a closed hi-hat, and an open hi-hat. Feel free to add a crash cymbal, too.

Now that your drum kit is set up, you can record a drum Sequence!
Recording a Drum Sequence

Let’s record a drum Sequence.

**Hardware:**

1. Press the **Rec** button to activate Record Mode.
2. To start the actual recording, press the **Play** button. The pre-count will count one measure before the software starts to record. We recommend recording only one sound (pad) at a time, especially if you are not familiar with playing on the pads.
3. Play a simple bass drum pattern. The note events you just recorded will automatically be placed in the grid (in this case, on 16th notes). The initial measure length is two bars. After the two bars, the recording will enter Overdub Mode automatically; the Sequence plays again from the beginning and keeps looping, allowing you to record further notes. Don’t stop the recording!
4. Play the snare drum part, then a hi-hat part.
5. When you’re done recording, press the **Stop** button.
6. To repeat the recording, keep in mind that the pads you play in your new recording will automatically replace existing notes played with the same pads. To prevent this, you can start again from Step 1 but press the **Overdub** button instead of the Rec button; Overdub lets you record additional note events over the existing Sequence.
7. The **Undo** button functions differently while in Record Mode. Normally, pressing **Undo** will undo just the last event. When there is an event to undo, the **Undo** button will be lit solid. While recording, the **Undo** button will flash. In this case, pressing **Undo** will erase all events from that recording (i.e., since **Play** or **Play Start** was pressed).
8. Want to add a crash cymbal? In this case, it is easier to create it directly in the software by clicking the desired position in the grid, in the same row as the crash sample.
Organizing Samples and Editing Note Events

We recommend naming and editing your files before recording any further. Let’s use the software, which is easier for editing.

The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged in a Program. Let’s rename the existing Program as we’ll want to create more Programs later on. Right-click Program 001 in the Project Information panel, and select Rename. Name the Program (e.g., Drums), and click OK.

Right-click the name of a sample (e.g., Bassdrum-01), and select Rename. Enter a suitable name for the sample (e.g., Bass Drum 1 or Kick 1). Repeat this for the other samples in the Program. This will help keep your Program organized as you add more samples to it.
In the grid, you can see your recorded note events. Click and drag a note to move it to a different position. By default, you can position notes only by quantization values, defined by the Time Correct value. You can change the value by clicking the Time Correct drop-down menu. We recommend working with 8 or 16 values. Hold down your keyboard’s Shift key and use the arrow keys to nudge events without restricting (“snapping”) them to the grid.

Hold down your keyboard’s Control key (Windows) or ⌘ key (Mac OS X) and click and drag a note to copy it. Double-click a note to delete it.

Velocity data can be easily edited in the velocity lane below the grid. Click a note event or place the mouse over a velocity bar in the lane. A small round handle will appear at the top of the velocity bar. Move the mouse vertically to change its value.
Making Basic Sound Edits

Let’s make sure the samples are properly tuned and have good levels.

**Hardware:**

1. Press the **Prog Mix** button to enter Program Mixer Mode.
2. Press the **F1** button (**Level**) to control the volume for each pad. You can use the hardware’s **Q-Link Knobs** as well as the corresponding faders in the software. Adjust the levels of each pad to suit your taste.
3. Press **F2** (**Pan**) to control the stereo panning for each pad. You can use the hardware’s **Q-Link Knobs** as well as the corresponding **Pan** knob in the software. We recommend spreading the panning of the bright sounds (e.g., cymbals, snare drum) a little.
4. The snare drum needs a small amount of reverb to give it a more spatial sound. Press **F5** (**Insert**) to view the Insert Effect tab. Use the **Cursor Buttons** to navigate to the snare sample’s pad (here, A02). Using the **Data Dial**, select the desired effect, and press **F4** (**Select**) to load it. Let’s try **Reverb Medium**.
5. Could the bass drum use some tuning? Press the **Prog Edit** button and press **Pad 1** to select the bass drum. Press **F2** (**Samples**) and use the Q14 and Q15 **Q-Link Knobs** to tune the sound. You can also use the corresponding **Semi** and **Fine** parameter in the **Layer** section of the software.
Recording a Bass Track

Let’s try recording a bass line. Unlike a drum kit, it’s important to be able to play and record a bass sound chromatically, so this will be slightly different than setting up the drum kit.

Adding a bass line over the drum part means we need to add a new Track. A Track is simply a layer of a Sequence; you can have multiple Tracks in a single Sequence (e.g., a drum Track, a bass Track, a piano Track, etc.), and they all play simultaneously when you play the Sequence.

First, select a new Track. Go back to Main Mode and select Track 2 (unused) in the Track drop-down menu above the grid.

**Hardware:** Press the Main button and then press the F4 button (Track+) to move to the next Track.

Let’s create a new Program to assign to this empty Track:

1. In the Track Section in the lower half of the window, click the + button next to the Program drop-down menu.
2. In the Project Information on the right, right-click the new Program (Program 001) and enter a name (e.g., Bass).
3. Back in the Track Section, click the Type drop-down menu and select Keygroup. This is necessary because we want to play the bass sound chromatically with the pads.

Now, let’s load a bass sound:

1. Click the File Browser’s drop-down menu for an overview of your hard disk structure and select a location. Double-click any displayed folder in the File Browser to open it.
2. Locate and select a bass sample. Click the Preview button to preview any selected audio sample.
3. Double-click a sample to add it to the Project. (Keep in mind that the sample is not yet assigned to a pad.)
Let’s continue to set up the Keygroup Program:

1. Click the **Program Edit** tab to enter Program Edit Mode.

   **Hardware:** Press the **Prog Edit** button to enter Program Edit Mode.

2. In the **Layer** section, click the **Layer 1** drop-down menu and select the bass sample you just loaded (you’ll see your drum samples in this list, as well). Because you’re working with a Keygroup Program instead of a Drum Program, this sample is now playable across all pads.

   **Tip:** On your MPC hardware, press the **Pad Bank D** button to switch to Pad Bank D and press **Pad 13**. You should hear the bass sample played back with its original pitch. You can use the other pads to play your sample chromatically.

Let’s add a second layer and set the Layers’ velocity ranges so our bass sounds different when played at a higher velocity (as a real bass would):

1. Go back to the File Browser and select a different bass sample that sounds similar but a little bit brighter.

2. Double-click a sample to add it to the Project.

3. Back in the **Layer** section, click the **Layer 2** drop-down menu and select the new bass sample. Press a pad—both samples will sound at once. Maybe this new sound is interesting as it is, but let’s make some quick edits to get as close as we can to a real-life bass sound.

4. Set **Layer 1**’s **Velocity** slider to cover the velocity range from 0 to 80, and set **Layer 2**’s **Velocity** slider to cover the range from 81 to 127.

   Now when you press a pad, the lower velocities will trigger the Layer 1 sample only, while higher velocities will trigger the Layer 2 sample only.
Let's record that bass line now. Prepare your recording as described earlier, and record some bass notes. You can edit your recording just like we've done earlier.
Once you’ve recorded it, let’s tweak it a bit in the **Filter** section of the **Program Edit** menu. For this, let’s use the MPC hardware.

### Hardware:

1. Press **Prog Edit** to enter Program Edit Mode, and press F4 (Fit Env) to enter the **Filter** page.
2. Turn **Q-Link Knob 13** to select a filter for the **Filter Type** field. We recommend working with the **Low 4** type, to start.
3. Turn the **Cutoff** and **Reso** (Resonance) knobs (Q-Link Knobs Q14 and Q15) until your bass sample sounds perfect to you.
4. Use the **Q-Link Knobs Q1 to Q4** to set the **Amp Atk** (Amplifier Envelope Attack) and **Amp Rel** (Amp Envelope Release). These control the overall level characteristics of the sound.
5. Do you want to add an effect (e.g., **Chorus**)? Press F6 (Effects) and select the desired effect type for your bassline. (Remember to turn the **Inserts** parameter in the upper-right corner of the display to **On**.)

So far, we’ve created a simple drum Sequence and a bass line to go with it. Repeat this process to create a second Sequence.
Creating a Song

This section explains how to make a Song out of your Sequences. Before starting, make sure that you have recorded some Sequences (which we described earlier in this chapter)!

Click the Song tab to open Song Mode. Each of the Sequences you've created in this Project is assigned to a pad.

Click and drag a pad with the desired Sequence onto the Sequence Playlist to the left of the pads. Alternatively, if you prefer viewing a horizontal timeline, you can click and drag it onto the workspace above the pads.

As a Song plays, it moves through the each Step, which has a Sequence you assigned. Each Sequence may (or may not) be repeated, determined by the value in the Repeats (Rpts) column (a Rpt value of 1 means the Sequence will play through only once).

Each step can be set to play its Sequence at an independent tempo, determined by the value in the BPM column. The Bars column indicates the length of the Sequence for that step.

Click any drop-down menu in the Sequence column to select a new Sequence for that step. Click and drag up or down on a Rpts value to change it.

Exporting the Song

Want to share your new Song with your friends? All you need to do is export it.

While in Song Mode, click the File menu, select Export, and select As Audio Mixdown.

In the Audio Mixdown window, select your mixdown settings.

- Set the Start field to 1, and set the End field to the last bar of your Song.
- As the Song will likely be uploaded to the Internet, select the mp3 file format option.
- Choose a save location.

Click Export to start exporting the Song.

To learn more about the Audio Mixdown options, please see General Features > Software Menus > File Menu.
Other Features Explained

This chapter describes various advanced features. These sections explain how to perform these operations by using mostly the MPC hardware, but all of them are also possible in the software. For a fuller explanation of these features, please refer to their corresponding sections in the Operation (Software) chapter.

Step Sequencer

You've already learned how to record note events on a Track, but you can quickly enter note events in Step Sequence Mode by using the pads as "step buttons," simulating the experience of a traditional step-sequencer-style drum machine.

Hardware:

1. Press Step Seq to enter Step Sequence Mode.
2. Start a new Track by using the Cursor Buttons to select the Trk field and use the Data Dial or -/+ buttons to select an unused Track. Let's use Track 04.
3. Use the F2 (Bar-) and the F3 (Bar+) buttons to select the bar whose steps you want to create or edit.
4. Use F5 (Pad-) and F6 (Pad+) to select the pad whose steps want to create or edit. The pad number and its sample name will appear in the upper-right corner of the display. Alternatively, you can use the Cursor Buttons to select the Pad field in the upper-right corner and use the Data Dial or -/+ buttons to select a pad.
5. Press the Play button to start your Sequence.

Each pad represents a step in the bar. If the pad already has note events on the selected Track, the corresponding pads (steps) will be lit with colors corresponding to their velocities.

Press an unlit pad to enter a note event at that step. The pad will light up with a color corresponding to its velocity.

Click a lit pad to delete the note event from that step. The pad will be unlit.

See the Step Sequence Mode chapter to learn more about this feature.
Drum Loops and Chop Mode

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains how to use Sample Edit Mode to work with drum loops.

Use the File Browser to locate a drum loop on your hard disk (the loop does not have to match the tempo of anything in the Project). Double-click the desired drum loop to add it to the current Program.

Hardware:
1. Press the **Sample Edit** button to enter Sample Edit Mode.
2. Use the **Data Dial** to select the loaded drum loop. You can scroll through all loaded samples seen the top of your MPC hardware display.
3. Press **F1 (Chop)** to enter the Chop Mode where the drum loop will be cut into slices.
4. Use the **Cursor Buttons** to select the **Threshold** parameter, and use the **Data Dial** or +/- buttons select a value. The higher the value, the more slices will be created. Be sure to select a value so that every transient peak of the drum loop has a corresponding a slice marker.

**Tip:** Press **F4 (Audition)** to play the created slices with the pads. Each slice will be automatically assigned to a pad: **Pad A01** plays Slice 1, **Pad A02** plays Slice 2, etc.
Hardware:
Now, let’s create a new Program containing all of these slices as individual samples. It will also automatically create corresponding note events to play back these slices sequentially.

1. Press F5 (Convert) to enter the Convert Slices page.
2. Use the Cursor Buttons to select the following parameters and use the Data Dial or +/- buttons select the value indicated as follows: Convert to Sliced Samples, Crop Samples to On, Create New Program to On, Create Events to On, and Program to the same Program the original drum loop was from.
3. Press F6 (Do It) to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note event in the Track. When you play that Track, it will play each pad (each slice) in the original order.
4. Press Play and listen to how the drum loop matches your Song tempo now.
You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new Track with the note events playing their corresponding slices has been automatically created. Click the T Correct drop-down menu to use Time Correct to quantize the note events so they fall on exact, even time intervals. You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the frequency range of a selected slice. There are almost no limits to what you can do.

See Sample Edit Mode > Chop Mode to learn more about this feature.
Pad Muting and Track Muting

Pad Mute Mode and Track Mute Mode let you silence different pads and Tracks to see what the Sequence sounds like without those samples or parts.

**Hardware:**
1. Select your basic drum Track.
2. Press and hold the **Shift** button and press the **Track Mute / Pad Mute** button to enter Pad Mute Mode.
3. Press **Play** to play the Sequence.
4. Mute a pad by pressing it once. The muted pad will be lit red. You can mute multiple pads at the same time.
5. To mute pads on another Track, press **Shift + Main / Track** and press F3 (Track-) or F4 (Track+) to switch between the recorded Tracks. Press **Shift + Track Mute / Pad Mute** again to perform the desired muted.
You can also mute entire Tracks by using the similar Track Mute function.

<table>
<thead>
<tr>
<th>New: 000:00:00</th>
<th>Sent: 001 Sequence 01</th>
</tr>
</thead>
<tbody>
<tr>
<td>(unused)</td>
<td>(unused)</td>
</tr>
<tr>
<td>(unused)</td>
<td>(unused)</td>
</tr>
<tr>
<td>(unused)</td>
<td>(unused)</td>
</tr>
<tr>
<td>Drums</td>
<td>Baseline</td>
</tr>
<tr>
<td>TrkMute</td>
<td>Trk Group</td>
</tr>
<tr>
<td>Time Div</td>
<td>T.C.</td>
</tr>
<tr>
<td></td>
<td>Solo</td>
</tr>
</tbody>
</table>

The **Track Mute** display of the MPC hardware.

**Hardware:**

1. Press the **Track Mute** button to enter Track Mute Mode.
2. Press **Play** to play the Sequence.
3. Mute a Track by pressing the corresponding pad once. The muted pad will be lit red. You can mute multiple pads at the same time.
4. To mute a Track only at precise note intervals ("quantizing" your mutes, essentially), you can set a musical timing value by pressing the **F4** button (**Time Div**). Use the **Data Dial** or +/- buttons to set a musical value (e.g., 1 bar). Press **F4 (Close)** to close the page. Now, when you press a pad in Track Mute Mode, the mute will occur precisely at the beginning of the following bar. This lets you test musical combinations of patterns—the stage preliminary to building a Song structure.
Sample Recording

This section describes recording new samples of your own, which you can use in your Projects.

Important: To record any audio, you need to connect an audio source to your MPC Renaissance or to your computer’s audio interface.

MPC Studio users: This section describes recording using MPC Renaissance as your sound card. MPC Studio cannot be used in this way, but you can use a separate audio interface connected to your computer to record audio.

**Hardware:**

1. Press and hold the **Shift** button and press the **Sample Edit / Sample Rec** button to enter Sample Record Mode.
2. Connect a suitable microphone to a **Mic In** jack of your MPC Renaissance. Make sure to set the input switch to **Mic**.
3. Set the **Mic In / Phono In** switch on the top panel to **Mic In** and turn up the **Rec Gain** dial. In the software you should now see the input signal. Make sure that the signal gain does not exceed the maximum level (the top input level display segment should be hardly lit).
4. Use the **Cursor Buttons** to select the **Threshold** parameter and use the **Data Dial** or **-/+** buttons to set it to a fairly low level (e.g., -70 dB).
5. Press **F6** (**Record**) and sing/say/shout something into the microphone. Recording starts immediately when the input signal level reaches the threshold value.
6. Press **F6** (**Stop**) again, to stop recording.

If you’re happy with your recording, name the new sample in the software in the window that appears when you stop recording. You should also assign the sample to an unused pad. Simply press the pad to assign the sample! After that, click **Keep**.

See the **Sample Record Mode** chapter to learn more about this feature.
Sample Editing

Select the sample in the **Project Information** and right-click it. In the drop-down menu, select **Edit**. Sample Edit Mode will open.

**Hardware:**
1. Press F2 (Trim) to enter Trim Mode.
2. Use Q-Link Knobs Q1, Q5, Q9, or Q13 to define a suitable start point for your sample.
3. Use Q-Link Knobs Q2, Q6, Q10, or Q14, to define a suitable end point for your sample.
4. To hear your edits, press Pad A15 to play the sample from the new start point to the new end point.

![Process Sample display of the MPC hardware.](image)

Let’s apply some transformations to the sample.

**Hardware:**
1. Press F6 (Process) to enter the Process Sample window.
2. With the Data Dial or +/- buttons you can select the desired option. Let’s try **Pitch Shift** to change the overall pitch of your sample.
3. Use the **Cursor Buttons** to select the Pitch parameter and set it to 5.0. This will transpose the sample by 5 semitones without affecting the sample’s length.
4. Press F5 (Do It) to finalize the edit process.

See the **Sample Edit Mode** chapter to learn more about this feature.
Recording Automation with the Q-Link Knobs

Automating various parameters is a good way to add some motion and dynamism to your Sequences.

1. In the software, click the **Main Mode** tab to open Main Mode. Press a pad that has a sample assigned to it.
2. In the **Q-Link** section, click the **Prg** button.
3. Turn Q-Link Knob Q1 to activate it for assignment.
4. Click the **Pad** menu and select the pad you pressed earlier.
5. Click the **Change** menu and select **Real Time**, and then click the **Param** menu and select **Tuning**.
6. Repeat Steps 3-5 for **Q-Link Knob 2**. Assign it to the same pad, and select **Real Time** as the Change, but select **Pan** for the Param menu.
7. On the Program Channel strip, click the **Automation** button (curve icon, under the Mute button) until it turns red and has a W.
8. Record the automation using your MPC hardware:

   **Hardware:**
   1. Press the **Overdub** button to arm your automation recording. Press **Play** to start it.
   2. Use Q-Link Knobs Q1 and Q2 to record filter movement as desired.
   3. Press **Stop** to finish the automation recording.

Want to see what you’ve recorded? In the software, to the left of the velocity lane under the grid, under the Automation menu, click **Tuning** or **Pan**. The automation curve will appear in the lane. If part of the curve is still not quite what you want, select the Pencil Tool in the upper-left corner and draw in your own automation curve.

See **General Features > Grid View > Recording Automation** and **Manually Entering and Editing Automation** to learn more about this.
Using MPC as a Plugin

If you're working with other audio software, you can use the MPC software as an instrument plugin (VST, AU, RTAS, or AAX format) within your host software. The MPC plugin offers the same features and functionality as the standalone software version but with some notable differences, which are discussed in the Operation (Plugin) chapter.

Note: To learn how to load and use an instrument plugin in a host application, please refer to the corresponding chapter of your host application's manual.
Operation (Software)

This chapter explains the complete features and functions of the MPC software.

Important: When using the MPC software as a plugin, its features and functions are very similar to how it is described in this chapter but with some notable differences, discussed in the Operation (Plugin) chapter.

Remember:
- In this manual, whenever the MPC hardware can be used to control a parameter or a function, this is explained separately in a light-red box labeled Hardware, MPC Renaissance, or MPC Studio (as below on this page). Note that these paragraphs are not the only parts of the manual that mention the MPC hardware!
- We strongly recommend using the MPC hardware to control the software as its intuitive and fast operation will greatly enhance your workflow.

Hardware:
- The MPC hardware display reflects what it is controlling in the software, but due to space and character limitations, the hardware display is slightly different (e.g., parameter names may be abbreviated, the layout may be different or spread across multiple tabs, etc.).
- You can navigate through the MPC hardware display by using the MPC hardware’s Cursor Buttons. When a parameter is selected, you can change it by turning the hardware’s Data Dial or using the +/- buttons.
- When the display shows a series of parameters that cannot be selected with the Cursor Buttons, this means that the display is showing you what the Q-Link Knobs are controlling. Touch a Q-Link Knob, and the parameter’s name and setting will appear in the upper-right corner of the hardware display. Turn the knob to adjust it (If the Q-Link Knob does not control any parameter in the display, this area will show the Q-Link Knob number and no text).
- When accessing the secondary functions of buttons on your MPC hardware, you can do this one of two ways: (1) pressing and holding Shift and then pressing the desired button or (2) double-pressing the desired button. This manual describes these operations using only the first option, but both are acceptable.
- When the Window button lights up red, it means the currently selected field in the MPC hardware display contains a secondary window. Press the Window button to open that window, and adjust any settings or parameters as desired.
General Features

Adjusting the Controls

**Tip:** If you use a computer mouse with scroll wheel, you can use it to affect some of these controls: place your mouse pointer over the control and use the scroll wheel to change it. If you hold down your keyboard’s Shift key while doing this, you can increase the resolution.

The MPC software uses the following types of control elements:

**Knobs**
To set a value, click the knob, hold the mouse button, and drag the knob up and down. Alternatively, you can edit values by using your mouse scroll wheel.

**Parameter Values**
To set a value, click and hold the mouse button on the field, and drag the mouse up and down.

**Drop-Down Menus**
Click the downward arrow (▼) to open a drop-down menu where you can select the desired setting or parameter.
Switches
Switches are represented by "LEDs." If a function is active, its LED will be lit red. To activate a function, click it. Any other LEDs in its set will be automatically deactivated.

Buttons
Click a button to activate or deactivate its function. Buttons are red when they are activated.

Envelope Displays
Click the respective "handle" of an envelope and drag into the desired direction to change an envelope parameter.

Pencil and Select Box Icons
Clicking this icon will switch between Draw Mode (the Pencil Tool) and Select Mode (the Select Box tool).

Draw Mode:
- Click once on an empty square in the grid to place a note event in that square.
- Double-click a note event to erase it.

Select Mode:
- Click and drag the box over note events on the grid to highlight them.
- Double-click an empty square in the grid to add a note event.
- Double-click a note event to erase it.
Program Types

About Programs

A Program is a file that contains (1) a list of all samples used and (2) the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.) Program Edit Mode lets you edit and assign samples. A single Project can hold a total of 128 Programs.

There are two kinds of Programs that use samples as their sound source: Drum Programs (used mostly for creating drum parts and quickly and easily assigning samples to pads) and Keygroup Programs (in which you can assign one or more samples to one or more keys and play them chromatically with a MIDI keyboard or the MPC hardware pads). Two other kinds of Programs use MIDI data only: Plugin Programs and MIDI Programs. This section covers how to create each Program type. To learn about editing your Programs to your preference, see the Program Edit Mode chapter.

Drum Programs

To create a Drum Program in the software:

1. Click the Main Mode tab to enter Main Mode.
2. In the Track Section, click the Type drop-down menu and select Drum.
3. If the Project does not contain a Drum Program yet, a new Drum Program will automatically be added to the Project.
   If the Project already contains a Drum Program, click the + button next to the Program drop-down menu.
4. Click the name in the Program drop-down menu, and enter an appropriate Program name.

Hardware: To create a Drum Program:

1. Press Main to enter Main Mode.
2. Use the Cursor Buttons to select the Pgm field, and then press the Window button.
3. In the Edit Program window that appears, press F3 (New) to create a new Program.
4. Use the Data Dial or +/- buttons to select Drum as the Type, and then press F5 (Do It) to confirm or F4 (Cancel) to cancel.
To load samples into a Drum Program, click and drag a sample onto the desired pad (in the pad display or its row in the grid) from one of the following locations:

- the File Browser
- the Project Information
- your computer’s Explorer (Windows) or Finder (Mac OS X)

The sample will be assigned to the corresponding pad.

**Tip:** By following the same process described earlier, you can also load an entire folder of samples into a Program by dragging the folder onto a pad. Each sample will be assigned to a pad in alphabetical order, starting from the “destination” pad and ascending from there, one sample per pad.

**Hardware:** Press the Browser button. Choose a pad you want to assign a sample to. Locate the desired sample and press F6 (Open) to load it. The sample is now “placed” on that pad.

![The Browser display of the MPC hardware.](image)

**Hardware:** Press the Prog Edit button, and then press F1 (Master). With the Q9, Q5, and Q1 Q-Link Knobs, you can assign additional samples to the selected pad. You can assign up to four samples per pad (one for each Layer).

In the software, click the Program Edit tab. With the Sample drop-down menus of Layer 2 to Layer 4, you can assign additional samples to the selected pad. You can assign up to four samples per pad (one for each Layer).

**Remember:** A Drum Program holds 128 pads: 16 pads across eight banks.
Keygroup Programs

To create a Keygroup Program in the software:

1. Click the Main Mode tab to enter Main Mode.
2. In the Track Section, click the Type drop-down menu and select Keygroup.
3. If the Project does not contain a Keygroup Program yet, a new Keygroup Program will automatically be added to the Project.
   If the Project already contains a Keygroup Program, click the + button next to the Program drop-down menu.
4. Click the name in the Program drop-down menu, and enter an appropriate Program name.

**Hardware:** To create a Keygroup Program:

1. Press Main to enter Main Mode.
2. Use the Cursor Buttons to select the Pgm field, and then press the Window button.
3. In the Edit Program window that appears, press F3 (New) to create a new Program.
4. Use the Data Dial or +/- buttons to select Keygroup as the Type, and then press F5 (Do It) to confirm or F4 (Cancel) to cancel.

To load samples into a Keygroup Program:

1. In the File Browser, double-click the desired sample. The sample is now loaded in the current Project.
2. Click the Program Edit tab.
3. Click Layer 1’s Sample drop-down menu to select and assign a sample to the Keygroup Program.
   The loaded sample can now be played chromatically with the pads or a connected MIDI keyboard.

**Hardware:**

1. Press the Browser button.
2. Locate the desired sample and press F6 (Open) to load it. The sample is now loaded into the current Project.
4. Press the F1 (Master) button and use Q-Link Knob Q13 to assign the sample to the Keygroup Program.
In the software, click the **Program Edit** tab. With the **Sample** drop-down menus for **Layer 2** to **Layer 4**, you can assign up to four samples (loaded into the **Project Information** beforehand) to create velocity layers or make other layer-dependent adjustments.

**Hardware:** Press the **Prog Edit** button. Press F2 (Samples). With the Q9, Q5, and Q1 Q-Link Knobs, you can load additional samples to your existing one. These samples are placed in up to four Layers.

To create complex Keygroup Programs, you can add more Keygroups (up to 128). This is useful when working with multi-samples (e.g., when programming a real piano).

**Remember:** A Keygroup Program offers up to 128 Keygroups, and each Keygroup can hold up to four samples (Layers 1 to 4). This is a total of 512 samples.
Plugin Programs

A Plugin Program lets you send your Tracks’ MIDI data to a loaded plugin. This lets you set multiple Tracks to use the same plugin instead of loading an instance of a plugin on every Track (which can be cumbersome and CPU-intensive).

To create a Plugin Program:

1. Click the Main Mode tab to enter Main Mode.
2. In the Track Section, click the Type drop-down menu and select Plugin.
3. If your Project already contains the desired plugin, click the Program drop-down menu to select it.
   If your Project does not contain the desired plugin yet:
   1) Click the + icon next to the Program drop-down menu. A new Program name (Plugin ###) will appear, which you can click to edit.
   2) Click the Plugin drop-down menu. In the window that appears, you can click checkboxes to re-order your list of plugins: Sort by type or Sort by manufacturer.
   3) Select the desired plugin from the list, and click Select to select it or Close to cancel. Click the e button to open the user interface of the loaded plugin.

   Remember: You have to specify the disk directory where your plugins are located. This can be done in the software’s Preferences. See Software Menus > Edit Menu > Preferences: Plugins Tab for more information.

4. To enter a Program name, click the name in the Program drop-down menu, and type a name.
   To select the MIDI channel the Program will use, click the MIDI Ch drop-down menu and select one (from 1 to 16). Use this setting when you are working with a virtual instrument that supports multi-mode.
   To select a preset for your plugin (if any), click the Preset drop-down menu.
Hardware: To create a Plugin Program:

1. Press Main to enter Main Mode.
2. Use the Cursor Buttons to select the Pgm field, and then press the Window button.
3. In the Edit Program window that appears, press F3 (New) to create a new Program.
4. Use the Data Dial or +/- buttons to select Plugin as the Type, and then press F5 (Do It) to confirm or F4 (Cancel) to cancel.
5. Use the Cursor Buttons to select the Plg field.
6. Use the Data Dial or +/- buttons to select the desired plugin, and then press F4 (Select) to confirm or F3 (Back) to cancel.
7. To select the MIDI channel the Program will use, use the Cursor Buttons to select the Ch field, and use the Data Dial or +/- buttons to select one (from 1 to 16).

To select a preset for your plugin (if any), use the Cursor Buttons to select the Plg field, and then press the Window button. Use the Data Dial or +/- buttons to select the desired preset, and then press F5 (Select) to confirm or F4 (Close) to cancel. You can also press F2 (AutoSel) to load each preset immediately as you select it.

Selecting the Plg field in the Main Mode of the MPC hardware display.

Preset selection for Plugin Programs in the MPC hardware display.

60
To adjust the volume and panning of a Track using the Plugin Program, click the **Track Mixer** tab to enter Track Mixer Mode, and adjust that Track’s volume slider or pan knob, respectively. (If the Track channel strips are not shown, click the **Show Tracks** icon on the left edge of the window.)

By default, the volume and pan values will initially appear as `?`, indicating the Program is not sending any volume or pan changes.

The volume and panning of the Plugin Program itself will appear (and can be adjusted) as normal.

**Important:**

If you copy a Sequence, the volume and pan values will be copied with that Sequence. If you move to a new Sequence and put the same Plugin Program on a new Track, though, these values will appear as `?`, as described above.

By default, some plugins do not support MIDI volume and pan. In this case, adjust volume levels and panning on the Track.

**Hardware:** To adjust the volume and panning of a Track using the Plugin Program or the Plugin Program itself:

1. Press **Shift + Prog Mix / Track Mix** to enter Track Mixer Mode.
2. Use the **Cursor Buttons** to highlight the Mixer field at the top of the display.
3. Use the **Data Dial** or `-/+` buttons to switch between **Track** and **Programs**.
   - **Track** will show the information for the Track channel strips.
   - **Programs** will show the information for the Program channel strips.
4. Press **F1 (Level)** or **F2 (Pan)** to select the desired tab.
5. Use the **Q-Link Knobs** to adjust the volume levels or pan settings of your Tracks or Plugin Programs.
Tracks in Track Mixer Mode in the MPC hardware display.

<table>
<thead>
<tr>
<th>Tracks</th>
<th>Level</th>
<th>Pan</th>
<th>Mute</th>
</tr>
</thead>
<tbody>
<tr>
<td>13+</td>
<td>127</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9+</td>
<td>127</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5+</td>
<td>127</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11+</td>
<td>127</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Programs in Track Mixer Mode in the MPC hardware display.

<table>
<thead>
<tr>
<th>Programs</th>
<th>Level</th>
<th>Pan</th>
<th>Mute</th>
<th>Send</th>
<th>Insert</th>
<th>Route</th>
</tr>
</thead>
<tbody>
<tr>
<td>13+</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9+</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5+</td>
<td>0.00dB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11+</td>
<td>0.00dB</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
MIDI Programs

To create a MIDI Program:
1. Click the Main Mode tab to enter Main Mode.
2. In the Track Section, click the Type drop-down menu and select Midi.
3. If the Project does not contain a MIDI Program yet, a new MIDI Program will automatically be added to the Project.
   If the Project already contains a MIDI Program, click the + button next to the Program drop-down menu.
4. Click the name in the Program drop-down menu, and enter an appropriate Program name.

Hardware: To create a MIDI Program:
1. Press Main to enter Main Mode.
2. Use the Cursor Buttons to select the Pgm field, and then press the Window button.
3. In the Edit Program window that appears, press F3 (New) to create a new Program.
4. Use the Data Dial or -/+ buttons to select Midi as the Type, and then press F5 (Do It) to confirm or F4 (Cancel) to cancel.

Unlike Drum Programs and Keygroup Programs, which use samples imported into the software, your MIDI Program will send MIDI messages to an external sound module (a connected drum machine, synth, etc.). You will need to set up the MIDI Program to do this properly. See Main Mode > Track Section for more information on how to properly configure your MIDI Program.

To adjust the volume and panning of a Track using the MIDI Program, click the Track Mixer tab to enter Track Mixer Mode, and adjust that Track’s volume slider or pan knob, respectively. (If the Track channel strips are not shown, click the Show Tracks icon on the left edge of the window.)

By default, the volume and pan values will initially appear as ?, indicating the Program is not sending any volume or pan changes.

Important: If you copy a Sequence, the volume and pan values will be copied with that Sequence. If you move to a new Sequence and put the same MIDI Program on a new Track, though, these values will appear as ?, as described above.
Browsers

File Browser

The File Browser lets you navigate through your computer’s internal and external hard disks to load samples, Sequences, Songs, etc. Using filter buttons and user-definable folders, you can easily adapt the File Browser to your preferred workflow. You can also preview (audition) your samples before loading them and set the preview volume.

In the software, the File Browser is in the left area of the window. Show or hide it by clicking the triangle button (◧ or ◣) in the lower-left corner of the window. Alternatively, click the View Menu and select File Browser, or press Shift+B on your computer keyboard.

**Hardware: To enter the File Browser, press the Browser button.**

To get the most efficient use of the File Browser, set the file path to your hard disk(s) first. There are five Folder Buttons labeled 1 to 5 at the top of the File Browser. Here, you can select up to five locations on your hard disk(s) to give you quick access to your files.

**Note:** The File Browser does not display irrelevant files (e.g., text documents, spreadsheets, pictures, etc.).

**To set the file path:**

1. Click the File Browser’s drop-down menu. You’ll see an overview of your hard disk structure, which looks quite similar to the Explorer (Windows) or the Finder (Mac OS X).
2. Select the desired location. The folder’s content will appear in the File Browser.
3. Press and hold your computer’s Shift key and click one of the Folder Buttons (1–5) at the top of the File Browser.

   Now, when you click that Folder Button again, the File Browser will display that folder’s content immediately.
You can filter the displayed files with the filter buttons. The selected buttons will light red. Click No Filt to switch the filter function off. Click Proj. to show only Project files. Click Seq. to show only Sequence files. Click Prog. to show only Program files. Click Sample to show only audio files.

To load a Project, double-click its corresponding .xpj file in the File Browser.

To load a single sample or multiple samples into a Project, click and drag the files onto the Pad Bank Section, the grid, or the Project Information. You can select a single file or multiple files in the following ways:

- To select a single file in the File Browser, click it.
- To select multiple adjacent files in the File Browser, click the first file, press and hold your keyboard’s Shift key, and then click the last file. All files between (and including) those two files will be selected.
- To select multiple files in the File Browser that are not adjacent, click the first file, press and hold your keyboard’s Control key (Windows) or ⌘ key (Mac OS X), and then click any additional file(s) you want to select. Release the Control key or ⌘ key when you have finished selecting the files.
- To load a track from an audio CD into your Project, click and drag it from the File Browser onto the software window.

**Tip:** You can also click and drag files from your computer’s Explorer (Windows) or Finder (Mac OS X) instead of from the File Browser.

**Hardware:**

- Use the following buttons for the File Browser filter functions: No Filter to deactivate the filter (same as the No Filt button in the software), Project for Project filter, Sequence for Sequence filter, Program for Program filter and Sample for sample filter.
- Use the Shift button and the five Folder buttons to select the desired location on your hard disk.
- Once a location is selected, you can select any file with the Data Dial, the /-+ buttons or the Cursor Buttons.
- Use the left and right Cursor Buttons to enter or exit a folder.
- Press the F6 button (Load) to load a sample on the selected pad.

![Browser display of the MPC hardware.](image)
With the Parent Directory arrow button (, in the software, to the right of the file path) you can exit the current folder.

**Hardware:** Use the left and right Cursor Buttons to enter or exit a folder.

In the software, the Preview button (horn icon) is located below the File Browser.

**Hardware:** Press the F3 (Play) button to preview any selected audio sample.

**Important:** Only audio samples can be previewed. Also, make sure that your audio hardware is connected properly to listen to the audio file.

Click and drag the meter below it to set the preview volume. Press and hold Alt (Windows) or Option (Mac OS X) on your computer keyboard and click the meter to return it to its default position.

**Hardware:** Press and hold the F4 (Volume) button to show the current preview volume. Use the left or right Cursor Buttons to select the value before the decimal place (for coarser volume adjustment) or the value after the decimal place (for finer volume adjustment). Use the Data Dial or -/+ buttons to adjust the value. You can also use the numeric buttons to enter a desired value and confirm it by pressing Enter.

Adjusting the Audition Volume in the MPC hardware display.

In the software, click the Auto Preview button to activate or deactivate the automatic preview function. When Auto Preview is active, each time an audio file is selected, it will play automatically. This is useful when scrolling through a list of samples (i.e., comparing different snare drum sounds without having to load or manually preview them).

**Hardware:** Press the F2 (Auto) button to activate or deactivate Auto Preview. When Auto Preview is active, each time an audio file is selected, it will play automatically.
Expansion Browser

In the software, the Expansion browser contains any available MPC Expansions you have installed.

To view the Expansion Browser, click the Expansion button, click the Expansion button located below the File Browser. To return to the traditional File Browser, click it again.

To select an Expansion plugin in the Expansion Browser, click its title.

To view the available patches/presets of that Expansion plugin, click Patches below the Expansion title.

To load a patch/preset immediately in the current Plugin Program (or in a new Plugin Program, if you are currently using a different Program type), simply double-click the name of a patch/preset.

**Hardware:** To view the available patches of an Expansion and load a patch to a new or existing Plugin Program:

1. Press Main to enter Main Mode.
2. Use the Cursor Buttons to select the Pgm field.
   - To select an existing Plugin Program, use the Data Dial or +/- buttons to select it.
   - To create a new Plugin Program, press the Window button, press F3 (New), use the Data Dial or +/- buttons to select Plugin, and then press F5 (Do It).
3. Back on the Main Mode screen, use the Cursor Buttons to select the Plg field.
4. If the Plg field already contains the desired plugin name, skip to the next step.
   - If the Plg field does not already contain the desired Plugin name, use the Data Dial or +/- buttons to select it, and then press F4 (Select) to confirm.
5. With the Plg field still selected, press the Window button.

6. Use the Data Dial or +/- buttons to select the desired preset, and then press F5 (Select) to confirm or F4 (Close) to cancel. You can also press F2 (AutoSel) to load each preset immediately as you select it.

![Image of MPC hardware display showing preset selection]

Selecting the Plg field in the Main Mode of the MPC hardware display.

![Image of Hybrid Presets menu]

Preset selection for Plugin Programs in the MPC hardware display.
Mode Tab Section

The Mode Tab Section contains tabs that let you switch between the software modes as well as further control for selecting Programs, Sequences, Songs, etc. depending on the selected mode tab on the left. This section is always visible.

The different modes are described in detail in the following sections of this chapter.

To select a mode within the software, click the corresponding tab.

**Hardware:** To select a mode, press the corresponding button.

**Tip:** On your computer keyboard, press and hold Ctrl (Windows) or ⌘ (Mac OS X) and then press 1-10, - (minus sign), or = (equal sign) to select a mode.
Depending on the selected mode, some Mode Tab Section menus and functions can change:

Click the **Program** drop-down menu to select one of your Programs in the currently loaded Project. A Project can hold up to 128 Programs. The **Program** drop-down menu is available only when **Program Edit** or **Program Mixer** tab is selected.

**Hardware:** Press the **Prog Edit** button and use the **Data Dial** or the +/- buttons to select the desired Program. This can also be done in the **Pgm** field on the **Main** window.

Click the **Seq (Sequence)** drop-down menu to select one of your Sequences in the currently loaded Project. A Project can hold up to 128 Sequences. The **Sequence** drop-down menu is available only when **Main**, **Program Mixer**, **Track Mixer**, **Track View**, or **Step Sequence** tab is selected.

**Hardware:** Press the **Step Seq** button and use the **Cursor Buttons** to select the **Seq** field. Use the **Data Dial** or the +/- buttons to select the desired Sequence.

Click the **Track** drop-down menu to select one of your Tracks in the currently loaded Sequence. Alternatively, press **Ctrl+[-]** or **Ctrl+[** (Windows) or **⌘+[** or **⌘+]** (Mac OS X) to move to the previous or next track, respectively. A Sequence can hold up to 128 Tracks. The **Track** drop-down menu is only available when **Main**, **Program Mixer**, **Track Mixer**, **Track View**, or **Step Seq** tab is selected.

**Hardware:** Press the **Main** button and use the **Cursor Buttons** to select the **Trk** field. Use the **Data Dial** or the +/- buttons to select the desired Track. You can also use the **F3 (Track-)** or **F4 (Track+)** buttons on the **Main Mode** page.

Click the **Song** drop-down menu to select one of your Songs in the currently loaded Project. A Project can hold up to 32 Songs. The **Song** drop-down menu is only available when the **Song** tab is selected. See the **Song Mode** chapter for more information about Songs.

**Hardware:** Press the **Song** button and use the **Cursor Buttons** to select the **Song** field. Use the **Data Dial** or the +/- buttons to select the desired Song.
Click the **Global Automation** button to switch Automation for all Programs between Off, Read (R), and Write (W).

- Set this to **Off** to set all Programs to ignore automation data. If you have already recorded or entered automation, clicking the button will switch between Read (R) and Write (W) only, but you can override this and set it to Off by pressing and holding **Shift** on your computer keyboard while clicking the button.

- Set this to **Read** (R) to set all Programs to read automation data but not record any additional automation over it, though you can still manually edit and enter automation. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- Set this to **Write** (W) to set all Programs to record automation. (If you have any Q-Link Knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording!)

**Note:** To set the automation for individual Programs, click the **Automation** button (curve icon) of that Program’s channel strip—under the **Mute** button—in Main Mode, Program Mixer Mode, Track Mixer Mode, or Step Sequence Mode. Alternatively, click the **Automation** button (curve icon) in the upper-right corner of the **Master** section of Program Edit Mode when the desired Program is selected.

**Hardware:** To set the Q-Link Trigger button to cycle through the automation states for just the Program or globally, do the following:

1. Press **Shift + Song/Other**.
2. Press **F1** (**Prefs**).
3. Use the **Cursor Buttons** to select the **Auto button** field
4. Use the **Data Dial or -/+ buttons** to set the field to **Program** or **Global**.

To learn more about automation, please see **General Features > Grid View > Recording Automation** and **Manually Entering and Editing Automation**.
Click the **Auto Scroll** button to switch between **Follow**, **Page**, and **Off**.

- When set to **Follow**, depending on the zoom setting, the grid will scroll along in the background, keeping the position marker centered.
- When set to **Page**, the grid display will "turn over" to follow the position marker.
- When set to **Off**, the grid will not move at all.

Click the **View** button to switch between **Split View** and **Full-Screen View**.

- In **Split View**, the software window will show the grid in the upper half and the mode-specific controls in the lower half.
- In **Full-Screen View**, the software window will show the grid only. This view is useful if you are working with a lot of pads or Tracks and need to view all of them simultaneously.

**Hardware:** Press the **Shift + Window / Full Screen** buttons to switch between **Split View** and **Full-Screen View**.

The top LED next to the MPC logo is the **MIDI In LED**. It will light up to indicate the software is receiving MIDI messages from your connected MPC hardware.

The bottom LED next to the MPC logo is the **MIDI Out LED**. It will light up to indicate the software is sending MIDI messages out.
Transport Section

The Transport Section contains various transport controls (for playback and recording) as well as bar and tempo displays, the master level, and a CPU meter. This section is always visible.

The CPU meter shows the computer CPU usage of the actual project. Keep in mind that an excessive use of synthesis functions such as filter and effects will increase the CPU usage.

**Tip:** If the CPU meter is very high, software response may slow down. Triple-clicking the Stop button (in this Transport Section or on your MPC hardware) will send a "MIDI panic" message. This will halt all messages the software is currently sending, and you can resume normal operation.

With the Metronome dial, you can set the volume of your metronome click. Press and hold Alt (Windows) or Option (Mac OS X) on your computer keyboard and click the knob to return it to its default position.

In the software, next to the Metronome dial, click On to activate or deactivate the metronome. It will light up red when active.

**Hardware:** Press the Main button and press F2 to enter the Click menu. Use the Cursor Buttons to select the Metronome field. Use the Data Dial or the +/- buttons to select the desired metronome setting. You can switch between Off, Play, Record, and Record + Play.

Please see Software Menus > Metronome Menu to learn more about the metronome functions.
The bar and tempo display shows the actual position in bars, beats, and ticks.

**Hardware:** To navigate to a particular position in a Sequence, you can use the < / > buttons to move one step at a time within a bar, or use the << / >> buttons to move one bar at a time. You can also press the Main button and use the Cursor Buttons to move between the bars, beats, and ticks values in the Now field (at the top of the display) and use the Data Dial or the +/- buttons to change the value. You can also use the numeric buttons to enter a desired value and confirm it by pressing Enter.

You can change the Sequence’s tempo by double-clicking the BPM value and entering a value with your computer keyboard. You can also click and drag the BPM value up or down to increase or decrease it.

**Hardware:** Use the Tap Tempo button to tap in the beats per minute of your desired tempo. An amber LED will blink, indicating the current beats. You can also press the Main button and use the Cursor Buttons to move to the Bpm parameter. Select the desired value by using the Data Dial or the +/- buttons. You can also use the numeric buttons to enter a value and confirm by pressing Enter.
Note: The transport controls can be found on the MPC hardware as well as in the software, so the descriptions below apply to both.

Click the **Rec** button to put the software in Record Mode. The button’s LED will light up red to indicate the Record process is armed. To start recording, press **Play** or **Play Start**. When the Sequence starts to loop in Record Mode, it will switch to Overdub Mode.

**Overdub** allows you to add data to the existing data on the selected Track. It is additive and non-destructive. It operates just like the **Rec** button, except that the recording will be in Overdub Mode from the moment you press **Play** or **Play Start**.

**Stop** will stop playback or recording. Quickly pressing **Stop** three times will act as a "MIDI panic" and shut off all voices and stop all audio processing. **Stop** will also cancel loading any files that are being loaded—if you select a Project or Program by accident, press **Stop** to abort and clear the loaded files.

**Play** will start playback from the current time position.

**Play Start** will start playback from the beginning of the Song or Sequence or from the First Bar setting.

**Hardware:** The **Undo** button can be used differently during recording. Normally, pressing **Undo** will undo the last event only (the button will be lit solid when there is an action that can be undone). While recording, pressing **Undo** will erase all events since **Play** or **Play Start** was pressed (the **Undo** button will flash in this case).

**Tip:** When using the MPC software as a plugin in host software, you can use your MPC hardware to control your host software’s transport. For instructions on how to set this up, click the **Edit** menu and select **Set Up MMC Control**, which will open a separate PDF. This is available for certain host software applications only.
**Level** controls the software's master output level.

**MPC Renaissance users:** The software’s **Level** knob controls the volume level of the audio *before* the MPC Renaissance's **Main Volume** dial. The audio will then be sent out of the **Stereo Outs** on the rear panel.

The **Vintage** display directly below the output level meter indicates the selected emulation mode.

**MPC Renaissance:** Press the **Vintage Mode** button to switch between the different audio quality emulations. You can select to emulate the particular sonic qualities of the **MPC3000**, the **MPC60**, **Other** and of course no emulation (no LED will be lit).
Grid View

The grid is where you record, program, and edit your Sequences and arrange your Songs. The grid is visible in Main Mode, Program Edit Mode, Program Mixer Mode, Pad Mute Mode, and Step Sequencer Mode. Furthermore, the grid has two different appearances, depending on the selected Program type; Drum Programs appear one way while Keygroup Programs, MIDI Programs, and Plugin Programs appear another way.

If you are not already in Grid View, enter it by doing any of the following:

- Clicking the View Menu and selecting Grid Editor.
- Clicking the List View button just below the Mode Tab.
- Pressing Shift+G on your computer keyboard.

Note: The alternative to the Grid View is List View, explained in the following List View section. Click the Show/Hide List button to switch between the two views.

Tip: Click the View button in the upper-right corner to switch between Split View and Full-Screen View. This is ideal for working on Sequences in detail.

Hardware: Press the Shift + Window / Full Screen buttons to switch between Split View and Full-Screen View. This is ideal for working on Sequences in detail.
For Drum Programs, the left column shows you all available pads in a vertical view with their corresponding data.

For Keygroup Programs, Plugin Programs, and MIDI Programs, the left column shows a vertical "piano roll" keyboard.

Use the vertical window scroll bar right of the grid windows to move up and down. Under the scroll bar is a slider that can adjust the "vertical zoom." Below the grid is a similar scroll bar and slider for horizontal scrolling and zooming.

**Hardware:** To zoom vertically, press and hold the **Shift** button and use the up and down **Cursor Buttons.** To zoom horizontally, press and hold the **Shift** button and use the left and right **Cursor Buttons.**

For Drum Programs, click a pad name to hear it in the Program. For Keygroup Programs, Plugin Programs, and MIDI Programs, click a key to hear that note in the Program.

Mute a pad by clicking its mute (**M**) button in the left column.
In the top-left corner of the grid are two buttons to switch between Draw Mode and Select Mode:

- By default, **Draw Mode** is active, indicated by the **Pencil Tool** icon. You can draw notes by clicking the corresponding position in the grid. You can also use it to draw automation curves in the velocity/automation lane underneath the grid.

- The **Select Mode** is indicated by the **Select Box** icon and lets you select one or more notes by drawing a frame around them. Selected notes will have a white border.

Learn more about these modes under **Pencil and Select Box Icons** in the **Adjusting the Controls** part of this chapter.

Duplicate note events by selecting them on the grid and then pressing **Ctrl+D** (Windows) or **Cmd+D** (Mac OS X). The selected note events will be automatically copied and pasted, starting from the step just after the last selected note event.

When **Hitting Pads Select Events** is selected, you can press a pad on your MPC hardware to select all events on that pad in the currently shown Sequence.

Click **Show/Hide List** to switch between the Grid View and List View. See the following **List View** section for an explanation of this view.

Click **Undo** (the red arrow) to undo your last action.

Click **Redo** (the green arrow) to redo the last action you undid.
In the upper-right corner of the Grid View, there are some menus and parameters you can adjust:

- Click the **Track** drop-down menu to select one of the Tracks to view in the grid.
- Click and drag the **Total Bars** field up or down to change the selected Track’s length. The default setting is 2 bars. The maximum length is 999 bars.
- Click the **Time Correct** drop-down menu to select the note value to quantize to. Default is $1/16$ (16th notes).
- Click and drag the **Swing** field up or down to set the amount of swing (from 50% to 75%) so you can "shuffle" your beats—from subtle to extreme.

**Hardware:**

- Press the **Main** button and use the **Cursor Buttons** to select the **Trk** field. Use the **Data Dial** or the -/+ buttons to select the desired Track. You can also use the F3 (Track-) or F4 (Track+) buttons.
- To change the number of bars, select the **Bars** parameter.
- To adjust the Time Correct and Swing, press the F1 button (T.C.) and use the **Cursor Buttons** to select the **Note** field or **Swing** field. Use the **Data Dial** or the -/+ buttons to set the desired value. Press F5 (Do It) to confirm the operation or press F4 (Close) to cancel it without making any changes.
Across the top of the grid is a blue strip that indicates where you are in the Sequence:

- The number in the upper half is the bar number.
- The number in the lower half (of the first beat of the first bar) is the time signature. To change the time signature, double-click in the measure bar and enter the desired signature in the drop-down window.
- The red arrows (►) indicate the start and the end of a Sequence. When a Sequence is played back using Play Start, the audio pointer will start playing from the first beat of the first bar. If the Loop function is activated (in the Sequence panel underneath the grid), the Sequence will loop between the beginning of the first bar and the end of the last bar. When creating a new Sequence, the first bar will default to Bar 1.

You can change the start point and end point of a Sequence by adjusting the First Bar and Last Bar parameters in the Sequence section below the grid. The red arrows in the measure bar will be placed accordingly. For more information on this, please see Main Mode > Sequence Section.

The section under the grid is the velocity/automation lane. Here, you can edit MIDI velocity data of the note events in the grid and/or create and edit complex automation data for various parameters. The default parameter visible in the automation lane is Velocity.

Learn more about velocity in Grid View > Entering and Editing Note Events.

Learn more about automation in Grid View > Recording Automation as well as Grid View > Manually Entering and Editing Automation parts of this chapter.
Entering and Editing Note Events

You can easily insert note events and data with your computer mouse.

**Hardware:** Press the **Rec** button to record-arm the software, and press the **Play** or **Play Start** button when you’re ready to record. The metronome will pre-count one measure before the recording starts. Press the pads to record note events in the Sequence. Press the **Stop** button when you’re finished recording.

**Tip:** Whenever possible, we recommend recording note events with your MPC hardware’s pads, which are velocity- and pressure-sensitive, providing a faster and more intuitive recording process.

In the software, you can create or delete note events with the Pencil Tool (in Draw Mode) or with the Select Box Tool (in Select Mode):

In Draw Mode:
- Click once on an empty square in the grid to place a note event in that square.
- Double-click a note event to erase it.

In Select Mode:
- Click and drag the box over note events on the grid to highlight them.
- Double-click an empty square in the grid to add a note event.
- Double-click a note event to erase it.

Click a note event to hear its corresponding pad.

You can delete a note event if it is selected by pressing **Backspace** or **Delete** on your computer keyboard.

The length of note events depends on the **Time Correct** value (e.g., if set to 16, the note event length will be a 16th note).

To shorten or extend a note event in steps corresponding to the **Time Correct** value, click and drag its start point or end point left or right.
Click and drag a note event to move it to another position (when multiple note events are selected, you can move them all simultaneously). You can position note events only on quantization values defined by the set **Time Correct** value (indicated by vertical lines in the grid), but if you hold down your keyboard’s **Shift** key while moving a note event, you can drag it to any position you like, regardless of the selected **Time Correct** value.

Hold down **Control** (Windows) or ⌘ (Mac OS X) and move a note to duplicate it. You can also duplicate note events by selecting them on the grid and then pressing **Ctrl+D** (Windows) or ⌘+D (Mac OS X). The selected note events will be automatically copied and pasted, starting from the step just after the last selected note event.

Use the copy-and-paste function to copy a note in the clipboard (**Ctrl+C** [Windows] or ⌘+C [Mac OS X]) and paste it automatically where the audio pointer is (**Ctrl+V** [Windows] or ⌘+V [Mac OS X]).

**Tip:** Press your MPC hardware’s **16 Level** button to activate/deactivate 16 Level. When activated, the last pad that was pressed will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the software, in the window that appears, click the **Type** menu to select the parameter: **Velocity**, **Tune**, **Filter**, **Layer**, **Attack**, or **Decay**. You can change the pad by clicking the **Pad** drop-down menu in the window that appears. Alternatively, you can press and hold the **16 Level** button, press the desired pad, and then release both.
Use the velocity lane to edit note events' velocities.

Click a note event in the grid or place the mouse over its velocity bar in the lane. A small round handle will appear at the top of the velocity bar. Click and drag the round handle up or down to change the velocity. To increase the resolution, hold Control (Windows) or ⌘ (Mac OS X) on your computer keyboard while dragging.

You can also edit multiple note events' velocities simultaneously. Select multiple note events with the Select Box tool, and then click and drag any one of their velocity bars up or down. To select all note events for a single pad (Drum Program) or key of the virtual keyboard (Keygroup Program), click the desired pad or key.

**Tip:** List View offers a different way to edit velocities. See the List View section of this chapter to learn more.
Recording Automation

Tip: To make automating certain parameters easier, assign certain parameters to the Q-Link Knobs as described in the next section rather than adjusting them in their respective modes. We also recommend using your MPC hardware (especially the Q-Link Knobs) whenever possible.

1. Determine where the parameter you want to automate is—Main Mode, Program Mixer Mode, or Track Mixer Mode—and click the Main Mode, Program Mixer Mode, or Track Mixer Mode tab to enter that mode.

2. If the desired parameter is Program- or pad-related, click the Program’s Automation button (curve icon) until it turns red and has a W. This means the Program is able to record (write) automation. In Main Mode and Track Mixer Mode, this button is on the Program Channel Strip. In Program Mixer Mode, this is in the Master Section.

Program- or pad-related parameters include: Program Channel Strip controls, Pad/Keygroup insert effects, Program insert effects, send effects, Master Semi Tune, Master Fine Tune, and all pad parameters shown in Program Edit Mode.

If the desired parameter is Track-related, skip to the next step.

Track-related parameters include: Track Channel Strip controls, MIDI CC messages, Track mutes, pad mutes, the 16-Level feature (on the MPC hardware), Aftertouch messages, Pitchbend messages, Channel Pressure messages, Program Change messages, and parameters shown in the Main Mode’s Q-Link section’s Param menu when set to Prg and Change is set to Note On.

3. Click the Overdub button, and then click Play to start automation recording. It is very important to use the Overdub function; otherwise, this new recording will overwrite any data previously recorded to that Track.

4. Move the desired control(s) during the recording process. The automation curve will appear as you move the control(s).

5. Click Stop you are finished recording.

Tip: After recording, we highly recommend clicking the Automation button on the Program Channel strip so it turns green and has an R. This means the Program will read automation but will not record any additional automation over it, though you can still manually edit and enter automation.
Hardware: To record automation:

1. Determine where the parameter you want to automate is—Main Mode, Program Mixer Mode, or Track Mixer Mode—and press Main, Prog Mix, or Shift + Prog Mix/Track Mix to enter that mode.

2. Use the Function Buttons to select the desired tab or window (if available), and/or use the Cursor Buttons to select the parameter you want to automate.

3. If the desired parameter is Program- or pad-related, press the Q-Link Trigger button until it flashes (you may need to press it twice).

   If the desired parameter is Track-related, skip to the next step. (Note that in Track Mixer Mode, when the Mixer field is set to Tracks, you can record automation for the level and pan for the currently selected Track only, not all 16 Tracks shown.)

4. Click the Overdub button, and then click Play to start automation recording. It is very important to use the Overdub function; otherwise, this new recording will overwrite any data previously recorded to that Track.

5. Move the corresponding MPC hardware control(s) during the recording process (depending on the parameter(s) you are automating, the control(s) may include the Data Dial, +/- buttons, and/or the Q-Link Knobs). The automation curve will appear as you move the control(s).

6. Press Stop when you are finished recording.

   Tip: When you are done recording, we highly recommend pressing the Q-Link Trigger button until it is lit solid. This means the Program will read automation but will not record any additional automation over it, though you can still manually edit and enter automation.

To assign certain automatable parameters to the Q-Link Knobs:

1. Click the Main Mode tab to enter Main Mode.

2. Click and move a Q-Link Knob so that its number appears in the Q-Link field in the Q-Link Section.

3. In the Q-Link Section:
   Click FX if you want to automate an effect parameter. Click the Effect drop-down menu to select an effect (which must be already loaded). The available effects will be ordered by pad insert effects, Program insert effects, send effects, and master effects.

   Click Prg if you want to automate a real-time parameter. Click the Pad drop-down menu to select a pad, and click the Change drop-down menu and select the type of change: Note On or Real Time.

4. Click the Param drop-down menu and select the parameter you want to automate.

5. Optional: If you want to record automation for multiple parameters simultaneously, repeat Steps 2-4 for each additional parameter.
Hardware: To assign certain automatable parameters to the Q-Link Knobs:

1. Press the Shift + Prog Edit / Q-Link buttons.
2. Touch a Q-Link Knob so that its field is selected in the display.
3. To automate an effect parameter:
   - Press F2 (FX Q).
   - Press F4 (Edit), and then use the Data Dial or -/+ buttons to select an effect (which must be already loaded). The available effects will be ordered by pad insert effects, Program insert effects, send effects, and master effects.
   - Press F4 (Close) when you are done.

To automate a real-time parameter:
   - Press F1 (Prog Q).
   - Press F4 (Edit), and then press the desired pad, or use the Cursor Buttons to select the Pad field, and then use the Data Dial or -/+ buttons to select a pad.
   - Use the Cursor Buttons to select the Change field, and then use the Data Dial or -/+ buttons to select the type of change: Note On or Real Time.
   - Press F4 (Close) when you are done.

4. With the Q-Link Knob still selected, use the Data Dial or -/+ buttons to select a parameter you want to automate.
5. Optional: If you want to record automation for multiple parameters simultaneously, repeat the instructions in Step 3 for each additional parameter.

The Program Q-Link Edit window of the MPC hardware display.
Manually Entering and Editing Automation

In the software, follow these steps to manually enter or edit automation in Grid View:

**Tip:** You can manually enter or edit automation regardless of the setting of the Automation button on the Program Channel strip.

1. If you want to manually enter or edit automation for a pad in a Drum Program, select the pad whose automation you want to enter or edit. Otherwise, skip to the next step.

2. **To manually enter automation for a new parameter:** To the left of the velocity lane, next to Automation, click the triangle (▼) and select a parameter. Depending on the Program type, you can select parameters that affect the entire Track, the entire Program, or a specific pad. Parameters that are dark blue already have automation, while parameters that are grey do not, though you can still select them.

   **To edit existing automation:** To the left of the velocity lane, under Automation, click the desired parameter. Parameters with a green T icon affect the entire Track. Parameters with a blue P icon affect the entire Program. Parameters with a red P icon are specific to the current pad.

3. In the automation lane, you can enter or edit the automation points that make up the automation curve.

   **To move an automation point,** click and drag it. Dragging it up and down adjusts the parameter amount, while dragging it left or right adjusts its location in time. The automation points will automatically align with the grid set by your TimeCorrect setting, but you can hold the Shift key of your computer keyboard while dragging the automation points to ignore this quantization.

   **To add a new automation point,** double-click the desired location in the automation lane.

   **To delete an automation point,** double-click it.

   **To draw a curve,** use the Pencil Tool (Draw Mode) and click and drag it across the lane.

   **To adjust several adjacent automation points simultaneously,** use the Select Box Tool (Select Mode) to select them and then click and drag any one of the automation points as desired.

**Tip:** List View offers a different way to edit automation. See the List View section of this chapter to learn more.
List View

In List View, you can perform the same operations as in Grid View but with a different interface/workflow.

List View is visible in Main Mode, Program Edit Mode, Program Mixer Mode, Pad Mute Mode, and Step Sequencer Mode.

If you are not already in List View, enter it by doing any of the following:
- Click the View Menu and select List Editor.
- Click the List View button just below the Mode Tab.
- Press Shift+L on your computer keyboard.

Hardware: To enter or exit List View, press Shift + Step Seq.

Note: The alternative to List View is Grid View, explained in the earlier Grid View section. Click the Show/Hide List button to switch between the two views.

The Sequence for the Track will be shown as a list of note events, with the following parameters:
- #: The number of the note event.
- Time: The position of the note event in bars, beats, and ticks (identical notation to the clock in the Transport Section). Hover the mouse over the value to see its equivalent in pulses. If multiple note events occur at the same time, additional note events will be listed immediately below, but their Time values will be greyed out.
- Pad/Note: The pad and/or corresponding MIDI note number. For Drum Programs, you will see the pad number. For Keygroup Programs, Plugin Programs, and MIDI Programs, you will see the note.
- Length: The length of the note event in ticks.
• **Velocity:** The velocity of the note event with a velocity bar of corresponding color and length below it.

• **Mod Type:** The type of modifier used on the note event via automation. See the **Mod description on this page in Entering and Editing Events** to learn more.

• **Value:** The value of the modifier automation. See the **Value description on this page in Entering and Editing Events** to learn more.

**Hardware:** In List View, the Sequence for the Track will be shown as a list of note events, with the parameters listed above except for #. To set whether or not the list will scroll during playback, press **Window** when any List View field is selected and use the **Data Dial** or -/+ buttons to select **Off** or **Scroll**.

```
<table>
<thead>
<tr>
<th>Time</th>
<th>Note Pad/Note</th>
<th>Length</th>
<th>Mod Type/Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:01:00</td>
<td>Note: A03(42)</td>
<td>24</td>
<td>127: Tuning 24</td>
</tr>
<tr>
<td>00:01:24</td>
<td>Note: A03(42)</td>
<td>24</td>
<td>127: Tuning 24</td>
</tr>
<tr>
<td>00:01:48</td>
<td>Note: A03(42)</td>
<td>24</td>
<td>127: Tuning 24</td>
</tr>
<tr>
<td>00:02:00</td>
<td>Note: A03(42)</td>
<td>24</td>
<td>127: Tuning 32</td>
</tr>
</tbody>
</table>
```

List View in the MPC hardware display.

To show or hide specific parameter columns, right-click one of the parameter names, and select the parameter column to show or hide. You can also choose to **Auto-size this column** or **Auto-size all columns** to fit the contents.

The red arrow (►) on the left side of the list represents the audio pointer’s current position. If your Sequence is playing, the arrow will move accordingly.

Click **Show/Hide List** to switch between the Grid View and List View. See the previous **Grid View** section for an explanation of this view.

**Hardware:** Press **Shift + Step Seq** to switch between the Grid View and List View.

Click **Undo** (the red arrow) to undo your last action.

**Hardware:** Press **Undo** to undo your last action.

Click **Redo** (the green arrow) to redo the last action you undid.

**Hardware:** Press **Shift + Undo / Redo** to undo your last action.
In the upper-right corner of the List View, there are some menus and parameters you can adjust:

- Click the **Track** drop-down menu to select one of the Tracks to view in the grid.
- Click and drag the **Total Bars** field up or down to change the selected Track’s length. The default setting is 2 bars. The maximum length is 999 bars.
- Click the **Time Correct** drop-down menu to select the note value to quantize to. Default is 1/16 (16th notes).
- Click and drag the **Swing** field up or down to set the amount of swing (from 50% to 75%) so you can “shuffle” your beats—from subtle to extreme.

**Hardware:** Press the **Main** button to enter Main Mode, and use the **Cursor Buttons** to select a field, and use the **Data Dial** or the -/+ buttons to set the desired value:

- To change the current Track, select the **Trk** field. You can also press **F3** (Track-) or **F4** (Track+).
- To change the number of bars, select the **Bars** parameter.
- To adjust the Time Correct and Swing, press **F1** (T.C.) and select the **Note** field or **Swing** field. Press **F5** (Do It) to confirm or **F4** (Close) to cancel the operation.

In the lower-right corner of the List View, there are some icons to let you insert, duplicate, or view events:

- Click the + icon and select the type of event to insert it.
- Click the page icon when an event is selected to copy and paste it immediately after it.
- Click the **View** drop-down menu and select the type of event to view it: All, Notes, Aftertouch, Track Automation, Program Automation, Pitch Bend, Control Change, Program Change, Channel Pressure, Solo/Mute, or Other.

**Hardware:** Use the **Cursor Buttons** to select the **View** field, and use the **Data Dial** or the -/+ buttons to set the type of event. To insert or copy an event, please see Entering and Editing Events below.

**Entering and Editing Events**

To insert an event at the audio pointer’s current position, click the + icon in the lower-right corner of the List View and select the type.

**Hardware:** Press **F4** (Insert) to open the Insert Event window. Use the **Cursor Buttons** to select the **Time**, **Type**, or **Pad(Note)** fields, and use the **Data Dial** or -/+ buttons to set the value. Alternatively, simply press the pad you want to use in the **Pad(Note)** field. Press **F5** (Do It) to confirm or **F4** (Close) to cancel the operation.
In the software, the Pencil Tool and Select Box Tool will be greyed out as they are disabled in List View. You can enter notes in List View only by playing the pads, but List View offers a different way to edit your notes than in Grid View.

As in Grid View, you can do the following in List View:

- Click a note event to hear its corresponding pad.
- Delete a event if it is selected by pressing Delete or Backspace on your computer keyboard.
- To shorten or extend a note event (in ticks), click and drag its Length value left or right.
- Duplicate events by selecting them in the list and then pressing Ctrl+D (Windows) or ⌘+D (Mac OS X). The selected events will be automatically copied and pasted to the same position (one note event on top of another). Alternatively, click the page icon in the lower-right corner of the List View to duplicate an event to copy and paste it immediately after it.
- Use the copy-and-paste function to copy an event (Ctrl+C [Windows] or ⌘+C [Mac OS X]) and paste it automatically where the audio pointer is (Ctrl+V [Windows] or ⌘+V [Mac OS X]).

**Hardware:** (Use the Cursor Buttons in List View to select the desired note event.)

- To hear a note event’s corresponding pad, press F6 (Play).
- To delete a selected event, press F2 (Edit) so it is highlighted, and then press F3 (Delete).
- To shorten or extend a selected note event (in ticks), select the Length field and use the Data Dial or +/- buttons to adjust its length.
- To copy and paste a selected event, press F2 (Edit) so it is highlighted, and then press F4 (Copy). Use the Cursor Buttons to each Copy To (time) field, and use the Data Dial or +/- buttons to set the value. Press F4 (Do It) to confirm or F3 (Close) to cancel the operation.

Edit options in List View in the MPC hardware display.

Edit the velocity of a note event by clicking and dragging its Velocity value left or right.

**Hardware:** To adjust a selected note event’s velocity, select the Vel field and use the Data Dial or +/- buttons to adjust its velocity.
To edit a specific event, double-click it, and a small window will appear with a combination of the following options, depending on the **Type**:

- **Time**: The position of the event in bars, beats, and ticks (identical notation to the clock in the Transport Section), each in a different field. To change the value, either click and drag a field up or down, or click it and enter a value using your computer keyboard.

  **Hardware**: To adjust the position of a selected event, press **F2** (Edit) so it is highlighted, and then press **F5** (Move). Use the **Cursor Buttons** to each Copy To (time) field, and use the **Data Dial** or +/- buttons to set the value. Press **F4** (Do It) to confirm or **F3** (Close) to cancel the operation. Alternatively, press **F4** (Nudge) to and use the **Data Dial** or +/- buttons to adjust the **Time**.

- **Type**: The type of event. By default, this is a note event, but you can click the field and select any of the options from the menu that appears:
  
  - **Note**: A standard note event.
  
  - **Track**: A modifier that affects the Track and can be automated. Dark blue parameters already have automation, while grey parameters do not, though you can still select them.
  
  - **Program**: A modifier that affects the Program and can be automated. Dark blue parameters already have automation, while grey parameters do not, though you can still select them.
  
  - **Pad**: A modifier that affects the pad and can be automated. Dark blue parameters already have automation, while grey parameters do not, though you can still select them.

- **Pad**: The pad number. To change the pad, either click and drag the field up or down, or double-click it and select the pad from a visual representation of all eight pad banks.

- **Vel**: The velocity of the note event. To change the value, either click and drag the field up or down, or click it and enter a value using your computer keyboard.

- **Len**: The length of the note event in ticks. To change the value, either click and drag the field up or down, or click it and enter a value using your computer keyboard.

- **Mod**: The type of modifier used in the event (through automation). Click the field and select one from the menu that appears.

- **Value**: The modifier’s value (through automation). Click and drag the bar left or right to set it.

  **Hardware**: To set a selected event’s pad, velocity, length, modifier, or value, select the **Pad/Note**, **Vel**, **Length**, **Mod Type**, or **Value** field (respectively) and use the **Data Dial** or +/- buttons to adjust it.
Entering Automation

To manually enter automation in List View, follow the same process described in *Entering and Editing Events* above, but instead of *Note*, select the *Track*, *Program*, or *Pad* parameter you want to automate. You can enter automation regardless of the setting of the *Automation* button on the Program Channel strip.

**Hardware:** To manually enter automation in List View, follow the same process (for your MPC hardware) described in *Entering and Editing Events* above, but instead of selecting *Note* as the *Type*, select *Program Automation*, *Program Mixer*, or *Track Automation*, and select *Parameter* you want to automate.

**Tip:** To learn how to record automation in real time, please see *Grid View > Recording Automation*.

Editing Automation

To edit automation in List View:

1. If you want to edit automation for a pad in a Drum Program, select the pad whose automation you want to enter or edit. Otherwise, skip to the next step.

2. **To edit existing automation:** Click and drag a *Value* slider of the desired automation point to the left or right. For parameters with a center position, the center is marked with a 0 and a vertical line.

   Parameters with a green T icon affect the entire Track. Parameters with a blue P icon affect the entire Program. Parameters with a red P icon are specific to the current pad. Note events appear as gold note symbols without a *Value* slider.

3. In the list, you can edit the automation points that make up the automation curve.

   **To move an automation point,** double-click it in the list. In the small window that appears, click and drag any of the *Time* fields up or down, or click one and enter a value using your computer keyboard. This kind of adjustment will ignore your *Time Correct* setting (quantization), so it may not be aligned with the grid if the adjustment is too subtle (e.g., only a few ticks).

   **To delete an automation point,** click it, and then press *Delete* or *Backspace* on your computer keyboard.

**Hardware:** To edit automation in List View, follow the same process (for your MPC hardware) described in *Entering and Editing Events* above. The difference is that automation events will not have *Length* or *Velocity* (Vel) parameters.
Software Menus

Some of the software’s menu items let you access features that cannot be accessed with the MPC hardware.

Important:
- The software menu organization differs between Windows and Mac OS X operating systems.
- When loaded as plugin, the Menu button is the arrow icon located to the left of the Main Mode tab.

File Menu

New Project creates an empty Project. Use this command when you want to start a Project from scratch.

New From Template loads a user-defined Project template. We recommend creating a Project with the basic settings that suit your needs and saving it as a Project template for easy access. See Software Menus > Edit Menu > Preferences: Auto Load/Save Tab to learn how to set this template.

Tip: You can “bypass” or ignore the template by opening the MPC software while holding down your computer’s Shift key. This will open an empty Project instead of your selected Auto Load file.

Load Recent provides shortcuts to the last five files you have been recently working with. The list is chronological with the most recent file at the top.

Save Project saves the current Project. In the window that appears, name your Project and select a save location. The samples in the Project Information will be automatically saved with the Project. The Project file (.xpj), and its information (samples, MIDI files, Program files, etc.) will be saved in a folder with the same name on the same folder level.

Save Project As is identical to the Save Project function but lets you save the current Project with a new name.
Save All Programs saves all Programs of your Project.

Save Current Program saves only the current Program.

Save Current Sequence saves only the current Sequence.

Save MIDI Control Scene saves your control map as set in MIDI Control Mode. See the *MIDI Control Mode* chapter for more information about creating a control map.

Export lets you export your Project or Sequence data in various formats: a single Project Archive file, MPC formats, a standard MIDI file, or as an audio mixdown file. Select the desired option from the submenu.

- **As Project Archive** exports the entire Project as a Project Archive file (.xpa). In the window that appears, enter a file name and set the save location. This option is useful when you want to transfer a Project between different computers without dealing with its component files.
- **As MPC1000/MPC2500 Seq** exports the current Sequence so it can be read by an MPC1000 or MPC2500.
- **As MPC1000/MPC2500 Prg** exports the current Program so it can be read by an MPC1000 or MPC2500.
- **As MPC5000 Seq** exports the current Sequence so it can be read by an MPC5000.
- **As MPC5000 Prg** exports the current Program so it can be read by an MPC5000.
- **As MIDI File** exports the Sequence as a standard MIDI file (.mid). In the window that appears, enter a file name and set the save location. This option is useful when you want to import your Sequences into separate sequencer software or exchange your Sequences with another artist.
• As Audio Mixdown exports the Sequence or Song as an audio file (if you are in Song Mode, this will affect the entire Song; if you are in any other mode, this will affect the current Sequence only). You can also access this command by pressing Ctrl+Shift+E (Windows) or ⌘+Shift+E (Mac OS X) on your computer keyboard. In the window that appears, you can set the audio file's format:

  o **Audio Length** lets you define the length of your audio file with the **Start bar** and **End bar**, allowing you to export a certain number of measures only. You can also set the length of a "bounce tail" (**Tail**) in seconds, which is useful when working with audio effects like reverb or delay, whose sound may exceed the defined export range.

  o **Render source** lets you select between **Stereo output** and **Separate programs** and **Explode tracks**. **Stereo output** will render an audio output, which you can select by clicking the drop-down menu under the checkbox. **Separate programs** will render an audio mixdown of each Program used in the Sequence or Song. **Explode tracks** will render an audio mixdown of each Track used in the Sequence (this feature does not work in Song Mode).

  o The available **Render options** depends on your **Render source**. When **Master inserts** is checked, the audio mixdown will include master effects. When **Export returns** is checked, the audio mixdown will also export return buses. When your **Render source** is set to **Separate programs** or **Explode tracks**, **Master inserts** is bypassed, so this option is disabled.

  o **File format** lets you select wav, aiff, or mp3 as the exported file format. For WAV and AIFF files, you can select a **Bit depth** of 8-bit, 16-bit, 24-bit, or 32-bit, **floating point**. For MP3 files, you can select a **Bitrate** of 128 kbps, 160 kbps, 192 kbps, or 320 kbps.

  o **Sample rate** lets you select from 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most cases, we recommend selecting 44.1 kHz.

  o Click **Export** to open a window where you can enter a file name and set the save location.

  o Click **Cancel** to close the window without exporting.
Exit closes the software. If you have not saved any changes made to a currently open project, it will prompt you to do so before quitting.

**Mac OS X users:** The Exit command is named Quit MPC and located in the MPC menu.

**Edit Menu**

**Undo** undoes the last action you performed. When there are no actions left to undo, the Undo command will be unavailable and appear greyed out.

**Redo** undoes the Undo command. You can continue redoing actions until there are no items left to redo, in which case, the Redo command will be unavailable and appear greyed out.

**Important:** If you perform a new action when the Redo command is available, you will no longer be able to redo. In other words, as soon as you perform an editing action other thanUndo, Redo is no longer available.

**History** lets you view a list of previously executed commands in the Command History window. As you undo and redo commands, you can see your current "position" in the list of commands in the window.

To revert to a previous "state" in your Project, click and drag the point just after the last step. Any "undone" steps will be greyed out. You can do the same to redo all the greyed-out steps, as well.

**Cut** removes selected events from the grid and copies it to the clipboard. After cutting events, you can paste or insert them at another location in the same or another Sequence.

**Copy** copies selected events from the grid to the clipboard without removing them. After copying events, you can paste or insert them at another location in the same or another Sequence.
**Paste** lets you to paste the contents of the clipboard at the position marker's current location.

**Select All** selects all note events in the current Sequence and Track.

**Deselect All** deselects all note events in the current Sequence and Track.

**Sequence** provides options related to editing the current Sequence:
- *Clear* erases all Tracks and their note events from the current Sequence. After selecting this, click *Clear* to confirm your choice or *Cancel* to cancel it. *This operation cannot be undone."
- *Export* lets you export the current Sequence as a standard MIDI (.mid) file.
- *Next Sequence* selects the next Sequence. You can also press *Ctrl+Shift+} (Windows) or *⌘+Shift+} (Mac OS X) on your computer keyboard.
- *Previous Sequence* selects the previous Sequence. You can also press *Ctrl+Shift+{ (Windows) or *⌘+Shift+{ (Mac OS X) on your computer keyboard.

**Track** provides options related to editing the current Track:
- *Clear* erases all note events from the current Track. After selecting this, click *Clear* to confirm your choice or *Cancel* to cancel it. *This operation cannot be undone."
- *Explode* automatically splits the current Track into multiple Tracks—one for each distinct pad or note (pitch, not event). The current Track also remains present and intact, while each Track created from it is labeled with the Track Name and pad name or number.
- *Next Sequence* selects the next Sequence. You can also press *Ctrl+Shift+} (Windows) or *⌘+Shift+} (Mac OS X) on your computer keyboard.
- *Previous Sequence* selects the previous Sequence. You can also press *Ctrl+Shift+{ (Windows) or *⌘+Shift+{ (Mac OS X) on your computer keyboard.

**Hardware:** In Main Mode, use the *Cursor Buttons* to select the Trk field, and then Window. Press F2 (Clear) to erase all note events from the current Track, F3 (Explode) to explode the Track, press F4 (Copy) to copy the Track, or press F5 (Close) to cancel the operation.

If you select F4 (Copy), use the *Cursor Buttons* to move between the Copy Contents of Track and Over Contents of Track fields, and use the Data Dial or +/- buttons to change the number. Press F5 (Do It) to copy the Track or press F4 (Back) to cancel the operation.
Preferences opens the Preferences window, which contains many customizable elements of the software. Click the corresponding tab on the left to select it (e.g., MIDI or Sequencer). Click the OK button to close the Preferences window. Preferences will be automatically saved.

Mac OS X users: Preferences is located in the MPC menu.

- Preferences: Audio Tab
  - Audio Device Type and Device (Windows) or Output and Input (Mac OS X): Click these drop-down menus to select an audio hardware driver in your computer system.
    - Windows users: To use an MPC Renaissance’s inputs and outputs to record and play audio (to and from your computer), select ASIO as the Audio Device Type and MPC Renaissance ASIO Driver as the Device, and then check In 1+2. Otherwise, you can select an ASIO hardware driver of your audio interface.
      Tip: If you are using your computer’s internal soundcard, we recommend downloading the latest ASIO4ALL driver at asio4all.com.
    - Mac OS X users: To use an MPC Renaissance’s inputs and outputs to record and play audio (to and from your computer), select MPC Renaissance as the Output and Input, and then check Input 1+2.
  - Test: Click this button to play a test tone. This is for checking your audio output. Careful! You should lower the volume on your audio system beforehand.
  - Sample Rate: Click this to drop-down menu to select the desired sample rate for your Project. This should depend on your audio interface’s available sample rates (i.e., select 96000 Hz only if your interface allows a 96 kHz sample rate).
- **Audio Buffer Size:** Click this drop-down menu to set your audio system’s latency. Lower values result in a more immediate playing response but also more CPU consumption. If you are working with larger Projects, this may cause audible clicks and pops. Higher values are more CPU-friendly but can produce more delay between pressing a pad and hearing the corresponding sound. The ideal audio buffer size also depends on your computer’s CPU performance. Experiment with this to find the best setting for your system.

- **Latency Adjust:** If there is a delay in your audio system even after experimenting with the Audio Buffer Size, click and drag this field up or down to set an offset (in milliseconds).

- **Preferences: MIDI Tab**
  - **Active Midi Inputs:** These checkboxes represent the active installed MIDI inputs on your computer system.
  - **Hardware:** When the MPC hardware is connected and powered on, the available ports as well as the MPC public port are displayed.
  - **Midi Mapping:** Click each drop-down menu to define the Midi Out Port A to D. Here, you can select the MIDI output your Sequencer data is routed to.
  - **Note:** When using the MPC software as a plugin, the only option you can select for your Midi Out Port is your host software (DAW).

- **Preferences: Plugins Tab**

  Here, you can select up to four locations on your hard disk where the software will look for installed VST or AU plugins that you can use as insert or send effects in the MPC software.

  Click the ... button to the right of the field to select a desired location. After selecting a new location, we recommend using the Scan New function. When you make settings for the first time, you should click Rescan All to perform a complete scan of all selected plugin locations.

  **Mac OS X users:** We recommend checking the Use AudioUnits option, enabling you to use also the AudioUnit plugin format.
• **Preferences: Auto Load/Save Tab**
  - **Auto Load File**: Click the ... button to select a Project (.xpj) or Program (.xpm) on your hard disk to load automatically anytime the software opens.
    
    **Tip**: You can "bypass" or ignore the template by opening the MPC software while holding down your computer’s **Shift** key. This will open an empty Project instead of your selected Auto Load file.
  - **Template File**: Click the ... button to select a Sequence template to load automatically anytime you create a new Sequence.
  - **Auto Save**: Click the **Enabled** box to turn Auto-Save on or off. Auto-Save sets the software to save your Project at regular intervals. Click the **Timeout** drop-down menu to select the interval.

• **Preferences: Sequencer Tab**
  
  Here, you can activate or deactivate options related to the software’s sequencer.
  - **Instant Track Mute**: If this option is disabled, Note On messages will be ignored. This is how legacy MPCs’ track-muting worked. This allows samples and notes that are playing to finish playing their entire length. This is useful if you are using loops and want a loop to play to the end of a bar but not play the next time the Sequence loops.
  
  If this option is enabled, MIDI track volume is sent. This is useful when you want to have the Track muted immediately. The loop will continue to play but at zero volume, allowing the loop to continue playing when the Track is unmuted.
  - **Record Track Mute Events**: If this option is enabled, Track Mute events are recorded only when you are in Track Mute Mode. Timing Correct settings will affect the recorded position of Track Mute events.
  - **Play Track Mute Events**: If this option is enabled, Track Mute events are played back only when you are in Track Mute Mode.
- **Record Pad Aftertouch Events**: If this option is enabled, pad aftertouch data (from MPC hardware’s pressure-sensitive pads) can be recorded.
- **Place Events recorded during Count-In at start-point**: If this option is enabled, pressing a pad during the recording’s pre-count will record that note event at the start of the recording. (This is how the MPC3000 worked.)
- **Pulse Resolution**: Click this drop-down menu to select the display resolution (in PPQN—pulses per quarter note) of pulse values in certain areas of the software. Please note that this setting affects the display resolution, not the software’s timing.

### Preferences: Hardware Tab

Here, you can set additional parameters affecting the behavior of your MPC hardware.

**Hardware**: Press Shift + Song and then press F1 (Prefs). Use the Cursor Buttons to select the corresponding option, and use the Data Dial or +/- buttons to change it. Not all options in the software’s Hardware tab are available in the MPC hardware display, and some options are shown that are available in other tabs in the software.

- **Pad Threshold**: Click this drop-down menu to select a threshold that must be exceeded to trigger the pad.
- **Pad Sensitivity**: Click this drop-down menu to set how sensitively your MPC hardware’s pads respond to your touch. At lower values, you need to use more force to generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use much force while pressing a pad.
- **Pad Curve**: Click this drop-down menu to set how your playing is translated into velocity values, starting from A to D. An A pad curve is essentially linear, while the B, C, and D pad curves are exponential. (See diagram to the right.)
Footswitch 1 and Footswitch 2: Click these drop-down menus to select the functionality of footswitches connected to your MPC hardware. You can select either transport commands (e.g., Play or Stop) or trigger commands for pads and the Function Buttons.

Pad Response: View the Velocity and Aftertouch meters when pressing the pads to help gauge the force and pressure you are applying to them. These meters are useful when adjusting the Pad Threshold and Pad Sensitivity parameters (above).

Show Hardware Info: Click this button to open a window with information about your connected MPC hardware (firmware version, driver version, etc.).

Preferences: Sync Tab

Here, you can set various parameters related to the software’s synchronization:

Receive: Click this drop-down menu to select whether or not the software receives MIDI Clock or MIDI Time Code (MTC) from the host software (when MPC is used as a plugin) or from an external device (connected to the MIDI In port of the MPC hardware).

Send: Click this drop-down menu to select whether or not the software sends MIDI Clock or MIDI Time Code (MTC) to the individual ports of the MPC hardware or any connected MIDI interface. Make sure to check the port(s) over which you want to send this information. You can select two MIDI devices connected to your computer to send MIDI Clock or MTC data to. Select your device in each To drop-down menu below it.

MTC Frame Rate: Check one of these boxes to set the frame rate for MIDI Time Code (MTC) synchronization in FPS (frames per second). In most cases, you should select 25. The correct frame rate is important, especially when working on film scoring projects.

Device Control: Check either or both of these boxes to send or receive MIDI Machine Control (MMC) to or from your MPC hardware’s transport buttons. MMC sends only transport commands; it does not include track-arming or more advanced features.
• Preferences: Registration Tab
Here, you can view your hardware registration information (or unlock your MPC software by clicking Unlock Now, if you have not already done so).

• Preferences: Other Tab
Here, you can set various other MIDI and audio parameters.

Hardware: Press Shift + Song and then press F1 (Prefs). Use the Cursor Buttons to select the corresponding option, and use the Data Dial or +/- buttons to change it. Not all options in the software’s Other tab are available in the MPC hardware display, and some options are shown that are available in other tabs in the software.

- Tap Tempo: Click this drop-down menu to set how many times you have to press your MPC hardware’s Tap Tempo button until the new tempo is recognized.
- Filter ‘All Notes Off’ CC: Check this box to filter out All Notes Off data. If you have connected another device to your MPC hardware’s MIDI In, checking this box will cause the software to ignore “All Notes Off” (“MIDI panic”) messages. That is, if a MIDI device sending MIDI messages into the MPC hardware sends a MIDI panic message, the software will not stop all notes and will continue as before (recording, for instance).
- Program Change: Click this drop-down menu to select what an incoming MIDI Program Change message will change: a Program, Sequence, or Track.
- **Vintage Mode**: Click this drop-down menu to select an audio quality emulation for the software’s audio output. The software can emulate the particular sonic qualities of, for example, the MPC3000 or MPC60, or of course no emulation (None).

- **Sampling Bit Depth**: Click this drop-down menu to set the bit depth of the audio recorded from a sample.

- **Multi Process Threads**: Click and drag the number in this field up or down to set how many cores of your computer’s processor will be used to render audio. The available range depends on your processor.

- **Audition Auto Play**: Click and drag the number in this field up or down to set how long a sample will sound when auto-previewing it.

---

**Metronome Menu**

This menu contains all settings regarding the Metronome.

**Count-In** enables or disables the metronome pre-count before recording.
- **Off** disables the metronome pre-count.
- **Record** enables the pre-count during recording only.
- **Record + Play** enables pre-count in both Record and Playback Modes.

**Metronome** offers the settings for the metronome.
- **Off** disables the metronome.
- **Play** enables the metronome sound during playback only.
- **Record** enables the metronome sound during recording only.
- **Record + Play** enables the metronome to happen in both Record and Playback Modes.

**Rate** lets you to select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T (“T” stands for “triplet”).

**Sound** lets you to select the sound that you want to hear for the metronome: Sidestick1, Sidestick2, Clap, Metroclick, Shake, Tambourine, or MpcClick.
Time Correct Menu

Here, you can select Quantization settings.

**Apply** quantizes the currently selected note events. If no note events are selected, nothing will be quantized.

**Settings:** Click this to open the Time Correct window with the following functions. You can also open this window by pressing **Ctrl+Shift+K** (Windows) or **⌘+Shift+K** (Mac OS X) on your computer keyboard.

- **Time Division:** Click a box to select the note value to quantize to. Default is 1/16. You can select from different quantizations, including triplet (T) values. You can also do this with your computer keyboard by pressing any number key (1-0) in the top row or the – key to turn quantization off.

- **Swing:** Click and drag this field up or down to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle to extreme.

- **Shift Timing:** Click and drag this field up or down to shift all note events by clock ticks.

- **Window:** Click and drag this field up or down to set how many notes around a quantize value will be quantized. Any notes outside this range will not be quantized; notes inside will.

- **Strength:** Click and drag this field up or down to set how strictly notes will be quantized (i.e., shifted toward the quantize value). Lower values move notes a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict quantization (a higher value).

- **Events:** Click this drop-down menu select the target range for the time correction. You can apply the time correction to **All** note events or to just the **Selected** ones. When **Range** is selected, you can define the bars as well as the pads or keys that will be quantized. The selection is done on the MPC hardware.

**Hardware:** When **Range** is selected, you can define the pads or keys to be quantized by pressing their corresponding pads. Selected pads are shown in the Time Correct window. Use the Cursor Buttons to select the Events Range parameter to select the range of bars for quantization.

Click **Do It** to apply the settings you made, or click **Close** to cancel without making any changes.
Lengths: Click this to open the Time Correct Note Lengths window. Its fields are identical to the Time Correct Settings windows described above but with the addition of a Type drop-down menu.

Click the Type drop-down menu and select one of the following options:

- **End**: The end points of note events will be extended or cropped so they align with the closest Time Division marker in the grid. The start points will remain untouched.

- **Length**: The end points of note events will be extended or cropped so the note event’s length is a multiple of the Time Division, regardless of where it is in the grid. The start points will remain untouched.

- **Legato**: The end points of note events will be extended or cropped to create a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event will sustain until another note event starts. If multiple note events start at the same time (and are not the last note events), their lengths will become identical. Selecting Legato disables all other options in this window.

Click **Do It** to apply the settings you made, or click **Close** to cancel without making any changes.

Without legato applied.                  With legato applied.
Tools Menu

**Delete Unused Samples** deletes any samples not assigned to a pad from the Project.

*Important:* The samples will be deleted *immediately* from the project. The software will not ask for confirmation or allow you to cancel, but you can undo this action (i.e., with the *Undo* command or hardware button), if needed.

**Tip:** You can delete unused samples by clicking the trash can icon in the upper-right corner of the *Project Information*, as well.

**Show MIDI Keyboard** shows or hides a piano keyboard at the bottom of the window, above the Transport Section. You can also do this by pressing *Ctrl+Shift+W* (Windows) or *⌘+Shift+W* (Mac OS X) on your computer keyboard. You can use these keys to play or enter notes.

**MIDI Keys** enables or disables the use of your computer keyboard to enter or play a range of 17 MIDI notes, starting from a C. You can also do this by pressing *Ctrl+W* (Windows) or *⌘+W* (Mac OS X) on your computer keyboard. Press the [ or ] key on your computer keyboard to shift the range of playable notes up or down (respectively) by one octave.

On standard US/American computer keyboard, use the A, S, D, F, G, H, J, K, L, and ; keys to play the white keyboard keys, and use the W, E, R, T, Y, U, I, O, and P keys to play the black keyboard keys.

If the MIDI Keyboard is shown, the corresponding computer keyboard character will be shown above each key (though you can still use MIDI keys even if it is hidden).
View Menu

**Mode** lets you select any of the 12 modes as an alternative to the mode tabs above it.

*Tip:* On your computer keyboard, press and hold **Ctrl** (Windows) or  (Mac OS X) and then press 1-10, - . , or = to select a mode.

**Editor Full Screen** lets you switch between Split View and Full-Screen View. This is the same as clicking the View button in the upper-right corner of the window.

**File Browser** lets you show or hide the File Browser. You can also do this by clicking the triangle button (▲ or ▼) in the lower-left corner of the window or by pressing **Shift+B** on your computer keyboard.

**Expansion Browser** lets you show or hide the Expansion Browser when the File Browser is shown. You can also do this by clicking the “arrows-in-an-X” button in the lower-left corner of the window or by pressing **Shift+E** on your computer keyboard.

**Grid Editor** enters Grid View (described in the earlier Grid View section). You can also do this by clicking the List View button just below the Mode Tab (if you are currently in List View) or by pressing **Shift+G** on your computer keyboard.

**List Editor** enters List View (described in the earlier List View section). You can also do this by clicking the List View button just below the Mode Tab (if you are currently in Grid View) or by pressing **Shift+L** on your computer keyboard.

**Minimize** minimizes the MPC software window.

**Full Screen** maximizes the MPC software window.
Help Menu

**MPC Help** opens this PDF manual.

*Mac OS X users: About MPC and Check for updates... are located in the MPC menu.*

**MPC Release Notes** opens the documentation for changes and improvements in the current release.

**Set Up MMC Control** opens a PDF with instructions on how to allow your MPC hardware’s transport buttons to send MMC (MIDI Machine Control) messages from the MPC plugin to your host software. This allows you to use your MPC hardware to control your host software’s transport. This is available for certain host software applications only.

**Hybrid Instrument Help** opens the Hybrid 3 User Guide PDF.

**Check for Updates...** checks online if a newer version of the software is available. You need an active Internet connection to use this function.

**Unlock MPC** opens a window where you can enter information to unlock your MPC software (if you have not already done so).

**About MPC** shows information about the software version.
Main Mode

Main Mode gives you an overview of the most-used functions.

To enter Main Mode in the software, do one of the following:

- Click the **Main Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Main**.
- On your computer keyboard, press **Ctrl+1** (Windows) or **⌘+1** (Mac OS X).

**Important:** The MPC hardware cannot display as many parameters at the same time as the software. Some of the MPC hardware functions are located on different pages than in the software.
Q-Link Section

Here, you can set the functionality of the Q-Link Knobs.

The Q-Link section can work in two modes: Program Mode (Prg) and FX Mode.

- **Program Mode**: The 16 Q-Link Knobs control specific Program parameters of the selected Program.
- **FX Mode**: The 16 Q-Link Knobs can be assigned to the parameters of used effects.

By switching between these two modes, you are able to define two parameters for each knob. This offers maximum flexibility when controlling parameters in real time.

**Hardware**:

- Access the Q-Link Section by pressing Shift + Prog Edit / Q-Link.
- Touch the top of a Q-Link Knob to select it.
- Press F1 (Prog Q) to switch to Program Mode. Press F2 (FX Q) to switch to FX Mode.
- Press F4 (Edit) to change further parameters, described later in this section.
- Use F5 (Params) to see what parameter each of the 16 Q-Link Knobs controls. Pressing F6 (Values) displays the parameter value of each Q-Link Knob.

**Important**: The MPC Renaissance has 16 Q-Link Knobs, allowing direct access to all 16 parameters, whereas the MPC Studio is equipped with 4 Q-Link Knobs which need to be assigned to the corresponding Q-Link Knob column or row with the Scroll Knob above the Q-Link Knobs.

In modes where the display shows a "4 x 4" array of parameters, you will see an additional indicator on the top or left side of the array, indicating the currently controlled row/column:

- The Q-Link Knobs control **columns** of parameters in Main Mode, Program Edit Mode, Track View Mode, Sample Edit Mode, and Step Sequence Mode.
- The Q-Link Knobs control **rows** of parameters in Program Mixer Mode and Track Mixer Mode.
Program Mode

Click the Prg button to activate the Q-Link Knobs’ Program Mode. To assign a parameter to a Q-Link Knob in the software:

1. Click a Q-Link Knob and move the mouse to select it for assigning. The Qlink field will show the number of the selected knob.
   **Hardware:** Touch the top of a Q-Link Knob to select it.

2. Click the Trig drop-down menu and select Min or Max. When you hold down the Q-Link Trigger button on your MPC hardware and touch the top of one the Q-Link Knobs, the corresponding parameters will jump to either its minimum (Min) or maximum (Max) value.
   **Hardware:** Use the Cursor Buttons to select the Touch To field, and then use the Data Dial or -/+ buttons to select Min or Max.

3. Click the Pad drop-down menu and select the desired pad you want to control. We recommend using Q1 for Pad A01, Q2 for Pad A02 etc., so your controller mapping is easy to remember.

4. Click the Change drop-down menu to select the condition for changing a parameter. In most cases, you should select Real Time, which changes the sound immediately when the Q-Link Knob is moved. If Note On is selected, the Q-Link Knob’s position will affect the sound only when its corresponding pad is pressed.

5. Click the Param (Parameter) drop-down menu and select the parameter you want to assign to the Q-Link Knob:
   - Sample Layer allows you to switch between Sample Layers 1 to 4. To use this function, each layer must have an assigned sample with distinct (non-overlapping) velocities. See Program Edit Mode > Edit Layers Section to learn how to set sample layer velocities.
   - Tuning controls the sample’s pitch.
   - Filter Cutoff controls the cutoff frequency of the filter. (Select a pad’s filter type in Program Edit Mode.)
   - Filter Resonance controls the resonance value of the filter.
   - Filter Env Amount controls the envelope amount of the filter.
- **Qlink Pan** controls the sample’s panning position in the stereo field.
- **Level** controls the sample’s volume level.
- **Env Attack** controls the attack time of the Amp Envelope.
- **Env Decay** controls the decay time of the Amp Envelope.
- **Env Release** controls the release time of the Amp Envelope.
- **Send 1 to 4** controls the corresponding FX send levels for the selected pad.

If **Midi** is selected in the **Instrument** Section, the Q-Link Knobs' Program Mode will look slightly different. To control a desired parameter of an external sound generator by MIDI, you can define a **MIDI CC** (MIDI Control Change). This can be any MIDI Control Change from 1 to 128 for every Q-Link Knob. Make sure that your external MIDI device is able and set to recognize MIDI control change data.
**FX Mode**

Click the **FX** button to activate the Q-Link Knobs’ FX Mode. To assign a parameter to a Q-Link Knob in the software:

1. Click a Q-Link Knob and move the mouse to select it for assigning. The **Qlink** field will show the number of the selected knob.
   
   **Hardware:** Touch the top of a **Q-Link Knob** to select it.

2. Click the **Trig** drop-down menu and select **Min** or **Max**. When you hold down the Q-Link **Trigger** button on your MPC hardware and touch the top of one the Q-Link Knobs, the corresponding parameters will jump to either its minimum (**Min**) or maximum (**Max**) value.
   
   **Hardware:** Use the **Cursor Buttons** to select the **Touch To** field, and then use the **Data Dial** or -/+ buttons to select **Min** or **Max**.

3. Click the **Effect** drop-down menu and select one of the effects, which have previously been loaded.
   
   **Note:** You have to load an effect before its parameters can be assigned to the Q-Link Knobs. All effects loaded to the pads or to the Track, independent from their routing, can have their parameter assigned. See the **Effects** chapter for more information about loading effects.

4. Click the **Param** (Parameter) drop-down menu and select the parameter you want to assign to the Q-Link Knob. The available parameters depend on the selected effect.
The **Pad Bank** section lets you select a pad to edit (16 pads across eight banks).

In the software, click the desired pad to select it. To select a different bank, use the **Bank** buttons above the pads to specify a bank from A to H.

**Hardware:** Press a pad to select it. To select a different bank, use the **Pad Bank** buttons to specify a bank from A to H.
The **Sequence section** gives you an overview of parameters relevant to the current Sequence.

In the software, click the **Sequence** drop-down menu and select a Sequence or click the ► icon in the lower-right corner of the drop-down menu and select an unused Sequence from the list that appears.

**Hardware:** Move the cursor to **Seq** and use the **Data Dial** or the -/+ buttons to select the desired Sequence.

Click the **Loop** button to switch the Sequence’s loop function **On** or **Off**.

The loop points are defined by the **First** and **Last Bar** values. With the **First Bar** and **Last Bar** you can set the corresponding bar position pointer (e.g., to create a cycle for a loop). Keep in mind that the **Last Bar** value depends on the total length of the Sequence.

**Hardware:** Use the **Cursor Buttons** to select the **Loop** field and use the **Data Dial** or the -/+ buttons to turn the loop **On** or **Off**. With the **Loop** field still selected, press the **Window** button. Then, use the **Cursor Buttons** to select the field for **First Bar**, **Last Bar**, or **Number of Bars**, and then use the **Data Dial** or the -/+ buttons to select the desired numbers.

Click the **Total Bars** field to set the total number of bars.

**Hardware:** Use the **Cursor Buttons** to select the **Bars** field, and then use the **Data Dial** or the -/+ buttons to set the desired bar length of your Sequence. You can set up to 999 bars.

Click the **T Correct** (Time Correct) drop-down menu and select the note quantization value.

**Hardware:** Press the F1 button (T.C.) to edit the **Time Correct** value.

Click the **Time Sig** field to change the time signature for your Sequence.
Click the BPM field to set the desired tempo in beats per minute.

**Hardware:** Use the Cursor Buttons to select the Bpm field, and use the Data Dial or the +/- buttons to set the desired tempo in BPM (beats per minute).

Click the Swing field to change the groove of your Sequence. Values range from 50% to 75% and let you "shuffle" your beats—from subtle to extreme.

**Hardware:** Press F1 (T.C) to locate the Swing parameter. It can be changed by using the Data Dial or the +/- buttons to set the desired value.
The **Track** section gives you an overview of various parameters regarding the selected Track.

In the software, click the **Track** drop-down menu and select the desired Track.

**Hardware:** Use the **Cursor Buttons** to select the **Trk** field, and use the **Data Dial** or the **-/+** buttons to select the desired Track. You can also press **F3** (Track-) or **F4** (Track+) to switch to the desired Track or type in the number with the number keys.

In the upper-right corner of the **Track** section, an icon will indicate whether the Track is using a Drum Program, Keygroup Program, MIDI Program, or Plugin Program.

Click the **Velocity** display to change the overall velocity of the selected Track. This determines how loudly or quietly a Track plays relative its recorded levels. When set to 50%, the Track will be played with half the velocity it was originally played. When set to 200%, the Track will play twice as loud, up to a full velocity level of 127.

**Hardware:** Use the **Cursor Buttons** to select the **Vel%** field, and use the **Data Dial** or the **-/+** buttons to edit the overall velocity of the selected Track in percent.

Click the **M** button to mute the selected Track. Click the **S** button to solo the selected Track. When a **Solo** is activated from the **Main** page, the **Solo** function follows the current Track. In other words, if you have soloed Track 1, and turn to Track 2, now Track 2 will be soloed.

**Hardware:** Press **F5** (Mute), to mute or unmute the selected Track. Press **F6** (Solo) to solo or unsolo the selected Track.

Click the **Type** drop-down menu to select what kind of Program the Track will use: a **Drum** Program, **Keygroup** Program, **Midi** Program or a **Plugin** Program.
Drum Programs and Keygroup Programs

Click the Program drop-down menu to select which Program you want to use. To create a new Program, click the + icon next to the drop-down menu.

MIDI Programs

When the Track’s Program Type is set to Midi, the Track Section will look slightly different from other Programs:

Click the Port drop-down menu and select the desired MIDI port. This is where the Sequence data will be sent. The drop-down menu shows you the available MIDI ports as set in the MIDI tab of the Preferences window. For more information, see Software Menus > Edit Menu > Preferences: MIDI Tab.

Click the MIDI Ch drop-down menu to select the MIDI channel (from 1 to 16) you want to send MIDI messages over.

Click the Prog Ch drop-down menu to select a MIDI Program Change message (from 1 to 127 or Off). This is useful for selecting a particular preset in your MIDI sound module.

Click the Bank drop-down menu to select a Bank Select or Bank MSB (Most Significant Byte) message (from 0 to 127 or Off).

Click the LSB drop-down menu to select a Bank LSB (Least Significant Byte) message (from 0 to 127).
Hardware:

1. Use the Cursor Buttons to select Port and then use the Data Dial or +/- buttons to select the desired MIDI port. This is where the Sequence data will be sent.

2. Use the Cursor Buttons to select Ch and then use the Data Dial or +/- buttons to select the MIDI channel (from 1 to 16) you want to send MIDI messages over.

3. Use the Cursor Buttons to select PC and then press the Window button.

4. In the Program Change window that appears, use the Cursor Buttons to select the field and use the Data Dial or +/- buttons to select the setting(s) of the following:
   - Set the Program Change message from 0 to 127 or to Off.
   - Set Bank Enable to On.
   - Set the Bank MSB (Most Significant Byte) and Bank LSB (Least Significant Byte) message from 0 to 127 or to Off.

5. Press F4 (Close) to close the window.

The Program Change window in the display of the MPC hardware.
Plugin Programs

When the Track’s Program Type is set to Plugin, the Track Section will look slightly different from other Programs:

If your Project already contains the desired plugin, click the Program drop-down menu to select it. In the window that appears, you can click checkboxes to re-order your list of plugins: Sort by type or Sort by manufacturer. Click Select to load the selected plugin or Close to cancel the operation.

If you want to add a new plugin to the Project, click the + icon next to the Program drop-down menu. A new Program name (Plugin ###) will appear in the Program drop-down menu (you can click it to enter a new name for it). Then, click the Plugin drop-down menu, select the desired plugin from the list, and click Select to select it or Close to cancel. Click the e button to open the user interface of the loaded plugin.

Click the MIDI Ch drop-down menu to select a MIDI channel (from 1 to 16) the Plugin Program will use. Use this setting when you are working with a virtual instrument that supports multi-mode.

Click the Preset drop-down menu to select a preset for your plugin.
Program Channel Strip

The channel strip for the Program lets you use mixer controls directly from Main Mode. This is the same as the Program Channel strip shown on the right-most side of the window in Program Mixer Mode.

**Tip:** See *Effects > Overview* to learn more about how insert and send effects work in the software.

- **Insert:** Click this to view the insert effect slots for the Program.
- **Send:** Click this to view the levels for the send effects for the Program. Click and drag a knob up or down to set the effect level for that Return slot.
  
  **Important:** To use a send effect, you have to load an effect into the corresponding send effect slot on the right side of the window in Track Mixer Mode. See the *Track Mixer Mode* chapter to learn more.

- **Inserts On/Off:** Click this button to enable or disable the Program’s insert effects.
- **Insert Slots:** Click the downward arrow (▼) of the slot you want to assign an effect to. Select an effect from the window that appears.
  
  **Tip:** Move an effect from one slot to another by clicking and dragging it. Copy an effect from one slot to another by holding Ctrl (Windows) or ⌘ (Mac OS X) while clicking and dragging it.

  Double-click a loaded effect name to open its graphic user interface for more detailed editing.

- **Routing:** Select the desired output (e.g., Out 1,2) to route the audio signal directly to this output.
- **Pan:** Click this knob and drag it up or down to set the position.
- **Solo:** Click this button (S) to solo it, muting all other channels.
- **Mute:** Click this button (M) to mute it.
• **Automation:** Click the Automation button on Program Channel strip to switch its Automation between Off, Read (R), and Write (W).
  - When set to Off, the Program will ignore automation data. If you have already recorded or entered automation, clicking the button will switch between Read (R) and Write (W) only, but you can override this and set it to Off by pressing and holding Shift on your computer keyboard while clicking the button.
  - When set to Read, the Program will read automation data but will not record any additional automation over it, though you can still manually edit and enter automation. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)
  - When set to Write, the Program can record automation. (If you have any Q-Link Knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording!)

**Hardware:**

Press the Q-Link Trigger button to switch the Automation between Off (the button will be unlit), Read (the button will be lit solid), and Write (the button will flash).

If you have already recorded or entered automation, pressing the Q-Link Trigger button will switch between Read and Write only, but you can override this and set it to Off by pressing and holding the Shift button while pressing the Q-Link Trigger button.

To set the Q-Link Trigger button to cycle through the automation states for just the Program or globally, do the following:

1. Press Shift + Song/Other.
2. Press F1 (Prefs).
3. Use the Cursor Buttons to select the Auto button field
4. Use the Data Dial or +/- buttons to set the field to Program or Global.

**Tip:** Set all Programs to the same Automation setting by clicking the Global Automation button in the upper-right corner of the software window.

• **Level:** Click the channel fader and drag it up or down to set the level. The level meter to the right of the fader provides a visual indication of the level. Press and hold Alt (Windows) or Option (Mac OS X) on your computer keyboard and click a fader to return it to its default position.
The **Project Information** shows the Project name as well as all Programs and samples loaded into the software’s current project.

You can simply drag and drop a sample from the **Project Information** onto any pad to assign it. How a sample can be played and edited depends on the Program. Refer to *General Features > Program Types* for more information.
The Programs list displays all available Programs in the Project. Click the arrow next to it to expand or collapse the list.

Next to each Program in the list, an icon will indicate whether it is a Drum Program, Keygroup Program, MIDI Program, or Plugin Program (for Plugin Programs, the plugin name is in grey on the right side of the column).

Right-click a Program to open a menu with the following options:

- **Duplicate** makes a copy of the selected Program and adds a -1 to the Program name.
- **Duplicate to New Track** makes a copy of the selected Program onto a new Track and adds a -1 to the Program name.
- **Delete** deletes the selected Program. To avoid accidental deletion, a window opens for you to confirm or cancel the operation.
- **Save** saves the current Program to your hard disk. A dialog window opens automatically where you can select a save location. Samples will automatically be saved with a Program.
- **Rename** opens a window where you can rename your Program.

**Hardware:** Press the Window button to open the Edit Current Program display page:

- Press **F2 (Delete)** to delete the selected Program. To avoid accidental deletion, a window opens for you to confirm or cancel the operation.
- Press **F3 (New)** to create a new Program. Use the Data Dial or +/- buttons to select the type of Program you want to create, and then press **F5 (Do It)** to confirm or **F4 (Cancel)** to cancel.
- Press **F4 (Copy)** to make a copy of the selected Program. This also adds a -1 to the new Program name.
- Press **F5 (Close)** to close the Edit Current Program display page.

The above operations can also be done for Sequences (Seq) and Tracks (Trk).
The **Sequences** list displays all available Sequences in the Project. Click the arrow next to it to expand or collapse the list.

Under each Sequence is a list of Tracks used in that Sequence. Next to each Track, an icon will indicate whether it uses a Drum Program, Keygroup Program, MIDI Program, or Plugin Program (for Plugin Programs, the plugin name is in grey on the right side of the column).

The **Sample** column displays the available samples. Select **All Samples** to view all samples in the Project, or select a Program or Sequence below to view the samples in that Program or Sequence only. Double-click a sample in the **Sample** column to load it in Sample Edit Mode.

Right-click a Sample to open a menu with the following options:

- **Delete** deletes the selected sample. To avoid accidental deletion, a window opens for you to confirm or cancel the operation.
- **Save** saves the current sample to your hard disk. A dialog window opens automatically where you can select a save location.
- **Rename** opens a window where you can rename the selected sample. This does not affect the original file's name.
- **Edit** opens Sample Edit Mode for the selected sample. For more information, please refer to the **Sample Edit Mode** chapter.

Click the trash can icon in the upper-right corner of the **Project Information** to delete samples from the Project. In the window that appears, you can select **Purge Unused Samples**, which deletes any samples not assigned to a pad from the Project, or **Delete All Samples**, which deletes all samples within the Project. Click **Do It** to proceed or **Close** to cancel without deleting anything.

**Important:** You can undo this deletion (i.e., with the **Undo** command or hardware button), if needed.
Program Edit Mode

Program Edit Mode contains all parameters for editing your Programs.

For Drum Programs and Keygroup Programs, this mode includes the parameters of each Layer as well as all synthesis parameters and insert effect settings. These two Program types will have different parameters due to how they are set up (Drum Programs have fewer parameters than Keygroup Programs).

For MIDI Programs or Plugin Programs, skip to Program Edit Mode for MIDI Programs and Plugin Programs for more information.

For more general information on the differences between these four kinds of Programs, please see General Features > Program Types.

MPC Renaissance users: All parameters of Program Edit Mode are arranged in a grid of up to 16 parameters. These parameters correspond to the 16 Q-Link Knobs of the MPC Renaissance. The “4 x 4” grid lets you adjust the parameters shown in MPC Renaissance’s display, quickly and intuitively.

MPC Studio users: MPC Studio has four Q-Link Knobs which can be assigned to the corresponding Q-Link Knob column with the Scroll Knob above the Q-Link Knobs.
To enter Program Edit Mode in the software, do one of the following:

- Click the **Program Edit Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Program Edit**.
- On your computer keyboard, press **Ctrl+2** (Windows) or **⌘+2** (Mac OS X).

**Hardware:** To enter Program Edit, press the **Prog Edit** button.

**Drum Programs:** To select a Drum Program for editing, select the desired pad first. Do one of the following:

- In the software, click the desired pad in **Main Mode**.
- In the software, click the pad row in the grid in **Program Edit** Mode.
- In the software, click the pad in the **Edit Zones** area, under the **Edit Layers** section.
- On your MPC hardware, press the desired pad.
Master Section

In the Master Section, you can set the playback mode and tuning for the overall Program.

**Mode** sets the playback mode for the Program’s pads. In Mono Mode, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample(s), the new pad will immediately mute all other currently playing pads in that Program. In Poly Mode, several pads can be triggered at the same time (limited only by the total number of voices available).

**Semi** lets you transpose the selected Program up to 12 semitones up or down.

**Fine** provides fine-tuning of the Program by fractions of a semitone up or down.

**Trans** (only available for Keygroup Programs) transposes incoming notes; it does not change the pitch of a sample.

**Hardware:** To edit the Master Section, press the F1 button. Use the Q13, Q14, and Q15 Q-Link Knobs for direct access to the parameters. Remember that Drum Programs offer fewer parameters than Keygroup Programs.
Click the **Automation** button to switch the Program’s Automation between *Off, Read (R)*, and *Write (W)*.

- When set to *Off*, the Program will ignore automation data. If you have already recorded or entered automation, clicking the button will switch between *Read (R)* and *Write (W)* only, but you can override this and set it to *Off* by pressing and holding **Shift** on your computer keyboard while clicking the button.

- When set to *Read (R)*, the Program will read automation data but will not record any additional automation over it, though you can still manually edit and enter automation. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When set to *Write (W)*, the Program can record automation. (If you have any Q-Link Knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording!)

**Hardware:**

Press the **Q-Link Trigger** button to switch the Program’s Automation between *Off* (the button will be unlit), *Read* (the button will be lit solid), and *Write* (the button will flash).

If you have already recorded or entered automation, pressing the **Q-Link Trigger** button will switch between *Read* and *Write* only, but you can override this and set it to *Off* by pressing and holding the **Shift** button while pressing the **Q-Link Trigger** button.

To set the **Q-Link Trigger** button to cycle through the automation states for just the Program or globally, do the following:

1. Press **Shift + Song/Other**.
2. Press **F1 (Prefs)**.
3. Use the **Cursor Buttons** to select the **Auto button** field
4. Use the **Data Dial** or **-/+** buttons to set the field to *Program* or *Global*.

**Tip:** Set all Programs to the same Automation setting by clicking the **Global Automation** button in the upper-right corner of the software window.
Simultaneous Play Section (Drum Programs Only)

The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad only. Use this function to trigger a stack of sounds (e.g., layered bass drums).

**Hardware:** To select the pads for Simultaneous Play, press the F1 button (Master). Use Q-Link Knobs Q5–Q8 to select the corresponding pads. This function is available only in Drum Programs.

Mute Target Section (Drum Programs Only)

For the currently selected pad, you can select up to four pads as Mute Targets. When the pad is played, it will immediately silence its Mute Targets. Click each Pad drop-down menu to select the desired Mute Target.

**Hardware:** To select the Mute Target pads, press the F1 button (Master). Use Q-Link Knobs Q1–Q4 for selecting the corresponding pads. This function is only available in Drum Programs.

**Tips:**
- This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.
- This feature is similar to the Mute Group feature, available for both Drum Programs and Keygroup Programs. For more information about Mute Groups, see Keygroup Play Modes Section (for Keygroup Programs) and Pad Play Modes Section (for Drum Programs) in this chapter.
Keygroup Play Modes Section (Keygroup Programs Only)

Here, you can set the behavior for each pad’s samples in a Keygroup Program.

**Mute Groups** let you assign the selected pad to one of the 32 available groups. When pads assigned to the same Mute Group receive MIDI notes, the last pad played will silence all other pads in that Mute Group.

**Layer Play** determines how multiple samples assigned to the same pad are played:
- **Cycle (Cyc):** Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- **Velocity (Vel):** The pad will switch between layers depending on how hard you press a pad.
- **Random (Ran):** Each time the pad is played, it will play one of its layer’s samples at random.

**Sample Play** determines how much of the sample is played:
- **One-Shot:** The entire sample will play from start to end. Use this when you want to play short sounds.
- **Note-On:** The sample will play only as long as the pad is held. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.

**Hardware:** To edit the **Keygroup Play Modes** parameters, press the **F1** button (**Master**). Use **Q-Link Knobs Q9–Q11** for direct access of all three parameters. These parameters are available only in Keygroup Programs.
Key Group Section (Keygroup Program Only)

Here, you can set additional Keygroup Program parameters.

**Tips:**

- The loaded sample’s root key will determine where the original pitch is located. For example, if the root key is C3, the original sample is located at Pad D13.
- In a Keygroup Program, you can also use the pads on your MPC hardware to play samples assigned to Keygroups. The 128 pads (A01 to H16) correspond to MIDI notes from note number 0 to 127, allowing you to easily play a melody with a single sample over a wide range.

**KG Select** (Keygroup Select) lets you select a specific Keygroup for editing. This parameter works in conjunction with the **No. KG** (Numbers of Keygroups) parameter in the **Edit Layers** section, which lets you create up to 128 Keygroups within one Keygroup Program. A default Keygroup Program contains only one single Keygroup. When you have created more than one Keygroup with **No. KG**, use **KG Select** to select any Keygroup for editing. **All** selects all available Keygroups of a Keygroup Program for simultaneous editing.

**Keytrack** allows you to switch a sample’s automatic transposition on or off. If this is off, you will always hear the same pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard.

**Level** controls the overall volume level of the loaded sample(s). 

**Pan** controls the overall panning of the loaded sample(s) in the stereo field.
**Note Range** lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo and Hi are also shown in the virtual keyboard in the **Edit Layers** section.

**Tip:** Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano.

**Semi** lets you transpose the sample 12 semitones up or down, while **Fine** provides fine-tuning of each layer by fractions of a semitone up or down.

**Tip:** The **Edit Layers** section has some parameters similar to those in this section (Level, Pan, Semi, Fine, Note Range). Remember that **Key Group** parameters control the overall settings for the sample, while **Edit Layer** parameters control the settings for each layer (up to 4).

**Hardware:** To edit the **Key Group** parameters, press the **F1** button (Master). Use **Q-Link Knobs Q1–Q8** for direct access of all parameters. These parameters are available only for Keygroup Programs.
Edit Layers Section

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has separate parameters for Sample, Semi, Fine, Level, Pan and Velocity. Keygroup Programs also have a Root Note parameter.

**Note:** For easier recognition, Drum Program controls are colored in blue while Keygroup Programs are colored in red.

Click the Sample drop-down menu to select the sample file for that layer. Remember that the sample has to be loaded into the Project Information beforehand. For information on how to load samples into a Project, please see General Features > Browsers > File Browser and General Features > Program Types earlier in this manual.

**Tip:** For Drum Programs, you can click and drag a sample from the File Browser, your computer’s Desktop, or your computer’s Explorer (Windows) or Finder (Mac OS X) directly onto a pad to load it to Layer 1.
Semi lets you transpose the selected layer 12 up to semitones up or down.

Fine provides fine-tuning of each layer by fractions of a semitone.

Level lets you adjust the each layer’s volume, letting you control the “balance” of the samples assigned to the pad.

**Hardware:** To edit the first 16 Layer parameters located on the left of the vertical separation lines in the Layers section, press the F2 button (Samples). Use the Q-Link Knobs for direct access of their respective Edit Layers parameters. Remember that Drum Programs have fewer parameters than Keygroup Programs.

Pan adjusts the stereo placement of the respective layer.

Velocity defines the velocity range of each layer. Set the values by doing one of the following:
- In the software, click in the segment chain on the right side of the Layer area and drag its left and right ends to the desired values.
- On your MPC hardware, press the F3 button and changed the displayed values with the Data Dial or +/- buttons.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer accordingly. (For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.)

Root Note (available for Keygroup Programs only), you can set the root key of each loaded sample.

**Hardware:** To edit the second 16 Layer parameters located on the right of the vertical separation lines in the Layers section, press the F3 button (Layer 2). Use the Q-Link Knobs for direct access of their respective Edit Layers parameters. Remember that Drum Programs have fewer parameters than Keygroup Programs.
The virtual keyboard (available for Keygroup Programs only) shows the Note Range, which can be set in the Key Group section. You can also drag the left or right range with your computer mouse.

Click the red bar above the virtual keyboard to set the overall key range for the selected Keygroups.

No. KG (Number of Keygroups) lets you create up to 128 Keygroups within a Keygroup Program. This is very useful when working with multi-samples. For example, if you want to create a realistic piano, you can use different Keygroups (e.g., 88 for a grand piano) with every Keygroup containing its own sampled note (with up to 4 possible velocity layers). A single Keygroup can be edited by using the KG Select parameter in the Key Group section. Alternatively, you can select All Keygroups for simultaneous editing.
**Edit Zones** (only available in Drum Programs) displays an overview of any selected pad(s). Click one of the checkboxes on the right to select how the selected pads will be edited. In the software, you can select pads directly in Program Edit Mode by clicking with your computer mouse. On your MPC hardware, you can select pads by striking them.

- **Current:** Only the currently active pad (the purple square with an orange border) can be edited.
- **Multiple:** All selected pads (squares with an orange border; the purple square is the active one) can be edited simultaneously.
- **All:** All pads can be edited simultaneously.

---

**Hardware:** To select the Edit Zones setting:

1. Enter Program Edit Mode by pressing the Prog Edit button.
2. On any of the tabs (selectable with the Function Buttons), use the Cursor Buttons to select any field except: Flt Atk, Flt Hld, Flt Dec, Flt Sust, Amp Atk, Amp Hld, Amp Dec, Amp Sust, Dec Type, or a loaded effect name.
3. Press the Window button.
4. In the window that appears, use the Data Dial or +/- buttons to set the Edit Mode field to Current, Multiple, or All.
   - If you select Multiple, press the pads you want to select. Use the Pad Bank button to view other pad banks.
5. Press F4 (Close) when you are done.

**Tip:** You can immediately select multiple pads while on any tab in Program Edit Mode (regardless of the current Edit Zones setting) by pressing and holding the Shift button and pressing each desired pad. The Edit Zones setting will automatically change to Multiple.
Filter Section

The **Filter Type** drop-down menu lets you select a filter for the selected pad. See *Appendix > Glossary > Filter* for an explanation of the available filter types.

**Cutoff** controls the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-stop filter types.

**Reso** controls the resonance/emphasis of the frequencies around the cutoff point.

**Tip:** Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a strong audible boost around the cutoff frequency.

**Env** determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter **Cutoff** over time.

**Tip:** To give a sound a more distinctive attack, increase the **Env** setting and set low **Atk** and **Decay** values as well as a medium-low **Sust** value of the **Filter Envelope**. This will start a sound with the filter opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more "alive" with low **Env** settings and a high **Atk** value, resulting in a slight fade-in of the higher frequencies.

The **Modulation Sources** set the amount for different modulation. The following modulation sources are available:

- **V>Start** (Velocity ➔ Start, for Drum Programs only) sets how much velocity is needed (for a triggered pad or key) to modulate the sample startpoint.
- **Kbd>Flt** (Keyboard ➔ Filter, for Keygroup Programs only) sets how much aftertouch data (from a pad or a MIDI-keyboard) is needed to modulate the cutoff frequency.
• V>Atk (Velocity ➔ Attack) sets how much velocity is needed (for a triggered pad or key) to modulate the Attack phase for the Amp envelope.

• V>Env (Velocity ➔ Envelope) enables velocity information to control the amount of the filter envelope’s effect on the cutoff frequency.

• V>Flt (Velocity ➔ Filter) uses the velocity of a pad or key to modulate the cutoff frequency directly.

The Filter Envelope controls affect the filter frequency. The knobs control the envelope shape or time-variant modulation output. Adjust envelope’s influence on the filter frequency with the Env knob. See the following Anatomy of an Envelope below to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. The knobs control the envelope shape or time-variant modulation of a sound’s level. See the following Anatomy of an Envelope below to learn about the envelope parameters.

Hardware:
To edit the Filter, Filter Envelope, and Amp Envelope parameters, press the F4 button (Flt Env). Use the Q-Link Knobs for direct access of all 16 parameters.

To set the Filter Envelope type or Amp Envelope type, press the Window button while on the Flt Env tab. Use the Cursor Buttons to select the Filter Envelope or Amp Envelope, and use the Data Dial or -/+ buttons to select AD or AHDS. See the following Anatomy of an Envelope below to learn more about the envelope parameters.
Anatomy of an Envelope

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound over a given period of time.

For Drum Programs, the software offers two envelope types comprised of separately controllable parameters. Click the **AD** box to check or uncheck it, letting you switch between two envelope types: **AD** (checked) or **AHDS** (unchecked).

For Keygroup Programs, the software offers only AHDS envelopes.

With **AHDS** envelopes, the following happens when you trigger a sample:

1. Within the period of time you have defined with the **Attack (Atk)** parameter, the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained during the **Hold** phase.
3. During the **Decay** phase, the sample’s volume will gradually drop to the sustain level.
4. The sample’s volume will stay at the sustain level (Sust) until the pad or key is released.

With **AD** envelopes, the following happens when you trigger a sample:

1. Within the period of time you have defined with the **Attack (Atk)** parameter, the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained until its **Decay** phase, when the sample’s volume will gradually drop to zero over the set duration. Click the **Type** drop-down menu to select **Decay From Start** (the volume will start decreasing immediately after reaching its maximum level) or **Decay From End** (the maximum volume will be maintained for a hold phase until it reaches the decay phase).
Pad Play Modes Section (Drum Programs Only)

Here, you can set the behavior for each pad’s samples in a Drum Program.

**Mute Groups** let you assign the selected pad to one of the 32 available groups. When pads assigned to the same Mute Group receive MIDI notes, the last pad played will silence all other pads in that Mute Group.

**Tip:** This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

**Layer Play** determines how multiple samples assigned to the same pad are played:

- **Cycle (Cyc):** Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- **Velocity (Vel):** The pad will switch between layers depending on how hard you press a pad.
- **Random (Ran):** Each time the pad is played, it will play one of its layer’s samples at random.

**Sample Play** determines how much of the sample is played. **Note-On** (only as long as the note is held).

- **One-Shot:** The entire sample will play from start to end. Use this when you want to play short sounds.
- **Note-On:** The sample will play only as long as the pad is held. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.

**Pad Play** lets you select between two options: In **Mono** Mode, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample(s), the new pad will immediately mute all other currently playing pads in that Program. In **Poly** Mode, several pads can be triggered at the same time (limited only by the total number of voices available).

**Hardware:** To edit the Pad Play Modes parameters, press the F5 button (Lfo Mod). Use Q-Link Knobs Q13–Q16 for direct access of all 4 parameters. These parameters are available only in Drum Programs.
Velocity Sensitivity Section

Here, you can set how much velocity affects various sound parameters: Pitch, Filter Envelope Attack (Atk), Amplifier (Amp) and Panning (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding dial.

**Hardware:** To edit the Velocity Sensitivity parameters, press the F5 button (Lfo Mod). Use Q-Link Knobs Q13-Q16 for direct access of all 4 parameters. Remember that a Drum Program uses different Q-Link Knobs than a Keygroup Program.
A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be used for modulation purposes.

**Wave** sets the LFO waveform. Click the drop-down menu and select one of the following:

- **Triangle** (best suited for smooth modulations)
- **Sine** (best suited for smooth modulations)
- **Square** (interesting results with hard-panning modulations)
- **Saw** (can generate interesting filter or volume changes)
- **Saw Down** (can generate interesting filter or volume changes)
- **Noise** (generates random values and glides)
- **S&H** (samples a random value and holds it until the next value is generated)

**Rate** determines the LFO frequency when Sync is on. At lower values, it might take some time for the LFO to complete a cycle, while higher values will come closer to audible range.

**Sync** will synchronize the LFO to the tempo, based on the rate selected in the drop-down menu. When **None** is selected, Sync is off.

The LFO modulation **Destinations** determine the amount of effect of the LFO has on **Pitch**, Filter Cutoff frequency (**Filter**), Volume (**Amp**) and Panning (**Pan**).

**Hardware:** To edit the LFO parameters, press the F5 button (**Lfo Mod**). For Drum Programs, use **Q-Link Knobs Q1–Q7** for direct access to all seven parameters. For Keygroup Programs, use **Q-Link Knobs Q5–Q12** for direct access to all seven parameters. (Remember that a Drum Program uses different controls than a Keygroup Program.)
Controller Mod Section (Keygroup Program Only)

The **Controller Mod** section determines the influence of additional play controllers on various sound parameters.

**Important:** To use these parameters, make sure that a connected MIDI device can send pitch bend messages as well as aftertouch and modulation wheel data.

**Pitch Bend** sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel.

**Whl>LFO** (Wheel to LFO) determines how much a connected MIDI keyboard’s modulation wheel affects the LFO intensity.

**Aft>Filt** (Aftertouch to Filter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data affects the filter cutoff.

**Hardware:** To edit the **Controller Mod** parameters, press the F5 button (Lfo Mod). Use Q-Link Knobs Q2–Q4 for direct access of all three parameters. Remember that these parameters are available only in Keygroup Programs.
Insert Effects Section

You can select up to four insert effects for each pad or keygroup or for the entire Program. You can use various effects included in your MPC software as well as other VST and AU plugins installed on your computer.

To learn how to use insert effects in the MPC software, please see Effects > Insert Effects.

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.

Important:
When using keygroup insert effects, they will be applied to the entire Keygroup Program. This is because a Keygroup Program uses the same sound across all pads, as opposed to Drum Programs where each pad can have its own insert effect.

If a pad’s or keygroup’s Pad Audio Route menu is set to anything other than Program, then Program insert effect will not be applied to that pad or keygroup.
Pad/Keygroup Audio Route Section

This menu lets you select where the audio for currently selected pad or keygroup will be routed.

Click the drop-down menu, and select any one of the following outputs: Program, Submix 1 to 8, or Out 1,2 to Out 31,32.

**MPC Renaissance users:** Out 1,2 are routed to the **Stereo Out** jacks. Out 3,4 are routed to the **Assignable Mix Out** jacks.

When using a Drum Program, this lets you send each pad’s audio to separate outputs, if desired. When using a Keygroup Program, this will determine where the audio of the entire Program is sent. This is because a Keygroup Program uses the same sound across all pads, as opposed to Drum Programs where each pad can have its own insert effect.

**Important:** If the a pad’s Pad Audio Route menu is set to anything other than Program, then Program insert effect will not be applied to that pad.

Program Edit Mode for MIDI Programs and Plugin Programs

For MIDI Programs and Plugin Programs, Program Edit Mode looks a bit different. You will see an overview of all available parameters of your loaded virtual instrument, including a corresponding rotary knob for editing. We recommend editing a virtual instrument by using its own graphical user interface, though.

To assign a parameter to one of the controls, click the drop-down menu above the corresponding controller and select it from the drop-down menu. In this way, you can easily set up arrangements of 16 knobs to be controlled by your MPC hardware.

You can use Program Edit Mode to directly edit a set of parameters in a section with your MPC hardware.

**Hardware:** To edit virtual instrument parameters, press the corresponding F button (Page1 to Page6). Use the MPC hardware Q-Link Knobs for direct access of all 16 parameters that are displayed. You can use the Cursor Buttons to select a desired parameter location in the display and change the parameter with the +/- buttons or the Data Dial.
In Program Mixer Mode, you can set a Program’s levels, stereo panning, routing, and effects.

For Drum Programs, this mode has a channel strip for each individual pad (of 128). For Keygroup Programs, this mode has a channel strip for each individual Keygroup (up to 128). For MIDI Programs and Plugin Programs, this mode has no channel strips.

For more information on how these Programs differ, please see General Features > Program Types.

To enter Program Mixer Mode in the software, do one of the following:

- Click the Program Mixer Mode tab in the Mode Tab Section of the software window.
- Click the View Menu, select Mode, and then select Program Mixer.
- On your computer keyboard, press Ctrl+3 (Windows) or ⌘+3 (Mac OS X).

**Hardware:** To enter Program Mixer Mode, press the Prog Mix button.
Program Mixer Mode works like a regular audio mixer and offers various settings for each channel. All channels' functionality is identical. If a sample has been assigned to a pad, its name is displayed below the channel fader.

The channel strip on the right-most side of this area is the Program Channel strip (if visible). It works the same way as described in Main Mode > Program Channel Strip. Any other channel strips whose routing is set to Program will be routed to the Program Channel.

To view more mixer channels, use the scroll bar under the channel faders at the bottom of the window.

### Show/Hide Buttons

In the software, the Channel View buttons on the left side of the pad channel strip area determine which channel strips are visible.

- Click the first (top-most) button to show or hide the Program Channel strip, which is on the right-most side of the channel strip area.
- Click the second button (Show all pads) to show all channel strips, whether or not their pads have samples or events.
- Click the third button (Show pads with samples) to show channel strips whose pads contain samples.
- Click the fourth button (Show pads with events) to show channel strips whose pads contain events.
- Click the fifth button (Show pads with samples or events) to show channel strips whose pads contain samples or events.

When Show pads with events or Show pads with samples or events is selected, you can click the sixth (lower-most) button (Filter events in track/sequence) to show channel strips for all events in the Track (T) or all events in the Sequence (S).
Routing

In the software, to set the routing for a channel:
1. Click Route button of the channel.
2. Click the drop-down menu just above the Pan knob.
3. Select the desired output (e.g., Out 1,2) to route the audio signal directly to this output. (You need an audio interface that is equipped with more than two outputs.)
   Selecting Program will route the audio signal to the Program Channel, whose corresponding channel strip is on the right-most side of this area (if visible).

Hardware: To set the routing for a channel:
1. Press F6 (Route).
2. Use the Cursor Buttons to select a pad. You can use the Pad Bank buttons to select different sets of 16 channels.
3. Use the Data Dial or +/- buttons to select the desired output. (MPC Renaissance users: Out 1,2 are routed to the Stereo Out jacks. Out 3,4 are routed to the Assignable Mix Out jacks.)

Levels

In the software, click the channel fader and drag it up or down to set the level. The level meter to the right of the fader provides a visual indication of the level. Press and hold Alt (Windows) or Option (Mac OS X) on your computer keyboard and click a fader to return it to its default position.

Hardware: To set the level for a channel, press F2 (Level) and use the corresponding Q-Link Knob for editing. You can use the Pad Bank buttons to select different sets of 16 channels.
Pad (Drum Programs only)

In the software, click a pad below the channel fader to trigger the corresponding pad.

**Hardware:** To trigger a pad's sample(s), press the corresponding pad.

**Tip:** You can load a sample onto a pad by dragging the file onto it.

Panning

In the software, click the channel's **Pan** knob and drag it up or down to set the position.

**Hardware:** To set the panning for a channel, press **F3 (Pan)** and use the corresponding **Q-Link Knob** for editing. You can use the **Pad Bank** buttons to select different sets of 16 channels.

Mute and Solo

In the software, click the channel's **Mute** button (**M**) to mute it.

**Hardware:** To mute a channel, press **F4 (Mute)** and touch the top of the corresponding **Q-Link Knob** to toggle between "mute" and "mute off." You can use the **Pad Bank** buttons to select different sets of 16 channels.

Alternatively, you can click the **Mute** button (**M**) for the pad in the grid above to mute it.

To solo a channel, click its **Solo** button (**S**), which will mute all other channels. You can solo as many channels as you like. To deselect solo, click the active solo button.
Automation (Program Channel strip only)

You can click the Automation button on Program Channel strip to switch its Automation between Off, Read (R), and Write (W). (If the Program Channel strip is not shown, click the downward arrow icon to the left of the pad channel strips.)

- When set to Off, the Program will ignore automation data. If you have already recorded or entered automation, clicking the button will switch between Read (R) and Write (W) only, but you can override this and set it to Off by pressing and holding Shift on your computer keyboard while clicking the button.
- When set to Read (R), the Program will read automation data but will not record any additional automation over it, though you can still manually edit and enter automation. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)
- When set to Write (W), the Program can record automation. (If you have any Q-Link Knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording!)

Hardware:

Press the Q-Link Trigger button to switch the Program’s Automation between Off (the button will be unlit), Read (the button will be lit solid), and Write (the button will flash).

If you have already recorded or entered automation, pressing the Q-Link Trigger button will switch between Read and Write only, but you can override this and set it to Off by pressing and holding the Shift button while pressing the Q-Link Trigger button.

To set the Q-Link Trigger button to cycle through the automation states for just the Program or globally, do the following:

1. Press Shift + Song/Other.
2. Press F1 (Prefs).
3. Use the Cursor Buttons to select the Auto button field
4. Use the Data Dial or +/- buttons to set the field to Program or Global.

Tip: Set all Programs to the same Automation setting by clicking the Global Automation button in the upper-right corner of the software window.
Effects

Insert Effects

You can select up to four insert effects for each pad or keygroup or for the entire Program. You can use various effects included in your MPC software as well as other VST and AU plugins installed on your computer.

To learn how to use insert effects in the MPC software, please see Effects > Insert Effects.

Important:

When using keygroup insert effects, they will be applied to the entire Keygroup Program. This is because a Keygroup Program uses the same sound across all pads, as opposed to Drum Programs where each pad can have its own insert effect.

If a pad’s or keygroup’s routing is set to anything other than Program, then Program insert effect will not be applied to that pad or keygroup.

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.

Send Effects

You can select up to four send effects for each pad or keygroup or for the entire Program. You can use various effects included in your MPC software as well as other VST and AU plugins installed on your computer.

To learn how to use send effects in the MPC software, please see Effects > Send Effects.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in Track Mixer Mode.

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.
Track Mixer Mode

In Track Mixer Mode, you can set the levels, stereo panning, and effects for each Track.

To enter Track Mixer Mode in the software, do one of the following:

- Click the Track Mixer Mode tab in the Mode Tab Section of the software window.
- Click the View Menu, select Mode, and then select Track Mixer.
- On your computer keyboard, press Ctrl+4 (Windows) or ⌘+4 (Mac OS X).

**Hardware:** To enter Track Mixer Mode, press Shift + Prog Mix / Track Mix.

While Program Mixer Mode lets you control the mix of individual pads and sounds within a Program, Track Mixer Mode lets you mix your Tracks within a Sequence. Up to 128 Tracks are available.
The upper half of the window shows narrow versions of the Tracks in that Sequence. They are for visual reference only and are not editable.

The lower half of the window can contain two kinds of channel faders:

- **Tracks**, to the right of the grey Tracks separator (if Tracks are shown). Their functions are described in the following sections of this chapter. By default used Tracks are named Track 01, Track 02, etc.

- **Programs**, to the right of the grey Programs separator (if Programs are shown). These work the same way as described in Main Mode > Program Channel Strip.

This section works like a regular mixer with various settings for each channel strip. You can use the Tracks' channel strips and Program Channel strips together to create a good mix of the Sequences in your Project.

The controls on the right-most side of this area are the Send Effects, Submix, and Master FX panels (if visible).

To view more mixer channels, use the scroll bar under the channel faders at the bottom of the window.

### Show/Hide Buttons

You can show or hide unused Tracks' channel strips (i.e., those with no note events) and/or plugins through which your Tracks are routed:

- To show or hide the Send Effects, Submix, and Master FX panels, click the downward arrow icon to the left of the channel strips.

- To show or hide all Tracks' channel strips, click the channel strip icon to the left of the channel strips.

- To show or hide unused Tracks' channel strips, click the + icon to the left of the channel strips or in the upper-left corner of the grid.

- To show or hide the Programs' channel strips for the Tracks, click the plug icon to the left of the channel strips or in the upper-left corner of the grid.

- To show or hide unused Programs' channel strips for the Tracks, click the plug icon to the left of the channel strips or in the upper-left corner of the grid.
To select a Track’s Program:

1. Click the downward arrow (▼) of the drop-down menu above the Track’s Pan knob.
2. Select the Program you want this Track to use. The software will use this Program to play the events in this Track.
Levels

In the software, click the Track fader and drag it up or down to set the MIDI volume level (0–127). The level meter to the right of the fader provides a visual indication of the level. Press and hold Alt (Windows) or Option (Mac OS X) on your computer keyboard and click a fader to return it to its default position.

You can also set the levels of each Program within Track Mixer Mode by clicking and dragging a fader for a Program Channel strip. (If the Program Channel strips are not shown, click the plug icon to the left of the Track channel strips or in the upper-left corner of the grid.)

Hardware:

To set the level for a Track:
1. Use the Cursor Buttons to select the Mixer field, and then use the Data Dial or +/- buttons to set it to Tracks.
2. Press the F1 button (Level) and use the corresponding Q-Link Knobs for editing. You can use the Pad Bank buttons to select different sets of 16 Tracks.
   Important: Any automation you record in this mode will be for the current Track only, not for all 16 Tracks.

To set the level for a Program:
1. Use the Cursor Buttons to select the Mixer field, and then use the Data Dial or +/- buttons to set it to Programs.
2. Press the F1 button (Level) and use the corresponding Q-Link Knobs for editing. You can use the Pad Bank buttons to select different sets of 16 Programs.

The Level tab’s Tracks view in the Track Mixer Mode in the display of the MPC hardware.
The Level tab's Programs view in the Track Mixer Mode in the display of the MPC hardware.

**Important:** When the Mixer field is set to Tracks while recording automation, you can record automation for the level and pan for the currently selected Track only, not all 16 Tracks shown.

**Important:** By default, some plugins do not support MIDI volume. In this case, adjust this at the plugin Track.

**Note:** MIDI Programs' and Plugin Programs' levels will initially appear as ?. This indicates that the Program is not sending any volume changes, which allows certain plugins to load with their optimal default settings. If you copy a Sequence, the level values will be copied with that Sequence. If you move to a new Sequence and put the same MIDI Program or Plugin Program on a new Track, though, these values will appear as ?.
Panning

In the software, click the Track's **Pan** knob and drag it up or down to set the position.

You can also set the panning of each Program within Track Mixer Mode by clicking and dragging a **Pan** knob for a Program Channel strip. (If the Program Channel strips are not shown, click the plug icon to the left of the Track channel strips or in the upper-left corner of the grid.)

**Hardware:**

To set the panning for a Track:

1. Use the **Cursor Buttons** to select the **Mixer** field, and then use the **Data Dial** or +/- buttons to set it to **Tracks**.
2. Press the **F2** (**Pan**) and use the corresponding **Q-Link Knobs** for editing. You can use the **Pad Bank** buttons to select different sets of 16 Tracks.

To set the panning for a Program:

1. Use the **Cursor Buttons** to select the **Mixer** field, and then use the **Data Dial** or +/- buttons to set it to **Programs**.
2. Press the **F1** (**Pan**) and use the corresponding **Q-Link Knobs** for editing. You can use the **Pad Bank** buttons to select different sets of 16 Programs.

**Important:** By default, some plugins do not support MIDI panning by default. In this case, adjust this at the plugin Track.

**Note:** MIDI Programs' and Plugin Programs' pan values will initially appear as ?. This indicates that the Program is not sending any pan changes, which allows certain plugins to load with their optimal default settings. If you copy a Sequence, the pan values will be copied with that Sequence. If you move to a new Sequence and put the same MIDI Program or Plugin Program on a new Track, though, these values will appear as ?.
Mute and Solo

In the software, click the Track’s Mute button (M) to mute it.

**Hardware:** To mute a channel, press F3 (Mute) and touch the top of the corresponding Q-Link Knob to toggle between "mute" and "mute off." You can use the Pad Bank buttons to select different sets of 16 Tracks.

To solo a Track, click its Solo button (S), which will mute all other Tracks. You can solo as many Tracks as you like. To deselect solo, click the active solo button. Alternatively, you can click the Mute button (M) or Solo button (S) for the horizontal track above to mute or solo it.

You can also mute or solo each Program within Track Mixer Mode by clicking the M or S button for a Program Channel strip. (If the Program Channel strips are not shown, click the plug icon to the left of the Track channel strips or in the upper-left corner of the grid.)

**Hardware:**

To mute a Track:

1. Use the Cursor Buttons to select the Mixer field, and then use the Data Dial or +/- buttons to set it to Tracks.
2. Press the F3 (Mute) and use the corresponding Q-Link Knobs for editing. You can use the Pad Bank buttons to select different sets of 16 Tracks.

To mute a Program:

1. Use the Cursor Buttons to select the Mixer field, and then use the Data Dial or +/- buttons to set it to Programs.
2. Press the F3 (Mute) and use the corresponding Q-Link Knobs for editing. You can use the Pad Bank buttons to select different sets of 16 Programs.
Automation (Program Channel strips only)

You can click the Automation button on a Program Channel strip to switch its Automation between Off, Read (R), and Write (W). (If the Program Channel strips are not shown, click the plug icon to the left of the Track channel strips or in the upper-left corner of the grid.)

- When set to Off, the Program will ignore automation data. If you have already recorded or entered automation, clicking the button will switch between Read (R) and Write (W) only, but you can override this and set it to Off by pressing and holding Shift on your computer keyboard while clicking the button.

- When set to Read (R), the Program will read automation data but will not record any additional automation over it, though you can still manually edit and enter automation. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When set to Write (W), the Program can record automation. (If you have any Q-Link Knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording!)

Hardware:

Press the Q-Link Trigger button to switch a Program's Automation between Off (the button will be unlit), Read (the button will be lit solid), and Write (the button will flash).

If you have already recorded or entered automation, pressing the Q-Link Trigger button will switch between Read and Write only, but you can override this and set it to Off by pressing and holding the Shift button while pressing the Q-Link Trigger button.

To set the Q-Link Trigger button to cycle through the automation states for just the Program or globally, do the following:

1. Press Shift + Song/Other.
2. Press F1 (Prefs).
3. Use the Cursor Buttons to select the Auto button field
4. Use the Data Dial or -/+ buttons to set the field to Program or Global.

Tip: Set all Programs to the same Automation setting by clicking the Global Automation button in the upper-right corner of the software window.
Effects

Insert Effects

Because you can view Program Channel strips in Track Mixer Mode, you can select up to four insert effects for each Program, just as you could in Program Mixer Mode. You can use various effects included in your MPC software as well as other VST and AU plugins installed on your computer.

To learn how to use insert effects in the MPC software, please see Effects > Insert Effects.

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.

Send Effects

Because you can view Program Channel strips in Track Mixer Mode, you can select up to four send effects for each Program, just as you could in Program Mixer Mode. You can use various effects included in your MPC software as well as other VST and AU plugins installed on your computer.

To learn how to use send effects in the MPC software, please see Effects > Send Effects.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in Track Mixer Mode.

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.
Master Effects

You can load, edit, or remove up to four Master effects, which will be applied to the entire Master mix. (If the Master Effects section is not shown, click the downward arrow icon to the left of the Track channel strips.)

Tip: For a list of all available MPC software effects and their parameters, please see Appendix > Effects and Parameters.

To load a Master effect:

1. In one of the four slots of the Master FX column, click the downward arrow (▼).
2. Select an effect from the menu that appears.

Hardware: To load and edit a Master effect:

1. Press Shift + Seq Edit / Effects.
2. Press F5 (Insert).
3. Use the Cursor Buttons to select the desired Insert effect slot.
4. Use the Data Dial or the +/- buttons to open another page to select an effect. Click F4 (Select) to load it, or click F3 (Back) to close the page.

Master Effects in the MPC hardware display.
Track View Mode

Track View Mode gives you an overview of the Tracks of each Sequence. Use this mode to edit Tracks and Sequences simultaneously.

Tip: Use Track View Mode to switch quickly between Tracks in a Sequence. This allows for a faster editing workflow.

To enter Track View Mode in the software, do one of the following:

- Click the Track View Mode tab in the Mode Tab Section of the software window.
- Click the View Menu, select Mode, and then select Track View.
- On your computer keyboard, press Ctrl+5 (Windows) or ⌘+5 (Mac OS X).

Hardware: To enter the Track View mode, press Shift + Main / Track.

Track View Mode: Drum Program.
The upper half of the window shows narrow versions of the Tracks in that Sequence. They are for visual reference only and are not editable.

The lower half of the window shows either the standard Grid View (as described in General Features > Grid View) or the list view (as described in General Features > List View).

Select a Sequence by clicking the Seq drop-down menu in the upper-right corner of the window. The Sequence's Tracks will appear in the upper half of the window. Select a Track to edit by clicking it. The Track's grid and automation lane will appear in the grid in the lower half of the window.
Next Sequence Mode

Next Sequence Mode lets you trigger different Sequences simply by playing the pads. This is useful for live performances, letting you change a Song’s structure in real time.

To enter Next Sequence Mode in the software, do one of the following:

- Click the **Next Sequence Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Next Sequence**.
- On your computer keyboard, press **Ctrl+6** (Windows) or **⌘+6** (Mac OS X).

**Hardware:** To enter Next Sequence Mode, press the **Next Seq** button.
Triggering Sequences

During playback, select a Sequence to play next simply by pressing the corresponding pad. The number and name of the selected Sequence will be displayed in the timeline in the upper half of the window. Use the controls in the Pad Bank Section and Next Sequence Section to change or repeat Sequences in real time.

Sequence Playlist

The Sequence Playlist window in Next Sequence Mode shows a list-style overview of all used Sequences in your Project:

- The **Sequence** column shows the name of the Song’s Sequences.
- The **Length** column shows the bar length of a Sequence.
- The **Tempo** column shows the tempo of a Sequence in beats per minute.
Pad Bank Section

In the **Pad Bank** section, every pad is assigned to a Sequence, starting from **Pad A01** with **Sequence 1** and ascending from there. Used Sequences are shown with their names; unused Sequences are shown as **(unused)**. The selected pad will be green.

During playback, change the next Sequence by clicking and holding the corresponding pad until the current Sequence ends. If no other Sequence is selected, the software will repeat the current Sequence indefinitely.

**Hardware:** Every pad is assigned to a Sequence, starting from **Pad A01** with **Sequence 1** and ascending from there. Used Sequences are shown with their names; unused Sequences are shown as **(unused)**. The selected pad will be lit green.

1. Start playback by pressing the **Play** button.
2. During playback, change the next Sequence by pressing the corresponding pad until the current Sequence ends. The pad that will play next will flash green.
3. If no other Sequence is selected, the software will repeat the current Sequence indefinitely.

The **Next Sequence** section in the display of the MPC hardware.
Next Sequence Section

During the playback of a Sequence, the Next Sequence section gives you the following options:

- Click **Next Bar** to change the Sequence at the beginning of the next bar. This lets you select the next Sequence without having to press a pad or button in perfect time.
- Click **Sudden** to switch to the next Sequence immediately—before the software has finished playing the current Sequence. This is useful in live performances if you need to switch to the next Sequence instantly at a certain cue.
- Click **Clear** to delete the selected Sequence from the Sequence Playlist.
- Click **Hold** to repeat playback of the current Sequence until you click it again. This is useful for live performances to prolong the playing of a Sequence, for example, to respond to the audience.

**Hardware:**

- Press **F4 (Sudden)** to switch to the next Sequence immediately—before the software has finished playing the current Sequence. This is useful in live performances if you need to switch to the next Sequence instantly at a certain cue.
- Press **F5 (Hold)** to repeat playback of the current Sequence until you click it again. This is useful for live performances to prolong the playing of a Sequence, for example, to respond to the audience.
- Press **F6 (Clear)** to delete the selected Sequence from the Sequence playlist.
- Press **F3 (Next Bar)** to change the Sequence at the beginning of the next bar. This lets you select the next Sequence without having to press a pad or button in perfect time.

The Next Sequence section in the display of the MPC hardware.
When playback is stopped, this section gives you the following options:

- **Copy to Song** opens a drop-down menu to select a Song the Sequence playlist is copied to. To read more about Song Mode, please see the **Song Mode** chapter.

- **Erase Song** erases the active Sequence Playlist.

**Hardware:** Press F1 (To Song) to copy your changes directly into a Song. In the **Copy to Song** window that appears, use the Data Dial or -/+ buttons to select the Song number where you want to copy your changes.

**Project Information**

This is identical to the Project Information in Main Mode. For more information, please see **Main Mode > Project Information**.
Sample Record Mode

Sample Record Mode lets you record audio samples to use in your Tracks and Sequences. This mode is divided into two main parts: the Waveform Display (which shows the waveform of a sample after the recording process) and the Record Controls.

**Important:** To record audio, you need to connect an audio source to your MPC Renaissance or to your computer's audio interface.

**MPC Studio users:** This section describes recording using MPC Renaissance as your sound card. MPC Studio cannot be used in this way, but you can use a separate audio interface connected to your computer to record audio.

To enter Sample Record Mode in the software, do one of the following:

- Click the **Sample Record Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Sample Record**.
- On your computer keyboard, press **Ctrl+7** (Windows) or **⌘+7** (Mac OS X).

**Hardware:** To enter Sample Record Mode, press **Shift + Sample Edit / Sample Rec.**
Setting Up to Record with MPC Renaissance

The following example describes the sample recording procedure using the MPC Renaissance hardware.

**Hardware:**

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you make any connections to avoid “pops” or feedback.

2. Connect your audio source (e.g., a microphone, instrument, etc.) to the **Mic In** jacks of your MPC Renaissance. If a connected microphone requires phantom power, make sure the **Phantom Power** switch is set to **On**. Turn phantom power off when you are not recording. Alternatively, connect a turntable or CD player to the **Phono In** jacks.

3. Set the **Mic / Line** switch on the rear panel as well as the **Mic In / Phono In** switch on the top panel to match your source. Incorrect settings can produce unwanted distortion.

4. Set the **Rec Gain** knob to an appropriate input level.

5. Use the **Cursor Buttons** to select the record control parameters, described in detail below.

![Sample Record Section](image)

The **Sample Record** section in the display of the MPC hardware.
Waveform Display

The Waveform Display shows the entire waveform of your recorded sample with a timeline at the top. While this is just for reference during in Sample Record Mode, it is the focus of Sample Edit Mode. Please see the Sample Edit Mode chapter to learn about editing your recorded samples.
Record Controls

The **Record Controls** offer all the relevant controls for recording.

**Threshold**

In Record Mode, the software automatically starts recording when the level of the incoming source exceeds the Threshold (**Thresh**). If you set the threshold too high, the recording may not start when you play the input source, or the start of the material you wanted to record may be missing. If you set the threshold too low, the recording may start too early, before you play the external source. Set this parameter to an appropriate level using the level meter.

Use Q-Link Knobs Q3 and Q4 to define the maximum sampling time. You can record up to 20 minutes and 59 seconds. We recommend setting these to values that roughly match your estimated recording duration.

**Hardware:** To adjust the Threshold, use Q-Link Knob Q1. Use Q-Link Knobs Q3 and Q4 to set the record time in Minutes and Seconds.

Click the **Reset Peak** button to reset the "peak hold", which shows the highest level of your input signal as a red bar within the level meter.

**Hardware:** To reset the peak hold, press F1 or F2 (Reset Peak). The peak hold is shown as a vertical bar within the Level Meter.

**Record Arm**

Use the **Record Arm** buttons to define which side of the incoming audio signal is going to be recorded. You can select L for the left channel, R for the right channel or both buttons for stereo recording.

**Hardware:** To select the input channel(s), use the Cursor Buttons to select the Mode field and use the Data Dial or +/- buttons to select Stereo, Left, or Right.

**Tip:** Deselect the right channel when you are recording to one channel only.
Input Source

The Input Source parameter defines whether you are going to record an external audio signal (External) or an internal signal from the software (Resample). A Resample recording does not require an audio connection because the source is within the software and is therefore recorded without any loss in audio quality. You can, for example, use Resample to record two or more samples by pressing the corresponding pads simultaneously.

**Hardware:** To select the sample input, use the Cursor Buttons to select the Input field and use the Data Dial or +/- buttons to select External or Resample.

Input Monitor

When input monitoring is on, the audio you hear in your headphones will be taken before it reaches the software, ensuring zero latency. When input monitoring is off, the audio you hear in your headphones will be taken after it is processed in the software, so there may be some latency, but you will hear the audio source as it sounds in the recording.

Click the Input Monitor button to control the incoming audio source through your audio system.

**Hardware:** To activate the Input Monitor function, use the Cursor Buttons to select the Monitor field and use the Data Dial or +/- buttons to switch it to On.

**Important:** Make sure the Direct Monitoring, Input Monitoring, etc. control of your audio interface or MPC Renaissance is set appropriately so you can hear the incoming signal rather than just the signal from your computer.

**Tip:** To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Sample Length

For reference, the Sample Length display shows you the length of your sample during the recording procedure.
Sample Rec and Sample Stop

**Important:** To use the Assign to Pad function to assign the new sample directly to a pad after recording, select the desired Track and Program before starting to record.

Click **Sample Rec** to record-arm the software, or click **Sample Stop** to stop the recording process. If you do not click **Stop**, recording will continue to the end of the previously set sample length.

After clicking **Sample Rec**, the recording will start once the incoming audio level exceeds the **Threshold** parameter.

**Hardware:**
1. To start recording, press **F6** (Record).
2. After that, the recording will start once the incoming audio level exceeds the **Threshold** parameter.
3. If recording has not begun yet, you can cancel the procedure by pressing **F5** (Cancel) or start the recording immediately by pressing **F6** (Start).
4. To stop recording, press **F6**.

When the recording is finished, the **Keep or Retry Last Sample** window appears:
- If you want to keep the recorded sample, enter a name in the **New Name** field.
- Click the **Track** menu to select a Track to assign the sample to.
- Click and drag the **Assign to Pad** field to select a pad to assign the sample to.
  
  **Important:** You need to have already selected the Track to which you want to assign the pad. If the Track is not the one you wanted, either move the sample to the desired Track or Program later, or select **Retry** to start over.

- Click and drag the **Root Note** field to set where the sample’s original pitch will be on the keyboard.
- To save the sample, click **Keep**. To delete the recording and start over, click **Retry**. To listen to the sample before deciding, click **Play**.
Hardware: When the recording is finished, the MPC hardware’s display will show new options. Use the Cursor Buttons to select a field, and use the Data Dial or +/- buttons to change the setting:

- **Track**: Select a Track to assign the sample to.
- **Assign to Pad**: Select a pad to assign the sample to. Alternatively, simply press the pad.
- **Root Note**: Sets where the sample’s original pitch will be on the keyboard.

To save the sample, press F5 (Keep). To delete the recording and try again, press F2 (Retry). To listen to the sample before deciding, press F4 (Play).

**Tip**: We recommend editing your recorded sample in Sample Edit Mode.

![Keep or Retry Last Sample window](image)

Keep or Retry Last Sample window in the MPC hardware display.

**Direct Record**

You can also record a sample as a Sequence is playing and automatically place the newly recorded sample directly into the Sequence. This process is called Direct Record. This is helpful when you want to record a sample that is at the same tempo as a specific Sequence.

**To use Direct Record:**

1. During playback of a Sequence, record a sample as you normally would (described above in Sample Rec and Sample Stop).
2. When the Keep or Retry Last Sample window appears, click any of the following:
   - Click and drag the Assign to Pad field to select a pad to assign the sample to.
   - To automatically add the sample to the currently playing Sequence, check Add Event. (This option is available only when using Direct Record.)
• To automatically place the sample as a note event at the start of the currently playing Sequence, check **At Start**. (This option is available only when **Add Event** is checked.)

• To automatically place the sample as a note event where you began recording it in the currently playing Sequence, leave **At Start** unchecked. (This option is available only when **Add Event** is checked.)

• To delete the recording and start over, click **Retry**. To listen to the sample before deciding, click **Play**. To save the sample, click **Keep**.

**Hardware:** When the recording is finished, the MPC hardware’s display will show new options. Use the **Cursor Buttons** to select a field, and use the **Data Dial** or +/- buttons to change the setting:

- **Track:** Select a Track to assign the sample to.
- **Assign to Pad:** Select a pad to assign the sample to. Alternatively, simply press the pad.
- **Add Event:** Set this to **Yes** to automatically add the sample to the currently playing Sequence. (This option is available only when using Direct Record.)
- **At:** Set this to **Start** to automatically place the sample as a note event at the start of the currently playing Sequence. Set this to **Trigger** to automatically place the sample as a note event where you began recording it in the currently playing Sequence (This field is available only when **Add Event** is set to **Yes**.)
- **Root Note:** Sets where the sample’s original pitch will be on the keyboard.

To save the sample, press **F5 (Keep)**. To delete the recording and try again, press **F2 (Retry)**. To listen to the sample before deciding, press **F4 (Play)**.

**Project Information**

This is identical to the Project Information in Main Mode. For more information, please see **Main Mode > Project Information**.

**Important:** Newly recorded samples will be shown in the **Sample** area of the **Project Information**. To use them in your Project, load them into Programs first.
Sample Edit Mode

Sample Edit Mode lets you edit samples using various functions.

To enter Sample Edit Mode in the software, do one of the following:
- Click the Sample Edit Mode tab in the Mode Tab Section of the software window.
- Click the View Menu, select Mode, and then select Sample Edit.
- On your computer keyboard, press Ctrl+8 (Windows) or ⌘+8 (Mac OS X).

To select a sample to edit, click the Edit Sample drop-down menu in the left section below the waveform display and select a sample from the Project.

Alternatively, you can click and drag a sample from the Project Information onto the Waveform Display. You can also right-click a sample in the Project Information and select Edit. (You can select a sample this way in any mode that shows the Project Information. When selecting a sample for editing, the mode will change automatically to Sample Edit Mode.)

Hardware: To enter Sample Edit Mode, press the Sample Edit button. Use the Data Dial or the -/+ buttons to select a sample for editing. The selected sample is displayed at the top of the display.

The upper half of the window is the Waveform Display. The lower half contains the editing controls.

Sample Edit Mode can work in one of two ways: Trim Mode or Chop Mode. The options for each mode are slightly different. Please refer to the Trim Mode or Chop Mode parts of the chapter to see how each works.
The Waveform Display is divided into two sections:

- The top of the display shows an overview of the entire sample waveform. A shaded rectangle outlines the currently shown part of the sample.
- The main part of the display shows the “active” section of the sample waveform. Use the scroll bar under the waveform to move through it.

To move the view, click and drag the shaded rectangle in the overview.

To zoom in, double-click the shaded rectangle in the overview. Alternatively, you can use the slider in the lower-right corner of the Waveform Display.

To zoom out, press and hold Control (Windows) or ⌘ (Mac OS X) and double-click the shaded rectangle in the overview. Alternatively, you can use the slider in the lower-right corner of the Waveform Display.

### Hardware

To zoom in and out of the waveform, do one of the following:

- Press and hold Shift and use the left and right Cursor Buttons.
- Use Q-Link Knob Q4.

Use Q-Link Knob Q8 to scroll the Waveform Display.
In the main Waveform Display, a start point and end point are marked by green lines. These two points define the portion of the sample data which will be played.

Click and drag either of these lines to move it. The most recently moved line will be red instead of green.

Click the sample timeline to switch between **Time** (in seconds and milliseconds) and **Samples**.

**Tip:** A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a "tight," well-edited sample can enhance your production or performance.
Trim Mode

Edit Section

The Edit section contains controls to edit samples and to select between Chop Mode or Trim Mode.

**Hardware:** Use the Data Dial or the -/+ buttons to select a sample for editing. The selected sample name is shown at the top of your display.

In the software, click the Edit Sample drop-down menu and select the desired sample.

The Q-Link Knobs can be used for various editing and viewing functions:

- To zoom in or out of the sample, use Q-Link Knob Q4.
- To scroll the Waveform Display, use Q-Link Knob Q8.
- To adjust the start point of the sample, use Q-Link Knobs Q13, Q9, Q5, or Q1. The smaller the Q-Link Knob number, the more precise the adjustment of the start point.
- To adjust the end point of the sample, use Q-Link Knobs Q14, Q10, Q6, or Q2. The smaller the Q-Link Knob number, the more precise the adjustment of the end point.
- To adjust the loop point of the sample, use Q-Link Knobs Q15, Q11, Q7, or Q3. The smaller the Q-Link Knob number, the more precise the adjustment of the loop point.
- Alternatively, you can adjust the start point, loop point, or end point by clicking the corresponding small arrows below the sample timeline and moving them with your mouse.
Hardware:

- To zoom in and out of the waveform, do one of the following:
  - Press and hold Shift and use the left and right Cursor Buttons.
  - Use Q-Link Knob Q4.
- Use Q-Link Knob Q8 to scroll the Waveform Display.
- To adjust the start point of the sample, use Q-Link Knobs Q13, Q9, Q5, or Q1. The smaller the Q-Link Knob number, the more precise the adjustment of the start point.
- To adjust the end point of the sample, use Q-Link Knobs Q14, Q10, Q6, or Q2. The smaller the Q-Link Knob number, the more precise the adjustment of the end point.
- To adjust the loop point of the sample, use Q-Link Knobs Q15, Q11, Q7, or Q3. The smaller the Q-Link Knob number, the more precise the adjustment of the loop point.

Tips:

- Remember that the loop start point cannot be placed before the start point of a sample.
- Click the waveform and hold the mouse button to play the edited sample.
- Click the sample timeline to switch between Time (in seconds and milliseconds) and Samples.
Pad Section

You can use the pads to play certain parts of the selected sample, regardless of the selected Pad Bank.

Trigger the following playback options by pressing the corresponding pad:

- **Play Loop (Pad 13)** plays the sample repeatedly from the loop point to the end point.
- **Play Loop Continuous (Pad 16)** plays the sample as a continuous loop. You can adjust the start point and end point while it plays.
- **Play Sample (One-Shot) (Pad 10)** will play the whole sample as it has been edited. Pressing the pad once will play the entire sample.
- **Play Sample (Note On) (Pad 11)** will play the whole sample as it has been edited. Pressing the pad and holding it will play the part; releasing it will stop playback. You can also click the Waveform Display to activate this function.
- **Play All (Pad 9)** plays the whole sample regardless of any edits.
- **Play From Loop Start (Pad 14)** plays the sample portion before the loop point.
- **Play To Loop Start (Pad 15)** plays the sample from the loop start point to the end of the sample regardless of the end point. If the loop start point is identical to the end point, nothing will be played.

Pads 01-04 have the same respective functions as Pads 05-08, but Pads 01-04 play the sample part as “One Shots” (pressing the pad once will play the entire part) while Pads 05-08 play the sample part as “Note Ons” (pressing the pad and holding it will play the part; releasing it will stop playback):

- **Play From Start (Pad 01 and Pad 05)** plays the sample from the start point to the end of the sample regardless of the end point. If the start point is identical to the end point, nothing will be played.
- **Play To Start (Pad 02 and Pad 06)** plays the sample portion before the start point. If the start point is set to 0, nothing will be played.
- **Play To End (Pad 03 and Pad 07)** plays the sample portion from the start point to the end point.
- **Play From End (Pad 04 and Pad 08)** plays the sample part from the end point to the end of the sample. If the end point is identical to the end of the sample, nothing will be played.
Settings Section

The **Settings** section lets you edit various parameters affecting playback and loop functions.

In the software, edit the start point (**Start**), end point (**End**), or loop point (**Loop Start**) by double-clicking the number in the field, and use your computer keyboard to enter a value.

**Hardware:** Edit the start point (**Start**), end point (**End**), or loop point (**Loop**) by using the **Cursor Buttons** to select the field and then using the **Data Dial** or the +/- buttons to select a value. Alternatively, you can enter a value by using the number buttons and confirming by pressing **Enter**.

![Sample Edit](image)

The **Sample Edit** section in the display of the MPC hardware.

In the software, you can activate the loop and samples options by clicking the corresponding button:

- **Loop** activates the loop function, which will repeat the part of the sample between the loop point and the end point.
- **Snap to Zero** activates the snap-to-zero function. For easier sample editing, the software will "force" you to place a start point or end point only at "zero-crossings." This can help to avoid clicks and glitches when playing a sample.
- **Tune** lets you transpose the sample based on its original pitch. The value range is two octaves, up or down, in semitone steps.
- **Root Note** lets you select a root note for the sample. The root note defines which note will play the sample at its original pitch when in a Keygroup Program.
- **Loop Lock** activates the Loop Lock option. The adjusting of the sample start point and the start point can be linked, allowing simultaneous adjustments (e.g., when you need to find a loop with a defined length).
Hardware:

- Press **F4 (Loop)** to activate the loop function, which will repeat the part of the sample between the loop point and the end point.

- Press **F3 (0 Snap)** to activate the snap-to-zero function. For easier sample editing, the software will "force" you to place a start point or end point only at "zero-crossings." This can help to avoid clicks and glitches when playing a sample.

- Use the **Cursor Buttons** to select any of the following fields and use the **Data Dial** or the +/- buttons to change the setting:
  
  **Tune** lets you transpose the sample based on its original pitch. The value range is two octaves, up or down, in semitone steps.

  **Root Note** lets you select a root note for the sample. The root note defines which note will play the sample at its original pitch when in a Keygroup Program.

  **Loop Lock** activates the Loop Lock option. The adjusting of the sample start point and the start point can be linked, allowing simultaneous adjustments (e.g., when you need to find a loop with a defined length).
Process Section

The Process section gives you various editing options for the selected sample.

In the software, click the desired sample editing option (described below). A new window will open (which may have some additional parameters). To execute a selected option, click Do It, or cancel your changes by clicking Cancel.

Tips:
- When the new window is open, you can click the Function menu to select another edit option, if desired.
- All Start/End processes will only affect the part of the sample between the start point and the end point. Bit Reduce and Stereo > Mono will affect the entire sample regardless of its start point or end point.

Hardware:
1. Press F6 (Process) to open the Process Sample page.
2. Use the Data Dial or the +/- buttons to select the desired editing option (described below) in the Function field. Some options have some additional parameters—use the Cursor Buttons to select them and the Data Dial or +/- buttons to adjust them.
3. To execute a selected option, press F5 (Do It), or cancel your changes by pressing F4 (Cancel).
The following sample editing options are available:

- **Discard** deletes parts of the sample before the start point and after the end point.
- **Delete** deletes the part of the sample between the start point and end point and closes the gap between them.
- **Silence** replaces the part of the sample between the start point and end point with silence.
- **Extract** deletes parts of the sample before the start point and after the end point and saves it as a new sample (with a name you enter) in your current Project.
  
  **Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the Project.
- **Normalize** increases a sample's level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with Projects whose samples have a wide range of amplitudes.
- **Reverse** reverses the part of the sample between the start point and end point.
- **Fade In** sets a fade-in between the start point and end point of the sample. The following types are available:
  
  - **Linear** fades the audio in with a linear curve—a straight line between the start and end.
  - **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.
- **Fade Out** sets a fade-out between the start point and end point of the sample. The following types are available:
  
  - **Linear** fades the audio out with a linear curve—a straight line between the start and end.
  - **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.
• **Pitch Shift** changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your Sequence without affecting the sample’s tempo or duration. You can adjust it up to 12 semitones, up or down. Keep in mind that the audio quality may decrease at more extreme settings.

• **Time Stretch** lengthens or shortens the sample without changing its pitch. This is useful when you want to match the durations of two samples with different pitches. You can enter the original tempo of the sample and the desired tempo after processing.

  **Tip:** To change the sample length in percent, set the original tempo to 100, and then set the new tempo to the desired percentage (e.g., to lengthen the sample by 20%, set the original tempo to 100 and set the new tempo to 80).

• **Gain Change** raises or lowers the volume of the sample. You can adjust it up to 18dB, higher or lower. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

• **Copy** saves a copy of the sample and adds a consecutive number after the sample name.

• **Bit Reduce** lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. You can reduce the bit rate down to 1 bit. (The sound is similar to the Resampler effect, but Bit Reduce will permanently alter the sample.)

  **Tip:** Use this on drum loops to get a dirty, "old-school" sizzle but with a digital "edge."

• **Stereo > Mono** converts a stereo sample to a new mono sample and saves it as a new sample (with a name you enter) in your current Project. The following options are available:
  
  o **Left** will convert the left channel only.
  o **Right** will convert the right channel only.
  o **Sum** will combine the left and right audio channels to a single mono channel.

**Project Information**

This is identical to the Project Information in Main Mode. For more information, please see [Main Mode > Project Information](#).

**Important:** Newly recorded samples will be shown in the Sample area of the Project Information. To use them in your Project, load them into Programs first.
Chop Mode

The Chop section describes several functions unique to Chop Mode, in contrast to Trim Mode.

In Chop Mode, the sample will be divided into multiple regions called slices. There are three different ways to use this function:

- **Region** divides a sample into several regions of equal length.
- **BPM** divides a sample into several regions based on the tempo (beats per minute).
- **Threshold** uses an adjustable detection algorithm that derives the number of regions created from the volume levels present in the sample.

You can also manually insert a slice by clicking near the top of the Waveform Display, just under the light grey sample timeline.
Edit Section

The Edit section contains controls to edit samples and to select between Chop Mode or Trim Mode.

**Hardware:** Use the Data Dial or the -/+ buttons to select a sample for editing. The selected sample name is shown at the top of your display.

In the software, click the Edit Sample drop-down menu and select the desired sample.

The Q-Link Knobs can be used for various editing and viewing functions:

- Use Q-Link Knobs Q13, Q9, Q5, or Q1 to adjust the start point of the sample. The smaller the Q-Link Knob number, the more precise the adjusting of the start point.
- Use Q-Link Knobs Q14, Q10, Q6, or Q2 to adjust the end point of the sample. The smaller the Q-Link Knob number, the more precise the adjustment of the end point.
- Use Q-Link Knob Q15 to select a slice for editing.
- Use Q-Link Knob Q11 to set the threshold for slice detection (in Threshold Mode), the number of regions (in Region Mode), or the numbers of bars (in BPM Mode).
- Use Q-Link Knob Q8 to scroll through the waveform.
- Use Q-Link Knob Q7 to set the number of beats in BPM Mode. (This Q-Link Knob has no function in Threshold Mode or Region Mode.)
- Use Q-Link Knob Q4 to zoom in and out of the waveform.
- Use Q-Link Knob Q3 to set the Time Division in BPM Mode. (This Q-Link Knob has no function in Threshold Mode or Region Mode.)
Hardware: Press F1 (Chop) to enter Chop Mode.

- Use Q-Link Knobs Q13, Q9, Q5, or Q1 to adjust the start point of the sample. The smaller the Q-Link Knob number, the more precise the adjustment of the start point.
- Use Q-Link Knobs Q14, Q10, Q6, or Q2 to adjust the end point of the sample. The smaller the Q-Link Knob number, the more precise the adjustment of the end point.
- Use Q-Link Knob Q15 to select a slice for editing.
- Use Q-Link Knob Q11 to set the threshold for slice detection (in Threshold Mode), the number of regions (in Region Mode), or the number of bars (in BPM Mode).
- Use Q-Link Knob Q8 to scroll through the waveform.
- Use Q-Link Knob Q7 to set the numbers of beats in BPM Mode. (This Q-Link Knob has no function in Threshold Mode or Region Mode.)
- Use Q-Link Knob Q4 to zoom in and out of the waveform.
- Use Q-Link Knob Q3 to set the Time Division in BPM Mode. (This Q-Link Knob has no function in Threshold Mode or Region Mode.)
Pad Section

When **Audition** in the **Settings** section is deactivated, trigger the following playback options by pressing the corresponding pad:

- **Play Loop (Pad 13)** plays the sample from the loop point to the end point repeatedly.
- **Play All (Pad 16)** plays the whole sample regardless of any editings.

When **Audition** in the **Settings** section is activated, you can use the pads to play the different slices. Each slice is assigned to a pad automatically, starting from Pad A01 with Slice 1 and ascending from there.

If your sample contains more than 16 slices, use the **Bank** buttons to switch through the pad banks to view all playable slices. Playing a slice will also select it.
Settings Section

In the software, the Settings section lets you edit various parameters affecting the start point and end point of your sample's slices:

- **Snap to Zero** activates the snap-to-zero function. For easier sample editing, the software will "force" you to place a start point or end point only at "zero-crossings." This can help to avoid clicks and glitches when playing a sample.

- **Slice** is the number of the currently selected slice. To select a slice, either click it in the Waveform Display or click and drag the Slice field up or down. (Remember that you have to create slices before one can be selected.)

- **Start** and **End** define the start point and end point (respectively) of the current slice. Change these values by doing any of the following:
  - Click and drag a slice marker in the Waveform Display left or right.
  - Click near the top of the Waveform Display to create a new slice marker there. Remember that the start point of a slice is also the end point of the previous slice.
  - Double-click the value in the field and type in a new one using your computer keyboard.

- When **Audition** is activated, you can use the pads to play the different slices. Each slice is assigned to a pad automatically, starting from Pad A01 with Slice 1 and ascending from there. If your sample contains more than 16 slices, use the Bank buttons to switch through the pad banks to view all playable slices. Playing a slice will also select it.

- With **Link Slices** activated, changing the start point of a slice will also change the end points of the previous slice. Similarly, changing the end point of a slice will also change the start point of the next slice. Turn Link Slices off if you are trying to create slices that use non-contiguous parts of the sample.

- **One Shot / Note On** determines whether the pads play their respective slices as One Shots (pressing the pad once will play the entire part) or as Note Ons (pressing the pad and holding it will play the part; releasing it will stop playback).
Hardware: To adjust the settings in Chop Mode:

• Press F3 (0 Snap) to activate or deactivate to activate the snap-to-zero function. For easier sample editing, the software will “force” you to place a start point or end point only at “zero-crossings.” This can help to avoid clicks and glitches when playing a sample.

• Press a pad to select its slice. Each slice is assigned to a pad automatically, starting from Pad A01 with Slice 1 and ascending from there. If your sample contains more than 16 slices, use the Pad Bank buttons to switch through the pad banks to view all playable slices.

• Use the Cursor Buttons to select the Start field or End field, and then use the Data Dial or the -/+ buttons to set the value. Alternatively, you can enter a value by using the number buttons and confirming by pressing Enter. Remember that the start point of a slice is also the end point of the previous slice.

• Press F4 (Audition) to activate or deactivate Audition.

• Use the Cursor Buttons to select the Link field, and then use the Data Dial or the -/+ buttons to turn Link Slices on or off.

• Use the Cursor Buttons to select the One Shot / Note On field, and then use the Data Dial or the -/+ buttons to set it to One Shot or Note On.

The Sample Edit section in the display of the MPC hardware.
Chop To Section

The Chop To section determines the slicing process. You can select between three slicing modes:

- **Threshold** uses an adjustable detection algorithm that derives the number of regions created from the volume levels present in the sample.
  
  Click and drag the Threshold field up or down to set the threshold level. The higher the selected value, the more slices will be created.

- **Regions** divides a sample into several regions of equal length.
  
  Click and drag the Num Regions field up or down to set the number of regions you wish to divide the sample into. Usually, 16 is a good start for a single-measure loop.

- **BPM** divides a sample into several regions of equal length based on its length and the current tempo (beats per minute).
  
  Click and drag the Bars field up or down to set how many bars are in the sample.

  Click and drag the Beat field up or down to set how many beats are in each bar.

  Click and drag the Time Div field up or down to set a note division; the slice markers will be placed according to this setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this parameter to 1/16.)

**Hardware:**

1. Use the Cursor Buttons to select the Chop To field.
2. Use the Data Dial or the +/- buttons to set the mode (Threshold, Region, or BPM).
3. Use the Cursor Buttons to select the parameters for that mode, and use the Data Dial or the +/- buttons to change the value.
Process Section

The **Process** section gives you various editing options for the selected sample.

In the software, click the desired sample editing option (described below). A new window will open (which may have some additional parameters). To execute a selected option, click **Do It**, or cancel your changes by clicking **Cancel**.

**Tip:** When the new window is open, you can click the **Function** menu to select another edit option, if desired.

The following sample editing options are available:

- **Silence** replaces the part of the sample between the start point and end point with silence.
- **Extract** deletes parts of the sample before the start point and after the end point and saves it as a new sample (with a name you enter) in your current Project.
  
  **Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the Project.

- **Normalize** increases a sample’s level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with Projects whose samples have a wide range of amplitudes.

- **Reverse** reverses the part of the sample between the start point and end point.

- **Fade In** sets a fade-in between the start point and end point of the sample. The following types are available:
  
  - **Linear** fades the audio in with a linear curve—a straight line between the start and end.
  - **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.
• **Fade Out** sets a fade-out between the start point and end point of the sample. The following types are available:
  o *Linear* fades the audio out with a linear curve—a straight line between the start and end.
  o *Log* fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  o *Exp* fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

• **Pitch Shift** changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your Sequence without affecting the sample’s tempo or duration. You can adjust it up to 12 semitones, up or down. Keep in mind that the audio quality may decrease at more extreme settings.

• **Gain Change** raises or lowers the volume of the sample. You can adjust it up to 18dB, higher or lower. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

• **Convert** offers three ways of exporting the sliced sample:
  o *Patched Phrase* creates a new sample based on your edits and places it in the current Project.
  o *Sliced Samples* creates individual samples from the slices of the current sample.
    If *Crop Samples* is activated, each slice results in a new sample.
    If *Create New Program* is activated, you will create a new Program in which each slice results in a sample and is automatically assigned to a pad. (If *Create New Program* is selected, you also get the option to *Create Events*.)
    If *Create Events* is activated (available only when *Create New Program* is activated), you will create a new Program in which each slice results in a sample and is automatically assigned to a pad. Furthermore, it will automatically create a new Track in which each pad plays its corresponding slice in ascending sequence by pad number. The samples will be named with SI and a consecutive number attached to their original name.
- Assign Slice assigns a single slice to a selected pad. Click Pad and select the desired pad. If Crop Samples is activated, each slice results in a new sample. Click Program to specify a Program to which you want to add the assigned slice. The sample will be named with pp attached to its original name.

Track with events after using the Sliced Samples > Create Events function.
Hardware:
1. Press F6 (Process) to open the Process Sample page.
2. Use the Data Dial or the -/+ buttons to select the desired editing option (described below) in the Function field. Some options have some additional parameters—use the Cursor Buttons to select them and the Data Dial or -/+ buttons to adjust them.
3. To execute a selected option, press F5 (Do It), or cancel your changes by pressing F4 (Cancel).

The Process Sample display for Pitch Shift of the MPC hardware.

Project Information

This is identical to the Project Information in Main Mode. For more information, please see Main Mode > Project Information.

Important: Newly recorded samples will be shown in the Sample area of the Project Information. To use them in your Project, load them into Programs first.
Song Mode

Song Mode lets you arrange Sequences in a specific order and/or repetition to create songs. You can edit the structure of a Song during playback for easy, on-the-fly composing.

A Project can contain up to 32 Songs, each consisting of up to 999 "steps," each of which can have an assigned Sequence as well as the number of times that Sequence will repeat.

To enter Song Mode in the software, do one of the following:

- Click the **Song Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Song**.
- On your computer keyboard, press **Ctrl+9** (Windows) or **⌘+9** (Mac OS X).

**Hardware:** To enter Song Mode, press the **Song** button.
Sequence Playlist

The Sequence Playlist Section (to the left of the pads in the software) is the list of the steps of a Sequence.

Each step in a Song has:
- an assigned Sequence
- the tempo of the Sequence
- the number of bars in the Sequence
- how many times the Sequence plays

You can add a Sequence to the Sequence Playlist by clicking and dragging from a pad and dropping it onto the list. You can also click and drag Sequences from the pads and drop them onto the workspace in the upper half of the window, if you prefer working in a horizontal arrangement.

You can insert Sequences between existing Sequences, or you can replace Sequences by dragging a Sequence directly over another.

The information for each step of a Sequence is shown in five columns:
- **Step**: Which "step" of the Song it is. Each Song can contain up to 999 steps.
- **Sequence**: The name of the Song’s Sequences. Click a Sequence to open a drop-down menu where you can select which Sequence should be in that step.
- **Rpts (Repeats)**: How many times a Sequence will be played. Normally, a Sequence is played only once, but you make it replay up to 999 times. Click the field and drag it up or down to change the number. If you set it to **Hld** (Hold, the lowest/"minimum" value), the Sequence keep playing until you stop playback.
- **BPM**: The tempo of a Sequence in beats per minute.
- **Bars**: The bar length of a Sequence.
Hardware: To manage the Sequence Playlist in Song Mode.

- Use the **Cursor Buttons** to select the **Song** field, and use the **Data Dial** or the `-/+` buttons to select the Song shown in the Sequence Playlist.
- Use the **Cursor Buttons** to select a Sequence in the **Sequence** column, and use the **Data Dial** or the `-/+` buttons to select which Sequence should be in that step.
- Use the **Cursor Buttons** to select the **Rpts (Repeats)** column, and use the **Data Dial** or the `-/+` buttons to set how many times a Sequence will be played. Normally, a Sequence is played only once, but you make it replay up to 999 times. If you set it to **Hold** (the lowest/"minimum" value), the Sequence keep playing until you stop playback.
- Use the **Cursor Buttons** to select the **Now** field, and use the **Data Dial** or the `-/+` buttons to change the current position of the audio pointer in the Song. The arrow (>) in the **Step** column indicates the current step in the Song.

<table>
<thead>
<tr>
<th>Step</th>
<th>Sequence</th>
<th>Rpts</th>
<th>Tempo</th>
<th>Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sequence 01</td>
<td>1</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Sequence 02</td>
<td>2</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Sequence 03</td>
<td>2</td>
<td>120</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>(End of Song)</td>
<td>1</td>
<td>120</td>
<td>2</td>
</tr>
</tbody>
</table>

**Song Mode** in the MPC hardware display.
Pad Bank Section

In the Pad Bank section, all Sequences are assigned to a pad. Unused empty Sequences are marked **(unused)**. You can use the Pad Bank buttons to show the Sequences assigned to pads in other banks.

You can easily click and drag Sequences from this section and drop them onto the Sequence playlist. You can also click and drag Sequences from the pads and drop them onto the workspace in the upper half of the window, if you prefer working in a horizontal arrangement.

You can insert Sequences between existing Sequences, or you can replace Sequences by dragging a Sequence directly over another.

---

Song Section

The Song section lets you name or select a Song or execute other operations that affect the Song.

Click the Song drop-down menu to name the Song.

You can also click the downward arrow (▼) to the right of the Song name to open a drop-down menu where you can select another of the 32 Songs in the Project.

Click **Convert > Seq** to convert the current Song to a single Sequence.

**Hardware:** Press F4 (Convert) to convert the current Song into a single Sequence.

Click **Clear** to delete all Sequences of the Song.

**Hardware:** Press F1 (Clear) to delete all Sequences of the Song.
The **Edit Step** section contains controls to add or delete steps from the Song.

Click **Insert Step** to insert the selected Sequence (indicated by the lit pad in the **Pad Bank** section) in the Sequence Playlist.

**Hardware:** Press **F6 (Insert)** to insert a Sequence *under* the selected one.

Click **Delete Step** to delete the selected step from the Sequence Playlist.

**Hardware:** Press **F5 (Delete)** to delete the selected Sequence.
Step Section

The Step section contains information about the current step in the Sequence Playlist. Click and drag each field up or down to change its setting.

- **First Bar** indicates where in the Song the step begins.
- **Last Bar** indicates where in the Song the step ends before moving onto the next step.
- **Total Bars** indicates how many bars the step occupies in the Song (this accounts for how many times the step’s Sequence repeats).
- **Repeats** indicates how many times the step’s Sequence plays.
- **Time Sig** indicates the Sequence’s time signature.
- **BPM** indicates the Sequence’s tempo in beats per minute.

**Hardware:** When a Song is playing, the following buttons are available in the MPC hardware’s display:

- Press F2 (Sudden) to switch to the next Sequence before the software has finished playing back the current Sequence. This is useful in live performances, if you need to switch to the next Sequence at a certain cue.
- Press F3 (Next) to jump to the next Sequence at the end of the current Sequence. These buttons can be also used in conjunction with Hold to get the MPC out of a Hold Sequence.

**Tip:** To learn more about creating Songs, please see [Quick Start / Tutorial > Creating a Song](#).

Project Information

This is identical to the Project Information in Main Mode. For more information, please see [Main Mode > Project Information](#).
Pad Mute Mode lets you easily mute pads within a Program or set Mute Groups for each pad.

To enter Pad Mute Mode in the software, do one of the following:

- Click the **Pad Mute Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Pad Mute**.
- On your computer keyboard, press **Ctrl+0** (Windows) or **⌘+0** (Mac OS X).

**Hardware:** To enter Pad Mute Mode, press **Shift + Track Mute / Pad Mute**.
Pad Mute

You can mute or unmute individual sounds (on a single Track) in real time by pressing the pads. This is useful if you want to hear a Track without a particular sound or if you want to isolate specific sounds or combinations of sounds.

**Tip:** This function is similar to, but probably more convenient than, muting pads one at a time in the grid.

In the software, do the following to use Pad Mute:

1. Click the Pad Mute button in the Mute Section to activate it.
2. Click the desired bank (A-H) in the Bank section or Pad Bank section.
3. Click a pad in the Pad Bank section to mute or unmute its assigned sound. Muted pads are lit red; unmuted pads are lit yellow.

Alternatively, you can click the miniature pads in Bank section. This section gives you an overview of all 128 pads at the same time. Unused pads are greyed out.

**Time Correct** lets you quantize Pad Mutes. This is useful when you want your mutes to line up with a specific time division. Click the Time Correct drop-down menu and select a value from 1/16th (sixteenth notes) to 2 bar (2 bars). For example, with Time Correct set to 1 bar, your mutes will always align with the beginning of the measure immediately after you press the pad.
Hardware:

1. Press **F1 (PadMute)** to activate Pad Mute.
2. The 16 blocks in the display represent the 16 pads of the current bank. Press a pad to mute or unmute its assigned sound. Use the **Pad Bank** buttons to switch between the 16 banks, if necessary.

   Muted pads are lit red; unmuted pads are lit yellow. Unused pads do not show a sample name.

   Press **F4 (Time Div)** and use the **Data Dial** or +/- buttons to edit the **Time Correct** value. Press **F5 (T.C.)** to activate or deactivate Time Correct.

   The **Pad Mute** section in the display of the MPC hardware.
Pad Group

The Pad Group feature extends the concept of Pad Mutes: you can mute or unmute multiple pads (on a single Track) by pressing one pad that you have assigned to a Mute Group. This is useful if you want to hear a Track without a particular group of sounds or if you want to isolate specific sounds in various combinations. You can create up to 16 different Pad Groups.

In the software, do the following to use Pad Groups:

1. Click the Pad Group button in the Mute Section to activate it.
2. Click the desired bank (A–H) in the Bank section or Pad Bank section.
3. Click a pad in the Pad Bank section that you want to assign to a Mute Group.
   Alternatively, you can click the the miniature pads in Bank section. This section gives you an overview of all 128 pads at the same time. Unused pads are greyed out.
4. Click and drag the Pad field in the Mute Section up or down to select the desired Mute Group number.
   When a pad in a Mute Group is selected, the other pads in that same Mute Group will blink yellow.

Time Correct lets you quantize Pad Mutes. This is useful when you want your mutes to line up with a specific time division. Click the Time Correct drop-down menu and select a value from 1/16th (sixteenth notes) to 2 bar (2 bars). For example, with Time Correct set to 1 bar, your mutes will always align with the beginning of the measure immediately after you press the pad.
Hardware:

1. Press F2 (PadGroup) to activate Pad Group.
2. Press a pad to select it. Use the Pad Bank buttons to switch between the 16 banks, if necessary.
3. Use the Data Dial or +/- buttons to select the desired Mute Group number.

   When a pad in a Mute Group is selected, the other pads in that same Mute Group will blink yellow.

   Press F4 (Time Div) and use the Data Dial or +/- buttons to edit the Time Correct value. Press F5 (T.C.) to activate or deactivate Time Correct.

![Pad Group section in the display of the MPC hardware.](image)

Project Information

This is identical to the Project Information in Main Mode. For more information, please see Main Mode > Project Information.
Track Mute Mode

Track Mute Mode lets you easily mute Tracks within a Sequence or set Track Mute Groups to use with the pads.

To enter Track Mute Mode in the software, do one of the following:

- Click the **Track Mute Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Track Mute**.
- On your computer keyboard, press **Ctrl+-** (Windows) or **⌘+-** (Mac OS X).

**Hardware:** To enter Track Mute Mode, press the **Track Mute** button.
Track Mute

You can mute or unmute individual Tracks in real time by pressing the pads. This is useful if you want to hear a Sequence without a particular Track (e.g., muting your keyboard Track to focus on the bass) or if you want to isolate specific sounds or combinations of sounds that are separated by Track.

**Tip:** This function is similar to, but more convenient than, muting Tracks one at a time in Track Mixer Mode.

In the software, do the following to use Track Mute:

1. Click the **Track Mute** button in the **Mute Section** to activate it.
2. Click the desired bank (A–H) in the **Bank section** or **Pad Bank section**.
3. Click a pad in the **Pad Bank section** to mute or unmute its corresponding Track. Muted pads are lit red; unmuted pads are lit yellow.
   Alternatively, you can click the the miniature pads in **Bank section**. This section gives you an overview of all 128 pads at the same time. Unused pads are greyed out.

Click the **Solo** button to solo the selected Track only, muting all other Tracks.

**Time Correct** lets you quantize Track Mutes. This is useful when you want your mutes to line up with a specific time division. Click the **Time Correct** drop-down menu and select a value from 1/16th (sixteenth notes) to 2 bar (2 bars). For example, with **Time Correct** set to 1 bar, your mutes will always align with the beginning of the measure immediately after you press the pad.
Hardware:

1. Press F1 (TrkMute) to activate Track Mute.

2. The 16 blocks in the display represent the 16 pads of the current bank. Press a pad to mute or unmute its corresponding Track. Use the Pad Bank buttons to switch between the 16 banks, if necessary.

   Muted pads are lit red; unmuted pads are lit yellow. Unused pads do not show a sample name.

   Press F6 (Solo) to solo the selected pad.

   Press F4 (Time Div) and use the Data Dial or +/- buttons to edit the Time Correct value. Press F5 (T.C.) to activate or deactivate Time Correct.

The Track Mute section in the display of the MPC hardware.
Track Group

The Track Group feature extends the concept of Track Mutes: you can mute or unmute multiple Tracks simultaneously by pressing one pad that you have assigned to a Track Group. This is useful if you want to hear a Sequence without a particular group of Tracks or if you want to isolate specific Tracks in various combinations. You can create up to 16 different Track Groups.

In the software, do the following to use Track Groups:

1. Click the **Track Group** button in the Mute Section to activate it.
2. Click the desired bank (A–H) in the Bank section or Pad Bank section.
3. Click a pad in the Pad Bank section that you want to assign to a Mute Group.
   Alternatively, you can click the the miniature pads in Bank section. This section gives you an overview of all 128 pads at the same time. Unused pads are greyed out.
4. Click and drag the Track ____ field in the Mute Section up or down to select the desired Mute Group number.
   When a Track in a Mute Group is selected, the other Tracks in that same Mute Group will blink yellow.

Click the Solo button to solo the selected Track only, muting all other Tracks.

**Time Correct** lets you quantize Track Group Mutes. This is useful when you want your mutes to line up with a specific time division. Click the Time Correct drop-down menu and select a value from 1/16th (sixteenth notes) to 2 bar (2 bars). For example, with **Time Correct** set to 1 bar, your mutes will always align with the beginning of the measure immediately after you press the pad.
Hardware:

1. Press **F2 (TrkGroup)** to activate Track Group.
2. Press a pad to select it. Use the **Pad Bank** buttons to switch between the 16 banks, if necessary.
3. Use the **Data Dial** or +/- buttons to select the desired Mute Group number.

   When a pad in a Mute Group is selected, the other pads in that same Mute Group will blink yellow.

   Press **F6 (Solo)** to solo the selected pad.

   Press **F4 (Time Div)** and use the **Data Dial** or +/- buttons to edit the **Time Correct** value. Press **F5 (T.C.)** to activate or deactivate Time Correct.

---

![Track Group Section](image)

The **Track Group** section in the display of the MPC hardware.

---

Project Information

This is identical to the Project Information in Main Mode. For more information, please see **Main Mode > Project Information**.
Step Sequence Mode

Step Sequence Mode lets you create or edit Sequences by using the pads as "step buttons," simulating the experience of a traditional step-sequencer-style drum machine.

To enter Step Sequence Mode in the software, do one of the following:

- Click the **Step Sequence Mode** tab in the Mode Tab Section of the software window.
- Click the **View** Menu, select **Mode**, and then select **Step Sequence**.
- On your computer keyboard, press **Ctrl++** (Windows) or **⌘+=** (Mac OS X).

**Hardware:** To enter Step Sequence Mode, press the **Step Seq** button.
The upper half of the window contains the grid, showing the note events of the current Sequence. The lower half of the window has various controls that are also available in other modes, like Main Mode. Please see the Main Mode chapter to learn more about the Q-Link Section, the Sequence Section, the Track Section, the Program Channel Strip, or the Project Information.

The only difference is the Pad Section, which you use to enter note events as you would with a traditional step sequencer. (This can be done when a Sequence is playing or stopped.) Please see the following Pad Section part of this chapter to learn how to do this.

### Pad Section

The pad section lets you quickly create and delete note events as "steps" by using the pads of your MPC hardware or MPC software.

**Tip:** Step Sequence Mode is useful for programming drums, emulating the step recording of drums with drum machines in the 1980s.

In the software, enter or erase note events by doing the following:

1. First, click the Track drop-down menu above the grid or in the Track section to select a Track.
2. Select the pad whose steps you want create or edit by doing on the following:
   - In the Pad Section, click the Pad field and drag it up or down to select the pad number.
   - Click the pad’s row in the grid.
3. Click the Previous or Next buttons to select the bar whose steps you want to edit. You can also click the Current Bar field and enter the number using your computer keyboard.
4. Each pad represents a step in the bar. Keep in mind that the number of steps depends on the Time Correct setting, which you can set in the Sequence Section. For time divisions larger than 16 (e.g., 32), the bar’s steps will be represented by multiple pad banks. Use the Pad Bank Buttons A and B to view all the steps within a bar.

If the pad already has note events on the selected Track, the corresponding pads (steps) will be lit with colors corresponding to their velocities.

Click an unlit pad to enter a note event at that step. The pad will light up with a color corresponding to its velocity.

Click a lit pad to delete the note event from that step. The pad will be unlit.
Hardware: Create or delete steps by doing the following:

1. Use the **Cursor Buttons** to select the **Trk** field, and use the **Data Dial** or +/- buttons to select a Track.

2. Use **F5 (Pad-)** and **F6 (Pad+)** to select the pad whose steps you want to create or edit. The pad number and its sample name will appear in the upper-right corner of the display. Alternatively, you can use the **Cursor Buttons** to select the **Pad** field in the upper-right corner and use the **Data Dial** or +/- buttons to select a pad.

3. Use **F2 (Bar-)** and **F3 (Bar+)** to select the bar whose steps want to create or edit.

4. Each pad represents a step in the bar. Keep in mind that the number of steps depends on your **Time Correct** settings, which you can set by pressing **F1 (T.C.)**. For time divisions larger than 16 (e.g., 32), the bar’s steps will be represented by multiple pad banks. Use the **Pad Bank Buttons A** and **B** to view all the steps within a bar. You can press and hold the **Note Repeat** button to change the time division of the Sequence grid and use the **F-buttons** to select the desired value.

If the pad already has note events on the selected Track, the corresponding pads (steps) will be lit with colors corresponding to their velocities.

Press an unlit pad to enter a note event at that step. The pad will light up with a color corresponding to its velocity.

Click a lit pad to delete the note event from that step. The pad will be unlit.

---

Working with **Step Sequence Mode** in the MPC hardware display.
MIDI Control Mode

In MIDI Control Mode, you can customize what MIDI messages are sent from certain controls on your hardware. This custom “control map” will then work whenever you are in MIDI Control Mode. This is useful when using MPC as a plugin: you can use MIDI Control Mode to use your MPC hardware to control your host software, and then switch back to any other mode to control the MPC plugin.

**Important:**

- In your host software, make sure your MPC hardware is selected as a MIDI controller device.
- The edits you make in MIDI Control Mode will be retained with the current MPC Project. If you want to use the same control map for all of your Projects, we recommend saving your control map in your template file. See *Software Menus > Edit Menu > Preferences: Auto Load/Save Tab* for more information about template files.

To enter MIDI Control Mode in the software, click the **MIDI Control Mode** tab in the Mode Tab Section of the software window.

**Hardware:** To enter MIDI Control Mode, press **Shift + Song / Other**.

The software window will display a graphical interface resembling your connected hardware controller. Editable controls display their current MIDI message. Controls outlined in red are identical across all eight pad banks. The pads are all editable, as well, and can be set to behave identically across all banks or differently in each bank.
To edit a control:

1. Select it by doing one of the following:
   - clicking it in the software
   - pressing or moving it on your hardware

2. In the **Edit** panel on the left side of the software window, set that control’s parameters to your preference. The available parameters depend on whether it is a Q-Link Knob, pad, or the type of button.
   - **Control** (all controls): This determines what message the control sends to the software (e.g., acting as a specific Q-Link Knob, acting as a specific pad, entering a specific mode, revealing or hiding the File Browser, Undo, Tap Tempo, etc.).
   - **Light LED** (all controls): This determines how the control’s LED (or multiple LEDs) on the hardware will behave.
     - When set to **Never**, the LED will always be off.
     - When set to **MIDI Input**, the LED will light up when the software receives a MIDI message that matches that control.
     - When set to **Local**, the LED will light up when you use that control and/or MIDI input is received.
   - **MIDI Channel** (all controls): This determines over which MIDI channel (from 1 to 16) the control will send MIDI messages to the software.
   - **CC Number** (buttons and Q-Link Knobs only): This determines what Control Change the control will send to the software.
   - **Mode** (Q-Link Knobs only): This determines how the Q-Link Knob will control its parameter.
     - When set to **Absolute**, the Q-Link Knob’s current position is what determines its parameter’s value; moving the Q-Link Knob may cause its parameter to "snap" to a new position when using the Q-Link Knob to control different parameters between different modes.
     - When set to **Relative**, moving the Q-Link Knob will adjust its parameter upward or downward regardless of its position.
• **Low Range** (Q-Link Knobs only): This is the Q-Link Knob’s lowest possible value (0 to 127).

• **High Range** (Q-Link Knobs only): This is the Q-Link Knob’s highest possible value (0 to 127).

• **Touch Sense** (Q-Link Knobs only): This activates or deactivates the Q-Link Knob’s touch-capacitive circuitry.
  - When set to **On**, you can touch the Q-Link Knob to send a Note On message to the software (this is how your MPC hardware normally works).
  - When set to **Off**, the Q-Link Knob will not send any Note On messages; it will only send CC messages when you turn it.

• **Touch Note** (Q-Link Knobs only): This is the MIDI note number the Q-Link Knob will send to the software when you touch it (0–127 or C-2 to G8). **Touch Sense** must be set to **On** for this to work.

• **Type** (buttons only): This determines whether the button will behave as a **Momentary** switch or **Toggle** (latching) switch.

• **Note** (pads only): This is the MIDI note number the pad will send to the software when you press it (0–127 or C-2 to G8).

• **Bank** (pads only): This is the pad bank the pad belongs to. If you check the **Set All** box, the pad’s messages and parameters will be identical across all eight banks.

• **Velocity** (pads only): This determines whether the pad will be velocity-sensitive (**On**) or not (**Off**). When set to **Off**, pressing the pad will send a note at full-level (127) always.

• **Aftertouch** (pads only): This determines how the pad’s aftertouch (pressure applied to the pad after the initial press) behaves.
  - When set to **Off**, the pad will not send any aftertouch messages.
  - When set to **Channel**, if you press multiple pads that have this setting, the aftertouch messages they send will be identical.
  - When set to **Poly**, if you press multiple pads, the aftertouch message each pads sends will be independent from the others’.

3. When you have set all of the parameters as desired, select another control or enter another mode.

**Hardware: To edit a control:**

1. Select a control by pressing it (pads, buttons) or moving it (Q-Link Knobs).

2. Use the **Cursor Buttons** to select the desired field, and use the **Data Dial** or -/+ buttons to set the desired value or option. The available parameters (described above) depend on whether it is a Q-Link Knob, pad, or the type of button.

3. When you have set all of the parameters as desired, select another control or enter another mode.
Effects

The MPC software offers various effects that you can apply to the pads, Programs, and Master mix, using both insert and send effects. This chapter can help you get a good overall understanding of how the software’s effects work.

Tips:
To open an effect’s graphic user interface and edit its parameters, double-click the name of the loaded effect.
Move an effect from one slot to another by clicking and dragging it.
Copy an effect from one slot to another by holding Ctrl (Windows) or ⌘ (Mac OS X) while clicking and dragging it.

Hardware: Whenever an effect’s name is selected in the display, you can press the Window button to view and edit the effect’s parameters. Use the Cursor Buttons to select the desired parameter, and use the Data Dial or +/- buttons to adjust it.

See Appendix > Effects and Parameters for a list of all available effects (with a brief description of each) and their editable parameters.

Overview

In a Program, each pad can have up to four insert effects applied to it. See Pad/Keygroup Insert Effects to learn more about this.

An overall Program can also have up to four insert effects applied to it, as well. See Program Insert Effects to learn more about this.

Additionally, pads and Programs can each be sent to up to four send effects. The audio of the pads and Programs will be routed to the send effects at their designate send levels, and the send effects will return the audio at the designated return levels. See Send Effects to learn more about this.

Finally, you can apply up to four insert effects to the entire Master mix. See Master Effects to learn more about this.
Insert Effects

Pad/Keygroup Insert Effects

You can apply, edit, or remove up to four pad/keygroup insert effects. The instructions for doing this depend on which mode you are in: Program Edit Mode or Program Mixer Mode.

**Important:** When using keygroup insert effects, they will be applied to the entire Keygroup Program. This is because a Keygroup Program uses the same sound across all pads, as opposed to Drum Programs where each pad can have its own insert effect.

To load a pad/keygroup insert effect in Program Edit Mode:

1. In the software, click the Program Edit tab in the Mode Tab Section.
2. Click the desired pad to select it.
3. If the Pad Inserts button is set to Off, click it so it changes to On.
4. In one of the four Pad Inserts slots, click the downward arrow (▼).
5. Select an effect from the menu that appears.

Hardware: To load a pad/keygroup insert effect in Program Edit Mode:

1. Enter Program Edit Mode by pressing the Prog Edit button.
2. Press the desired pad. (To show another set of 16 pads, use the Pad Bank buttons to select another bank.)
3. Press F6 (Effects) to view the pad’s effect slots.
4. If the Inserts field in the upper-right corner is set to Off, use the Cursor Buttons to select it, and use the Data Dial or +/- buttons to change it to On.
5. Use the Cursor Buttons to select one of the four Insert slots.
6. Use the Data Dial or the +/- buttons to select an effect. Click F4 (Select) to load it, or click F3 (Back) to close the page.
To load a pad/keygroup insert effect in Program Mixer Mode:

1. In the software, click the **Program Mixer** tab in the Mode Tab Section.
2. If the **Route** button above the desired pad is not already selected, click it. Also, if the **Inserts** button is set to **Off**, click it so it changes to **On**.
3. In one of the four **Inserts** slots of the channel strip, click the downward arrow (▼).
4. Select an effect from the menu that appears.

**Hardware:** To load a pad/keygroup insert effect in Program Mixer Mode:

1. Enter Program Mixer Mode by pressing the **Prog Mix** button.
2. Press **F5 (Insert)** to view the pads’ insert effect slots. (You can repeatedly press **F5 (Insert)** to cycle through the four available insert effect slots. The small squares below the tab indicate the current slot.)
3. Press the desired pad, or use the **Cursor Buttons** to select the desired pad. (To show another set of 16 pads, use the **Pad Bank** buttons to select another bank.)
4. Use the **Data Dial** or the +/- buttons to select an effect. Click **F4 (Select)** to load it, or click **F3 (Back)** to close the page.
Program Insert Effects

You can apply, edit, or remove up to four Program insert effects. The instructions for doing this depend on which mode you are in: **Main Mode**, **Program Edit Mode**, **Program Mixer Mode**, **Track Mixer Mode**, or **Step Sequence Mode**.

To load a Program insert effect in Main Mode or Step Sequence Mode:

1. In the software, click the **Main Mode** tab or **Step Sequence** tab in the Mode Tab Section.
2. If the **Insert** button above the Program Channel strip (in the center of the lower section) is not already selected, click it. Also, if the **Inserts** button is set to **Off**, click it so it changes to **On**.
3. In one of the four **Inserts** slots of the Program Channel strip, click the downward arrow (▼).
4. Select an effect from the menu that appears.

**Hardware**: To load a Program insert effect in Main Mode or Step Sequence Mode:

1. Enter Main Mode by pressing the **Main** button, or enter Step Sequence Mode by pressing the **Step Seq** button.
2. Use the **Cursor Buttons** to select the **Vel%** field (the lower-right-most field), and then press the **Window** button.
3. Use the **Cursor Buttons** to select one of the four **Insert** slots.
4. Use the **Data Dial** or the +/- buttons to select an effect. Click **F4 (Select)** to load it, or click **F3 (Back)** to close the page.
5. Press **F4 (Close)** when you are done.
To load a Program insert effect in Program Edit Mode:

1. In the software, click the Program Edit tab in the Mode Tab Section.
2. If the Program Inserts button is set to Off, click it so it changes to On.
3. In one of the four Program Inserts slots, click the downward arrow (▼).
4. Select an effect from the menu that appears.

Note: If the a pad's Pad Audio Route menu is set to anything other than Program, then Program insert effect will not be applied to that pad.

To load a Program insert effect in Program Mixer Mode:

1. In the software, click the Program Mixer tab in the Mode Tab Section.
2. If the Program Channel strip (on the right edge of the window) is not shown, click the downward arrow icon (on the left edge of the window) to show it.
3. If the Insert button above the Program Channel strip is not already selected, click it. Also, if the Inserts button is set to Off, click it so it changes to On.
4. In one of the four Inserts slots of the Program Channel strip, click the downward arrow (▼).
5. Select an effect from the menu that appears.
To load a Program insert effect in Track Mixer Mode:

1. In the software, click the **Track Mixer** tab in the Mode Tab Section.
2. If the Program Channel strips (in the lower section) are not shown, click the plug icon (on the left edge or at the top of the window) to show them.
3. If the **Insert** button above the desired Program Channel strip is not already selected, click it. Also, if the **Inserts** button is set to **Off**, click it so it changes to **On**.
4. In one of the four **Inserts** slots of the Program Channel strip, click the downward arrow (▼).
5. Select an effect from the menu that appears.

**Hardware:** To load a Program insert effect in Track Mixer Mode:

1. Enter Track Mixer Mode by pressing **Shift + Prog Mix / Track Mix**.
2. Use the **Cursor Buttons** to select the **Mixer** field, and then use the **Data Dial** or **-/+** buttons to set it to **Programs**.
3. Press **F5 (Insert)** to view the Programs' insert effect slots. (You can repeatedly press **F5 (Insert)** to cycle through the four available insert effect slots. The small squares below the tab indicate the current slot.)
4. Use the **Cursor Buttons** to select the desired Program. (To show another set of 16 Programs, use the **Cursor Buttons** to select the Program field in the upper-right corner, and then use the **Data Dial** or **-/+** buttons to select a new set of 16 Programs to view.)
5. Use the **Data Dial** or the **-/+** buttons to select an effect. Click **F4 (Select)** to load it, or click **F3 (Back)** to close the page.
Send Effects

You can send pads and Programs through up to **four send effects**. You must load the send effects in Track Mixer Mode first. After that, do either or both of the following:

- set the pad’s send level in *Program Mixer Mode*.
- set the Program’s send level in *Main Mode, Program Mixer Mode, Track Mixer Mode, or Step Sequence Mode*.

The instructions for doing this depend on which mode you are in.

You can set the effect’s return level in Track Mixer Mode.

**To load a send effect and set its return level:**

1. In the software, click the **Track Mixer** tab in the Mode Tab Section.
2. If the Master section (on the right edge of the window) is not shown, click the downward arrow icon (on the left edge of the window) to show it.
3. In one of the four **Return** slots of the **Send Effects** column, click the downward arrow (▼).
4. Select an effect from the menu that appears.
5. Click and drag a knob up or down to set the return level of the send effect.

**Important:** See the rest of this section to learn how to send a pad or Program to that send effect.

**Hardware:** To load and edit a send effect and its return level:

1. Press **Shift + Seq Edit / Effects**.
2. Press **F1 (Send)**, if it is not already selected.
3. Use the **Cursor Buttons** to select the desired **Send** effect slot.
4. Use the **Data Dial** or the +/- buttons to open another page to select an effect. Click **F4 (Select)** to load it, or click **F3 (Back)** to close the page.
5. Use the **Cursor Buttons** to select the desired **Level** effect slot.
6. Use the **Data Dial** or the +/- buttons to set the level.
To set the send effect level for a pad:
1. In the software, click the Program Mixer tab in the Mode Tab Section.
2. If the Send button above the desired pad’s channel strip is not already selected, click it.
3. Click and drag the knob that corresponds to the send effect up or down to set the send level.

Hardware:
To set the send effect level for a pad in Program Mix Mode:
1. Enter Program Mixer Mode by pressing the Prog Mix button.
2. Press F4 (Send) to view the pads’ send effect slots. (You can repeatedly press F4 (Send) to cycle through the four available send effect slots. The small squares below the tab indicate the current slot.)
3. Do one of the following:
   - Turn the Q-Link Knob that corresponds to the desired pad.
   - Use the Cursor Buttons to select the desired pad, and then use the Data Dial or the +/- buttons to set the send level.
   - To show another set of 16 pads, use the Pad Bank buttons to select another bank.

To set the send effect level for a pad in Program Edit Mode:
1. Enter Program Edit Mode by pressing the Prog Edit button.
2. Press the desired pad. (To show another set of 16 pads, use the Pad Bank buttons to select another bank.)
3. Use the Cursor Buttons to select one of the four Send slots, and then use the Data Dial or the +/- buttons to set the send level.
To set the send effect level for a Program in Main Mode or Step Sequence Mode:

1. In the software, click the **Main Mode** tab or **Step Sequence** tab in the Mode Tab Section.
2. If the **Send** button above the Program Channel strip (in the center of the lower section) is not already selected, click it.
3. Click and drag the knob that corresponds to the send effect up or down to set the send level.

**Hardware:** To set the send effect level for a Program in Main Mode or Step Sequence Mode:

1. Enter Main Mode by pressing the **Main** button, or enter Step Sequence Mode by pressing the **Step Seq** button.
2. Use the **Cursor Buttons** to select the **Vel%** field (the lower-right-most field), and then press the **Window** button.
3. Use the **Cursor Buttons** to select one of the four **Send** slots (under **Program**).
4. Use the **Data Dial** or the +/- buttons to set the level.
5. Press **F4** (**Close**) when you are done.

To set the send effect level for a Program in Program Mixer Mode:

1. In the software, click the **Program Mixer** tab in the Mode Tab Section.
2. If the Program Channel strip (on the right edge of the window) is not shown, click the downward arrow icon (on the left edge of the window) to show it.
3. If the **Send** button above the Program Channel strip is not already selected, click it.
4. Click and drag the knob that corresponds to the send effect up or down to set the send level.
To set the send effect level for a Program in Track Mixer Mode:

1. In the software, click the **Track Mixer** tab in the Mode Tab Section.
2. If the Program Channel strips (in the lower section) are not shown, click the plug icon (on the left edge or at the top of the window) to show them.
3. If the **Send** button above the desired Program Channel strip is not already selected, click it.
4. Click and drag the knob that corresponds to the send effect up or down to set the send level.

**Hardware:** To set the send effect level for a Program in Track Mixer Mode:

1. Enter Track Mixer Mode by pressing **Shift + Prog Mix / Track Mix**.
2. Use the **Cursor Buttons** to select the **Mixer** field, and then use the **Data Dial** or +/- buttons to set it to **Programs**.
3. Press **F4** (**Send**) to view the Programs’ send effect slots. (You can repeatedly press **F4** (**Send**) to cycle through the four available send effect slots. The small squares below the tab indicate the current slot.)
4. Use the **Cursor Buttons** to select the **Program** field, and then use the **Data Dial** or +/- buttons to select the desired set of 16 Programs to display below.
5. Do one of the following:
   - Turn the **Q-Link Knob** that corresponds to the desired Program.
   - Use the **Cursor Buttons** to select the desired Program, and then use the **Data Dial** or the +/- buttons to set the send level.
Master Effects

You can load, edit, or remove up to four Master effects.

To load a Master effect:
1. In the software, click the Track Mixer tab in the Mode Tab Section.
2. In one of the four slots of the Master FX column, click the downward arrow (▼).
3. Select an effect from the menu that appears.

Hardware: To load and edit a Master effect:
1. Press Shift + Seq Edit / Effects.
2. Press F2 (Insert).
3. Use the Cursor Buttons to select the desired Insert effect slot.
4. Use the Data Dial or the +/- buttons to open another page to select an effect. Click F4 (Select) to load it, or click F3 (Back) to close the page.
**Operation (Plugin)**

When using the MPC software as a VST, AU, RTAS, or AAX plugin, its features and functions are very similar to its operation as your host software but with some notable differences discussed in this chapter.

**Important:** For information about using the MPC software as a standalone software program, please see the **Operation (Software)** chapter.

**Note:** To learn how to load and use an instrument plugin in a host application, please refer to the corresponding chapter of your host application’s manual.

---

**Differences Between Plugin and Standalone Usage**

**Saving:** Make sure to save your work in the MPC software plugin as well as saving all of your work in your host application. For ease of use, we recommend saving your host application projects and their associated MPC projects in the same folder.

**Software Menus:** The MPC plugin doesn’t offer a top menu like in the standalone application. The menu button is located to the left of the **Main Mode** tab.

**Audio Input and Output:** Your audio input and output are set in your host application rather than in MPC. MPC’s **Preferences** will not have the **Audio** tab.

**MIDI Ports:** All MIDI Out ports will be assigned to your digital audio workstation (DAW). In MPC’s **Preferences**, the **MIDI** tab will display **DAW** as the only available MIDI Out port assignment.

**DAW Projects Folder:** In MPC’s **Preferences**, the **Plugin** tab will let you select a **DAW Projects Folder** location.

**Tempo and Sync:** The MPC plugin is automatically synchronized to the tempo of your host application. MPC’s **Preferences** will not have the **Sync** tab, and the **BPM** in the Transport Section will be greyed out.

**Playback Controls:** The **Stop**, **Play**, and **Play Start** buttons will be greyed out. You must start and stop playback using your host application’s playback controls.

**Playback Start and Stop:** The start and stop commands are always synchronized to the host application. When the playback of the host application is started, the MPC plugin playback starts simultaneously.
# Appendix

## Keyboard Shortcuts

You can use the following computer keyboard shortcuts for the MPC software.

**Important:** When running MPC as a plugin in Ableton Live 9 or Steinberg Cubase, all keyboard shortcuts need to be combined with `Alt`.

<table>
<thead>
<tr>
<th>Function</th>
<th>Control (Windows)</th>
<th>Alt</th>
<th>Shift</th>
<th>Alt+Control (Windows)</th>
<th>Alt+⌘ (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Grid, Select Box Tool</td>
<td>Click and drag to copy selected events.</td>
<td>Click background to switch to Eraser Tool.</td>
<td>Click and drag to add events to current selection.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Track View, Region Mode</td>
<td>Click and drag to copy selected events.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main Grid, Pencil Tool</td>
<td>Click and drag to copy selected events.</td>
<td>Click background to switch to Eraser Tool.</td>
<td>Click and drag selected events without snapping to grid. Click events to add to current selection.</td>
<td>Click events to &quot;send to back.&quot;</td>
<td></td>
</tr>
<tr>
<td>Real-time and Track Automation, Pencil Tool</td>
<td>Fine-edit value of selected events.</td>
<td>Click background to switch to Eraser Tool. Click and drag selected events with no time constraints.*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NT Automation, Pencil Tool</td>
<td>Fine-edit value of selected events.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select Box Tool</td>
<td></td>
<td></td>
<td></td>
<td>Click and drag to add events to current selection.</td>
<td></td>
</tr>
<tr>
<td>Nudge grid events (using keyboard cursors)</td>
<td></td>
<td></td>
<td></td>
<td>Fine-edit nudge without snapping to grid (T.C.).</td>
<td></td>
</tr>
</tbody>
</table>

* Normally, real-time automation event cannot move beyond the selected event group’s previous or next event.
## File Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Project</td>
<td>Ctrl+N</td>
<td>⌘+N</td>
</tr>
<tr>
<td>New From Template</td>
<td>Ctrl+Shift+N</td>
<td>⌘+Shift+N</td>
</tr>
<tr>
<td>Save Project</td>
<td>Ctrl+S</td>
<td>⌘+S</td>
</tr>
<tr>
<td>Save Project As</td>
<td>Ctrl+Shift+S</td>
<td>⌘+Shift+S</td>
</tr>
</tbody>
</table>

## Edit Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td>⌘+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
<td>⌘+Shift+Z</td>
</tr>
<tr>
<td>History</td>
<td>Ctrl+Shift+H</td>
<td>⌘+Shift+H</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td>⌘+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td>⌘+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td>⌘+V</td>
</tr>
<tr>
<td>Select</td>
<td>Ctrl+A</td>
<td>⌘+A</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+Shift+A</td>
<td>⌘+Shift+A</td>
</tr>
<tr>
<td>Next Sequence</td>
<td>Ctrl+Shift+]</td>
<td>⌘+Shift+]</td>
</tr>
<tr>
<td>Previous Sequence</td>
<td>Ctrl+Shift+{</td>
<td>⌘+Shift+{</td>
</tr>
<tr>
<td>Next Track</td>
<td>Ctrl+]</td>
<td>⌘+]</td>
</tr>
<tr>
<td>Previous Track</td>
<td>Ctrl+[</td>
<td>⌘+[</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl+,</td>
<td>⌘+,</td>
</tr>
</tbody>
</table>
### Time Correct Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Time Correction</td>
<td>Ctrl+K</td>
<td>⌘+K</td>
</tr>
<tr>
<td>Open Time Correct</td>
<td>Ctrl+Shift+K</td>
<td>⌘+Shift+K</td>
</tr>
<tr>
<td>Time Division: 1/4</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Time Division: 1/4T</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Time Division: 1/8</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Time Division: 1/8T</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Time Division: 1/16</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Time Division: 1/16T</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Time Division: 1/32</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>Time Division: 1/32T</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Time Division: 1/64</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>Time Division: 1/64T</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Tools Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide MIDI Keyboard</td>
<td>Ctrl+W</td>
<td>⌘+W</td>
</tr>
<tr>
<td>Enable/Disable MIDI Keys</td>
<td>Ctrl+Shift+W</td>
<td>⌘+Shift+W</td>
</tr>
</tbody>
</table>
### View Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Mode</td>
<td>Ctrl+1</td>
<td>⌘+1</td>
</tr>
<tr>
<td>Program Edit Mode</td>
<td>Ctrl+2</td>
<td>⌘+2</td>
</tr>
<tr>
<td>Program Mixer Mode</td>
<td>Ctrl+3</td>
<td>⌘+3</td>
</tr>
<tr>
<td>Track Mixer Mode</td>
<td>Ctrl+4</td>
<td>⌘+4</td>
</tr>
<tr>
<td>Track View Mode</td>
<td>Ctrl+5</td>
<td>⌘+5</td>
</tr>
<tr>
<td>Next Sequence Mode</td>
<td>Ctrl+6</td>
<td>⌘+6</td>
</tr>
<tr>
<td>Sample Record Mode</td>
<td>Ctrl+7</td>
<td>⌘+7</td>
</tr>
<tr>
<td>Sample Edit Mode</td>
<td>Ctrl+8</td>
<td>⌘+8</td>
</tr>
<tr>
<td>Song Mode</td>
<td>Ctrl+9</td>
<td>⌘+9</td>
</tr>
<tr>
<td>Pad Mute Mode</td>
<td>Ctrl+0</td>
<td>⌘+0</td>
</tr>
<tr>
<td>Track Mute Mode</td>
<td>Ctrl+-</td>
<td>⌘+-</td>
</tr>
<tr>
<td>Step Sequence Mode</td>
<td>Ctrl+=</td>
<td>⌘+=</td>
</tr>
<tr>
<td>Show/Hide Browser</td>
<td>Shift+B</td>
<td>Shift+B</td>
</tr>
<tr>
<td>Show/Hide Expansion Browser</td>
<td>Shift+E</td>
<td>Shift+E</td>
</tr>
<tr>
<td>Grid Editor</td>
<td>Shift+G</td>
<td>Shift+G</td>
</tr>
<tr>
<td>List Editor</td>
<td>Shift+L</td>
<td>Shift+L</td>
</tr>
</tbody>
</table>

### Transport Controls

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>Space+Shift</td>
<td>Space+Shift</td>
</tr>
<tr>
<td>Play from Start</td>
<td>Space</td>
<td>Space</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Function</th>
<th>Command Keys (Windows)</th>
<th>Command Keys (Mac OS X)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate Note Event(s)</td>
<td>Ctrl+D</td>
<td>⌘+D</td>
</tr>
<tr>
<td>Erase</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>Note Repeat</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>
## Effects and Parameters

This chapter lists the available effects in the software. To learn more about how effects work in the software, please see the Effects chapter.

**Note:** Some of these effects have a "sync" version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be affected by the current tempo. In the graphic user interface for these effects, a . next to the time division indicates a triplet-based rate.

**Tip:** Move an effect from one slot to another by clicking and dragging it. Copy an effect from one slot to another by holding Ctrl (Windows) or ⌘ (Mac OS X) while clicking and dragging it.

### Reverbs

**Options:** Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, and Reverb Out Gate.

**Reverb Small**

This is a spatial effect, designed to emulate a small room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
</tbody>
</table>
Reverb Medium
This is a spatial effect, designed to emulate a medium room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
</tbody>
</table>

Reverb Large
This is a spatial effect, designed to emulate the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
</tbody>
</table>
Reverb Large 2
This is a less CPU-intensive spatial effect, emulating the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
</tbody>
</table>
Reverb In Gate
This is a hall reverb with an additional control. The reverb effect is cut off when the input drops below the level set in the *Gate In* parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
<tr>
<td>Gate In</td>
<td>0–100</td>
<td>0</td>
<td>Q15</td>
</tr>
</tbody>
</table>
Reverb Out Gate

This is a hall reverb that has an additional control. The reverb effect is cut off when the output drops below the level set in the Gate Out parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
<td>Q10</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q6</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
<td>Q2</td>
</tr>
<tr>
<td>Gate Out</td>
<td>0–100</td>
<td>0</td>
<td>Q15</td>
</tr>
</tbody>
</table>
Delays

Delays the original signal for a specified period of time and plays it back over an adjustable period of time.

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, Delay Analog, Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, and Delay Multi-Tap.

### Delay Mono

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
<td>Q5</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q1</td>
</tr>
</tbody>
</table>

### Delay Mono Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
<td>Q5</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q1</td>
</tr>
</tbody>
</table>
**Delay Stereo**
Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
<td>Q5</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q1</td>
</tr>
</tbody>
</table>

**Delay Sync (Stereo)**
Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q1</td>
</tr>
</tbody>
</table>
**Delay LP**

LP Delay is identical to the Mono Delay, but it uses a resonant low-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>500</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>20</td>
<td>Q14</td>
</tr>
</tbody>
</table>

**Delay HP**

HP Delay is identical to the Mono Delay, but it uses a resonant high-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>33</td>
<td>Q1</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
<td>Q14</td>
</tr>
</tbody>
</table>
Delay Analog

Analog Delay is similar to Mono Delay, except that it’s designed to sound like an analog “bucket brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100 ms</td>
<td>25</td>
<td>Q5</td>
</tr>
</tbody>
</table>

Delay Analog Sync

Analog Delay is similar to Mono Delay, except that it’s designed to sound like an analog “Bucket Brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100 ms</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Ramp</td>
<td>0–100 ms</td>
<td>50</td>
<td>Q1</td>
</tr>
</tbody>
</table>
Delay Tape Sync
Tape Delay emulates a delay system using an analog tape loop and a series of tape heads to produce an echo effect. This delay type yields a very distinct echo sound often heard in reggae and dub-style music.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Ramp</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Head 1</td>
<td>0–100</td>
<td>100</td>
<td>Q14</td>
</tr>
<tr>
<td>Head 2</td>
<td>0–100</td>
<td>0</td>
<td>Q10</td>
</tr>
<tr>
<td>Head 3</td>
<td>0–100</td>
<td>0</td>
<td>Q6</td>
</tr>
<tr>
<td>Head 4</td>
<td>0–100</td>
<td>0</td>
<td>Q2</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
<td>Q15</td>
</tr>
<tr>
<td>Spread</td>
<td>0–100</td>
<td>50</td>
<td>Q11</td>
</tr>
<tr>
<td>Wow &amp; Flutter</td>
<td>0–100</td>
<td>50</td>
<td>Q7</td>
</tr>
</tbody>
</table>

Delay Ping Pong
This stereo delay allows you to set different delay times for its left and right repeats.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time, Left</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Time, Right</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
<td>Q1</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q14</td>
</tr>
</tbody>
</table>
Delay Multi-Tap
This delay is a mono delay which has three delay generators with independently adjustable delay times and stereo position.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
<td>Q13</td>
</tr>
<tr>
<td>Time 1</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q9</td>
</tr>
<tr>
<td>Time 2</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Time 3</td>
<td>2–2000 ms</td>
<td>100</td>
<td>Q1</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
<td>Q14</td>
</tr>
<tr>
<td>Pan 1</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
<tr>
<td>Pan 2</td>
<td>0–100</td>
<td>50</td>
<td>Q6</td>
</tr>
<tr>
<td>Pan 3</td>
<td>0–100</td>
<td>50</td>
<td>Q2</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
<td>Q15</td>
</tr>
<tr>
<td>Gain 1</td>
<td>0–100</td>
<td>25</td>
<td>Q11</td>
</tr>
<tr>
<td>Gain 2</td>
<td>0–100</td>
<td>25</td>
<td>Q7</td>
</tr>
<tr>
<td>Gain 3</td>
<td>0–100</td>
<td>25</td>
<td>Q3</td>
</tr>
</tbody>
</table>
A flanger is a modulated delay to emulate the sound created when running two analog tape machines in parallel with a slight time disalignment. Slow Rate settings can produce a "whooshing" jet engine sound, while faster rates result in more of a "warble."

Options: Flanger and Flanger Sync.

**Flanger**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
<td>Q5</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
<td>Q1</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
<td>Q14</td>
</tr>
</tbody>
</table>

**Flanger Sync**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
<td>Q5</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
<td>Q1</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
<td>Q14</td>
</tr>
</tbody>
</table>
A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added to the dry signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up the Feedback and Depth for more pronounced “shimmering” and “watery” sounds.

Options: Chorus 2-Voice and Chorus 4-Voice.

### Chorus 2-Voice

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
<td>Q9</td>
</tr>
<tr>
<td>Amount</td>
<td>0–100</td>
<td>80</td>
<td>Q5</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
<td>Q1</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q10</td>
</tr>
</tbody>
</table>

### Chorus 4-Voice

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
<td>Q9</td>
</tr>
<tr>
<td>Amount</td>
<td>0–100</td>
<td>80</td>
<td>Q5</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
<td>Q1</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q10</td>
</tr>
</tbody>
</table>
Autopans

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a rotary effect.

Options: *Autopan* and *Autopan Sync*.

### Autopan

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q9</td>
</tr>
</tbody>
</table>

### Autopan Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
<td>Q9</td>
</tr>
</tbody>
</table>
**Tremolos**

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO shape, this can produce a smooth wave effect (sine wave) or a stuttering "on-off" effect (square wave).

**Options:** *Tremolo* and *Tremolo Sync*.

### Tremolo

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q9</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
<td>Q5</td>
</tr>
</tbody>
</table>

### Tremolo Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
<td>Q5</td>
</tr>
</tbody>
</table>
Phasers

The phaser is a classic effect, created by multiple ganged all-pass filters to create "notches," or sharp spikes, in the frequency spectrum. The frequencies of these all-pass filters are usually modulated by an LFO to create a sweeping sound.

**Options:** Phaser 1, Phaser 2, and Phaser Sync.

### Phaser 1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q9</td>
</tr>
</tbody>
</table>

### Phaser 2

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q9</td>
</tr>
</tbody>
</table>

### Phaser Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
<td>Q9</td>
</tr>
</tbody>
</table>
**HP (High-Pass) Filters**

Options: **HP Filter**, **HP Filter Sweep**, **HP Filter Sync**, and **HP Shelving Filter**.

**HP Filter**
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
<td>Q13</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
</tbody>
</table>

**HP Filter Sweep**
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
<td>Q13</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
<td>Q1</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q14</td>
</tr>
</tbody>
</table>
HP Filter Sync
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
<td>Q14</td>
</tr>
</tbody>
</table>

HP Shelving Filter
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
<td>Q13</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q5</td>
</tr>
</tbody>
</table>
LP (Low-Pass) Filters

Options: LP Filter, LP Filter Sweep, LP Filter Sync, and LP Shelving Filter.

LP Filter
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
<td>Q13</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
</tbody>
</table>

LP Filter Sweep
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
<td>Q13</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
<td>Q1</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
<td>Q14</td>
</tr>
</tbody>
</table>
LP Filter Sync
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
<td>Q5</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
<td>Q14</td>
</tr>
</tbody>
</table>

LP Shelving Filter
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
<td>Q13</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q5</td>
</tr>
</tbody>
</table>
Parametric EQs

Options: **PEQ 2-Band, 2-Shelf** and **PEQ 4-Band**.

**PEQ 2-Band, 2-Shelf**
This effect is a combination of one two-band parametric equalizer and two shelving filters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
<td>Q13</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
<td>Q9</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
<td>Q5</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
<td>Q1</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>0</td>
<td>Q10</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>0</td>
<td>Q6</td>
</tr>
<tr>
<td>Low Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q15</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q11</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q7</td>
</tr>
<tr>
<td>High Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q3</td>
</tr>
</tbody>
</table>
**PEQ 4-Band**

This effect is a powerful four-band parametric equalizer with four independent EQ ranges.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
<td>Q13</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
<td>Q9</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
<td>Q5</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
<td>Q1</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>5</td>
<td>Q14</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>5</td>
<td>Q10</td>
</tr>
<tr>
<td>Q3</td>
<td>0–100</td>
<td>5</td>
<td>Q6</td>
</tr>
<tr>
<td>Q4</td>
<td>0–100</td>
<td>5</td>
<td>Q2</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q15</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q11</td>
</tr>
<tr>
<td>Gain 3</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q7</td>
</tr>
<tr>
<td>Gain 4</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q3</td>
</tr>
</tbody>
</table>
Distortions

Options: Distortion Amp, Distortion Fuzz, Distortion Grimey, Distortion Overdrive, and Distortion Custom.

Distortion Amp
This effect is designed to reproduce the sound of a tube amplifier at high volumes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Dynamics</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
</tbody>
</table>

Distortion Fuzz
This popular effect uses hard clipping of the audio signal, which, at extreme settings, can turn a standard waveform into a square wave, producing a "razor" effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Low</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Low-Mid</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
<tr>
<td>High-Mid</td>
<td>0–100</td>
<td>50</td>
<td>Q6</td>
</tr>
<tr>
<td>High</td>
<td>0–100</td>
<td>50</td>
<td>Q2</td>
</tr>
</tbody>
</table>
**Distortion Grimey**
This is a unique distortion effect that distorts a frequency range in a selectable band.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Grime</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
<td>Q6</td>
</tr>
</tbody>
</table>

**Distortion Overdrive**
This distortion is designed to sound like a mildly distorting amplifier at medium volumes. It is the smoothest distortion type available.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
</tbody>
</table>
Distortion Custom
This effect is a highly customized distortion, capable of a wide range of useable sounds.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>+Soft</td>
<td>5–75</td>
<td>2</td>
<td>Q14</td>
</tr>
<tr>
<td>+Clip</td>
<td>5–50</td>
<td>25</td>
<td>Q10</td>
</tr>
<tr>
<td>–Soft</td>
<td>5–75</td>
<td>2</td>
<td>Q6</td>
</tr>
<tr>
<td>–Clip</td>
<td>5–50</td>
<td>25</td>
<td>Q2</td>
</tr>
<tr>
<td>Low</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q15</td>
</tr>
<tr>
<td>Mid</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q11</td>
</tr>
<tr>
<td>High</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
<td>Q7</td>
</tr>
<tr>
<td>Output</td>
<td>-18.0 – 18.0 dB</td>
<td>50</td>
<td>Q3</td>
</tr>
</tbody>
</table>
Compressors

A compressor is an effect that changes the dynamic range of a signal by automatically reducing its gain.

Options: Compressor Master, Compressor Opto, Compressor VCA, and Compressor Vintage.

Compressor Master

This is the most transparent compressor, able to perform substantial volume adjustments without artifacts.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
<td>Q1</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
<td>Q14</td>
</tr>
<tr>
<td>Oldskool</td>
<td>Off, On</td>
<td>Off</td>
<td>Q10</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
<td>Q6</td>
</tr>
</tbody>
</table>
Compressor Opto

The Opto Compressor is modeled after a vintage compressor type using an optical circuit to control the volume reduction of the input signal. These compressors are usually associated with soft and unobtrusive attack and release characteristics.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
<td>Q14</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
<td>Q10</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
<td>Q6</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
<td>Q2</td>
</tr>
</tbody>
</table>
**Compressor VCA**

This compressor is more modern-sounding, with a slightly more transparent sound. A VCA Compressor tends to have quicker attack and release times than an Opto Compressor.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
<td>Q14</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
<td>Q10</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
<td>Q6</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
<td>Q2</td>
</tr>
</tbody>
</table>
Compressor Vintage
This compressor has a sound similar to classic tube compressors, with their gentle yet pumping response and a dash of tube saturation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
<td>Q14</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
<td>Q10</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
<td>Q6</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
<td>Q2</td>
</tr>
</tbody>
</table>
Bit Reducers

Options: Decimator and Resampler.

Decimator
Decimator down-samples the incoming signal by removing bits from the digital signal. The difference between decimation and resampling is that Decimator does not use any filtering to mask or correct digital artifacts. The result is an effect ranging from mild to almost completely pure digital distortion, depending on the setting and the source material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Bit Reducer</td>
<td>4–32</td>
<td>32</td>
<td>Q5</td>
</tr>
</tbody>
</table>

Resampler
Resampler is similar to Decimator in that it removes bits from an incoming signal. The difference is that Resampler applies a complex suite of filters and anti-aliasing to attempt to retain the original sound quality. This is a method used by popular vintage samplers and sampling drum machines from the 1980s. Resampler can be used to achieve a “dirty” sound on drum loops, without the harshness of distortion.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
<td>Q5</td>
</tr>
</tbody>
</table>
Options: **Auto Wah, Frequency Shifter**, and **Transient Shaper**.

**Auto Wah**
This effect is a low-pass filter modulated by an envelope that yields a classic funky "wah-wah"-like sound. The envelope is triggered by the incoming signal's amplitude. The amount of the envelope on the cutoff frequency is user-definable.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>75</td>
<td>Q9</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>30</td>
<td>Q5</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>30</td>
<td>Q1</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
<td>Q14</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>0–100</td>
<td>50</td>
<td>Q10</td>
</tr>
</tbody>
</table>
Frequency Shifter
A frequency shifter changes the frequencies of an input signal by a fixed amount and alters the relationship of the original harmonics. This can produce a chorus-like effect as well as very crazy artificial timbres.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Frequency</td>
<td>-1000 – 1000</td>
<td>0</td>
<td>Q9</td>
</tr>
<tr>
<td>Asynchrony</td>
<td>0–1000</td>
<td>0</td>
<td>Q5</td>
</tr>
<tr>
<td>A Pan</td>
<td>0–100</td>
<td>0</td>
<td>Q14</td>
</tr>
<tr>
<td>B Pan</td>
<td>0–100</td>
<td>100</td>
<td>Q10</td>
</tr>
<tr>
<td>A Gain</td>
<td>0–100</td>
<td>75</td>
<td>Q6</td>
</tr>
<tr>
<td>B Gain</td>
<td>0–100</td>
<td>75</td>
<td>Q2</td>
</tr>
</tbody>
</table>

Transient Shaper
A transient shaper can be used to enhance or soften the Attack and Release phases of audio material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
<th>Q-Link Knob Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
<td>Q13</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
<td>Q9</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
<td>Q5</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
<td>Q1</td>
</tr>
</tbody>
</table>
A lot of the terms in this manual are based on the MPC parameter names. This glossary briefly explains many of the technical terms used throughout.

**Aftertouch**
The majority of contemporary keyboards are capable of generating aftertouch messages. On this type of keyboard, when you press harder on a key you are already holding down, a MIDI Aftertouch message is generated. This feature makes sounds even more expressive (e.g., through vibrato).

**Aliasing**
Aliasing is an audible side effect arising in digital systems as soon as a signal contains harmonics higher than half the sampling frequency.

**Amount**
Describes to which extent a modulation source influences a given parameter.

**Amplifier**
An amplifier is a component that influences the volume level of a sound via a control signal. It can be modulated by a control signal (e.g., generated by an envelope or an LFO).

**Attack**
An envelope parameter. This term describes the ascent rate of a time-relevant process (e.g., an envelope from its starting point to the point where it reaches its highest value). The Attack phase is initiated immediately after a trigger signal is received (e.g., after you play a note on a trigger pad or a keyboard).

**Bit Rate**
Bit rate (also known as **Word Length**), is the number of bits used to store the level information of each single sample slice within a whole sample. The higher the bit rate, the more precise the information about a sample (i.e., its dynamics’ resolution). Normal audio CDs use 16-bit. MPC supports full 24-bit resolution.

**Clipping**
Clipping is a sort of distortion that occurs when a signal exceeds the maximum value that can be handled by a signal processing system it is fed into. The curve of a clipped signal is dependent on the system where the clipping occurs. In the analog domain, clipping effectively limits the signal to a given maximum level. In the digital domain, clipping is similar to a numerical overflow, resulting in negative polarity of the signal’s portions exceeding the maximum level.
Control Change (Controllers)

MIDI messages enable you to manipulate the behavior of a sound generator to a significant degree. This message essentially consists of two components:

- The controller number, which defines the parameter to be influenced. It can range from 0 to 127.
- The controller value, which determines the extent of the modification.

Controllers can be used for effects such as slowly swelling vibrato, changing the stereo panning position and influencing filter frequency.

Cutoff

The cutoff frequency is a significant factor for filters. A low-pass filter for example dampens the portion of the signal that lies above this frequency. Frequencies below this value are allowed to pass through without being processed.

Decay

Decay describes the descent rate of an envelope once the Attack phase has reached its maximum and the envelope drops to the level defined by the Sustain value.

Envelope

An envelope is used to modulate a sound-shaping component within a given time. For instance, an envelope that modulates the cutoff frequency of a filter opens and closes this filter over a period of time. An envelope is started via a trigger, usually a MIDI Note. The classic ADSR envelope consists of four individually variable phases: Attack, Decay, Sustain, and Release. Attack, Decay and Release are time or slope values, while Sustain is an adjustable level. Once an incoming trigger is received, the envelope runs through the Attack and Decay phases until it reaches the programmed Sustain level. This level remains constant until the trigger is terminated. The envelope then initiates the Release phase until it reaches the minimum value.

Filter

A filter is a component that allows some of a signal’s frequencies to pass through it and dampens other frequencies. The most important aspect of a filter is the filter cutoff frequency. Filters generally come in four categories: low-pass, high-pass, band-pass, and band-stop. A low-pass filter dampens all frequencies above the cutoff frequency. A high-pass filter in turn dampens the frequencies below the cutoff. The band-pass filter allows only those frequencies around the cutoff frequency to pass; all others are dampened. A band-stop filter does just the opposite; it dampens only the frequencies around the cutoff frequency. The most common type is the low-pass filter.
LFO

**LFO** is an acronym for **low-frequency oscillator**. The LFO generates a periodic oscillation at a low frequency and features variable waveshapes. Similar to an envelope, an LFO can be used to modulate a sound-shaping component.

MIDI

**MIDI** stands for **musical instrument digital interface**. Developed in the early 1980s, MIDI enables interaction between various types of electronic music instruments from different manufacturers. At the time a communications standard for heterogeneous devices did not exist, so MIDI was a significant advance. It made it possible to link various devices with one another through simple, standardized connectors.

Essentially, this is how MIDI works: One sender is connected to one or several receivers. For instance, if you want to use a computer to play a MIDI synthesizer, the computer is the sender and the synthesizer acts as the receiver. With a few exceptions, the majority of MIDI devices are equipped with two or three ports for this purpose: MIDI In, MIDI Out and in some cases MIDI Thru. The sender transfers data to the receiver via the MIDI Out jack. Data are sent via a cable to the receiver’s MIDI In jack.

MIDI Thru has a special function. It allows the sender to transmit to several receivers. It routes the incoming signal to the next device without modifying it. Another device is simply connected to this jack, thus creating a chain through which the sender can address a number of receivers. Of course it is desirable for the sender to be able to address each device individually. To achieve this, a MIDI channel message is sent with each MIDI event.

**MIDI Channel**

This is a very important element of most messages. A receiver can only respond to incoming messages if its receive channel is set to the same channel as the one the sender is using to transmit data. Subsequently, the sender can address specific receivers individually. MIDI Channels 1 through 16 are available for this purpose.

**MIDI Clock**

The MIDI Clock message transmits real-time tempo information to synchronize processes among several connected devices (e.g., a sound generator’s delay time to a MIDI sequencer).

**Modulation**

A modulation influences or changes a sound-shaping component via a modulation source. Modulation sources include envelopes, LFOs or MIDI messages. The modulation destination is a sound-shaping component such as a filter or a VCA.
Note On and Note Off
This is the most important MIDI message. It determines the pitch and velocity of a generated note. A Note On message will start a note. Its pitch is derived from the note number, which can range from 0 to 127. The velocity lies between 1 and 127. A velocity value of 0 is equivalent to a Note Off message.

Normalize
Normalization is a function to raise the level of a sample to its maximum (0 dB) without causing distortion. This function automatically searches a sample for its maximum level and consequently raises the entire sample’s level until the previously determined maximum level reaches 0 dB. In general this results in a higher overall volume of the sample.

Panning
The process or the result of changing a signal’s position within the stereo panorama.

Pitchbend
Pitchbend is a MIDI message. Although pitchbend messages are similar in function to control change messages, they are a distinct type of message. The resolution of a pitchbend message is substantially higher than that of a conventional Controller message. The human ear is exceptionally sensitive to deviations in pitch, so the higher resolution is used because it relays pitchbend information more accurately.

Program
A Program is a file that contains a list of all samples to be used, and settings for each sample (e.g., pad assignments, loop points, pitch tuning, effects, etc.) MPC’s Program Edit Mode is where you can edit and assign samples. The software can have a total of 128 Programs in a Project.

There are two kinds of Programs that use samples for their sound source: Drum Programs, mostly used for creating Drum Programs and easy and quick assigning of samples to a pad, and Keygroups Programs. With Keygroup Programs, you can use one sample (or more) and spread it across two or more keys and play the sample chromatically over a keyboard. That way, there is no need to sample every key of, for instance, a piano.

Program Change
These are MIDI messages that select sound Programs. Program numbers 1 through 128 can be changed via program change messages.
**Release**
An envelope parameter. This term describes the descent rate of an envelope to its minimum value after a trigger is terminated. The Release phase begins immediately after the trigger is terminated, regardless of the envelope’s current status. For instance, the Release phase may be initiated during the Attack phase.

**Resonance**
Resonance or emphasis is an important filter parameter. It emphasizes the frequencies around the filter cutoff frequency by amplifying them with a narrow bandwidth. This is one of the most popular methods of manipulating sounds. If you increase the emphasis to a level where the filter enters a state of self-oscillation, it will generate a relatively pure sine waveform.

**Root Key**
The root key defines the original pitch of a recorded instrument or of a sample. Samples in the software contain the dedicated root key information. This information will be created automatically during recording or importing.

**Sample**
When you tap the pads on your MPC hardware, you can trigger sounds that we call samples. Samples are digitized snippets of audio that can either be recorded using the recording function of your MPC software or loaded from the File Browser.

Once a sample is present in the software, it can be manipulated in different ways. For example, a sample can be trimmed, looped, pitch-shifted or processed, using various effects offered by the software. When you have finished editing your sample, you can assign it to one or more drum pads to play it. Samples can be either mono or stereo.

**Sample Rate**
This is the frequency representing the amount of individual digital sample scans per second that are taken to capture an analog signal digitally. For normal CD audio recordings, 44100 samples per second are used, also written as 44.1 kHz. The software offers sampling rates up to 96 kHz.

**Sequence**
A Sequence is the most basic building-block of music you can compose on the software. MIDI information from your MPC hardware’s pads, buttons, and Q-Link Knobs (or an external keyboard) are recorded to the Tracks of a Sequence. Each Sequence has 64 Tracks. The software can hold up to 128 separate Sequences at the same time.

The length of a Sequence can be set from 1 to 999 bars, which would be enough to create an entire Song using only one Sequence. However, the software has a dedicated Song Mode that lets you chain Sequences together to create a Song.
### Song
The software has a special Song Mode that allows you to arrange different sections (verse, chorus, hook, etc.) in order to build a Song. Each Song can have up to 250 parts and the software can hold 20 Songs in its memory.

### Sustain
This term describes the level of an envelope remaining constant after it has passed the Attack and Decay phases. Once reached, the Sustain level is kept until the trigger is terminated.

### Track
A Sequence offers 64 Tracks and each Track can record notes and controller data. For example, you can record the verses of a Song on Track 1, while recording the choruses on Track 2. Alternatively, you can record different instruments on each Track.

Note that your performances are recorded as MIDI events and the actual digital audio is not recorded onto a Track. That way, you can edit your performance in many different ways once the performance has been captured.

### Trigger
A trigger is a signal that initiates events. Trigger signals are very diverse. For instance, a MIDI note or an audio signal can be used as a trigger. The events a trigger can initiate are also very diverse. A common application for a trigger is its use to start an envelope.
Trademarks and Licenses

Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other countries.
AAX and RTAS are trademarks or registered trademarks of Avid Technology, Inc. in the U.S. and other countries.
ASIO, Cubase, and VST are trademarks of Steinberg Media Technologies GmbH.
Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
All other product or company names are trademarks or registered trademarks of their respective owners.
Addendum for MPC v1.8

This chapter is an addendum that explains new features and improvements in MPC v1.8. We also updated certain sections of the earlier pages of the User Guide to correct previous errors.

Some of the most important new features include how MPC handles sample recording, editing, and playback. Please read through this section for a brief overview of how this works.

MPC 1.8 greatly expands your sample editing capabilities with two versions of non-destructive slices: non-destructive chop slices and pad slices:

- **Non-Destructive Chop Slices:** In MPC, these slices are regions of an audio file. Once you add some slice markers to a sample in Chop Mode (in Sample Edit Mode) and save your Project, those slice markers are saved into the Project’s sample. You can use that sample in any other MPC Project and the sample will retain those slices.

You can assign slices to multiple Drum Programs. If you change its slice markers, it will affect any pad that is set to play the corresponding slice. Above, changing Slice 2’s start point, end point, or loop point will affect both Drum Programs as both of them have a pad assigned to play Slice 2. Learn more about this feature in this addendum’s **Sample Edit Mode > Chop Mode** and **Program Edit Mode > Layer Section** chapters.
• **Pad Slices**: Pad slices are different from non-destructive chop slices. While editing a Drum Program in Program Edit Mode, a pad layer whose Slice menu is set to Pad has its own Pad Start point, Pad End point, and Pad Loop point (if activated) that are stored in the pad. This way, multiple pads can play different regions of the same sample.

Again, a pad slice’s Pad Start point, Pad End point, and Pad Loop point aren’t stored in the sample; they’re stored in a pad’s parameters as part of the Program. Because of this, changing those points for one pad will never affect another pad, even one with similar or identical settings. In contrast to non-destructive chop slices, pad slices let you make independent changes to each pad’s sound without affecting the rest of the Program or Project. Learn more about these pad parameters in this addendum’s Program Edit Mode > Layer Section chapter.

**Tip**: To quickly set multiple pads to play pad slices of the same sample, copy a pad (with its Slice menu set to Pad) to others, and then adjust the Pad Start point and Pad End point of each copied pad.

Furthermore, because the start and end points are stored in a pad rather than the sample itself, you’ll find that the easiest way to edit your pad slices is in the new Program Mode of Sample Edit Mode. Learn more in this addendum’s Sample Edit Mode > Program Mode chapter.
Furthermore, **Sample Record Mode** now features as looper so you can create your own samples on the fly. And a new **Pad Perform Mode** lets you easily use the pads (in a Keygroup Program) to play notes or chords within a musical scale or key.

Please see the *Table of Contents: Addendum for MPC v1.8* to learn more about the additions and improvements in 1.8.
# Table of Contents: Addendum for MPC v1.8

New Features in MPC v1.8

- General..................................................................................................................286
  - Software Navigation ......................................................................................286
  - Hardware Display Navigation ......................................................................287
  - Pad Keys ........................................................................................................288
  - Project Preview .............................................................................................289

- Main Mode..........................................................................................................290
  - Sequence and Track Options ......................................................................290
  - Sequence and Track Editing .........................................................................290

- Program Edit Mode..............................................................................................306
  - Master Section ..............................................................................................306
  - Layer Section .................................................................................................307

- Sample Record Mode..........................................................................................312
  - General ........................................................................................................312
  - Looper ...........................................................................................................312
New Features in MPC v1.8

General

Software Navigation

You can now deselect samples in Project Information. To do this, press and hold your computer keyboard’s Ctrl (Windows) or ⌘ (Mac OS X) key and click the sample.

You can now use your computer’s cursor keys to move through the Project Information.

You can now move the MPC software window by clicking and dragging any empty space in the Transport Section.
Hardware Display Navigation

**Hardware:** When a tab shows multiple pages (e.g., the *Send* or *Insert* tab of Program Mixer Mode), you can now cycle backward through the tabs instead of only forward. To do this, press and hold **Shift** and press the **Function Button** under the tab.

<table>
<thead>
<tr>
<th>Program</th>
<th>Send</th>
<th>Track 01 - Track 06</th>
</tr>
</thead>
<tbody>
<tr>
<td>First 1</td>
<td>2001</td>
<td>2002</td>
</tr>
<tr>
<td>Second 1</td>
<td>2007</td>
<td>2008</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
<td>Mute</td>
</tr>
</tbody>
</table>

Second page of *Send* tab in Program Mixer Mode in the MPC hardware display.

**Hardware:** Some screens of the display have a second bank of buttons at the bottom of the screen (corresponding to the **Function Buttons**). Press and hold **Shift** to see them.

<table>
<thead>
<tr>
<th>Sample (Sample Edit Mode)</th>
<th>Line ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start 1</td>
<td>End 17</td>
</tr>
<tr>
<td>Level</td>
<td>Mute</td>
</tr>
<tr>
<td>Trim</td>
<td>Program</td>
</tr>
</tbody>
</table>

First bank of buttons in Sample Edit Mode in the MPC hardware display.

After pressing **Shift+F4 (Send):** First page of *Send* tab in Sample Edit Mode in the MPC hardware display.

<table>
<thead>
<tr>
<th>Sample (Sample Edit Mode)</th>
<th>Line ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start 1</td>
<td>End 17</td>
</tr>
<tr>
<td>Level</td>
<td>Mute</td>
</tr>
<tr>
<td>Trim</td>
<td>Program</td>
</tr>
</tbody>
</table>

Second bank of buttons in Sample Edit Mode in the MPC hardware display.
Pad Keys

Pad Keys now enables the use your computer keyboard to play the 16 pads of the current pad bank.

To enable or disable Pad Keys, click the Tools menu and select Pad Keys. Alternatively, press Alt+Shift+W (Windows) or Option+Shift+W (Mac OS X).

On a standard US/American computer keyboard, use the keys as follows:

- the Z, X, C, and V keys play Pads 01, 02, 03, and 04
- the A, S, D, and F keys play Pads 05, 06, 07, and 08
- the Q, W, E, and R keys play Pads 09, 10, 11, and 12
- the 1, 2, 3, and 4 keys play Pads 13, 14, 15, and 16

**Note:** Enabling Pad Keys automatically disables MIDI Keys.
Project Preview

You can now export a Sequence or Project as a Project Preview. Selecting this type of file (or a Project with an associated Project Preview file) in the software's Browser will automatically play it just as a sample would do when Auto Preview is selected.

To export a Project Preview:
1. Click the File menu, and select Export.
2. Select As Audio Mixdown.
3. In the Audio Mixdown window that appears, set the Audio Length, File format, Bit depth, and Sample rate as you normally would.
4. Set the check the Save as project preview box. This will automatically set the Render source to Stereo output (you can click its drop-down menu to select the desired output). This will also automatically set the Render options to Master inserts (you can click it to deselect it) and disable Export returns.
5. Click Export or Cancel to confirm your choice.
Main Mode

Sequence and Track Options

To open the Sequence or Track drop-down menus, you can now click once anywhere on the menu (as opposed to just the downward arrow, ▼).

To rename a Sequence or Track, double-click the drop-down menu.

Sequence and Track Editing

You can now edit the current Sequence by doing either of the following:
  o In any mode, click the Edit menu and select Sequence.
  o In Main Mode or Step Sequence Mode, right-click the Sequence drop-down menu in the Sequence section. (This menu contains fewer options than the Edit menu.)

The available processes are:

- Clear
- Insert Blank Bars
- Copy Sequence
- Export
- Delete Bars
- Copy Track
- HalfLength
- Copy Bars
- Transpose
- Double Length
- Copy Events
- Erase
Clear: This will erase all pad events from the Sequence and reset all of its settings.

Hardware: To edit the current Sequence:
1. Use the Cursor Buttons to select the Seq field.
2. Press Window to open the Edit Current Sequence window.
3. Press F2 (Clear) to erase all pad events from the Sequence and reset all of its settings. Press F4 (Do It) or F5 (Cancel) to confirm your choice.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier User Guide.)

Export: This lets you export the Sequence as a standard MIDI file (.mid). In the window that appears, enter a file name and set the save location. This option is useful when you want to import your Sequences into separate sequencer software or exchange your Sequences with another artist. This is the same as clicking the File menu, selecting Export, and selecting As MIDI File.
**Half Length:** This will delete the second half of the Sequence.

**Double Length:** This will double the Sequence and copy all events from the first half to the second half.

**Hardware:** To edit the current Sequence:

1. Use the **Cursor Buttons** to select the **Seq** field.
2. Press **Window** to open the **Edit Current Sequence** window.
3. Press **F3 (Double)** to double the Sequence and copy all events from the first half to the second half.

The **Edit Current Sequence** window in the MPC hardware display.
Insert Blank Bars: This lets you add empty bars to a Sequence at a specified point, which you can set in the Insert Blank Bars window that appears.

Click Do It to confirm your choice or Cancel to cancel the operation.

- **Sequence**: Click this drop-down menu and select the desired Sequence.
- **Number of Bars**: Click and drag this field up or down to set how many bars you want to add.
- **Time Sig**: Click and drag these fields up or down to set the desired time signature of the bars you want to add.
- **Before Bar**: Click and drag this field up or down to set the bar of the Sequence before which you want to add the blank bars.

**Hardware**: To add empty bars to a Sequence at a specified point:

1. Press Seq Edit to open the Edit Sequence window.
2. Press Pad 01 (Insert Blank Bars) to open the Insert Blank Bars window.
3. Use the Cursor Buttons to select the desired field and use the Data Dial or +/- buttons to adjust them.
   - **Sequence**: Use this field to select the desired Sequence.
   - **Number of Bars**: Use this field to set how many bars you want to add.
   - **Time Sig**: Use these fields to set the desired time signature of the bars you want to add.
   - **Before Bar**: Use this field to set the bar of the Sequence before which you want to add the blank bars.
4. Press F5 (Do It) to confirm your choice or F4 (Back) to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier User Guide.)
**Delete Bars:** This lets you remove a range of bars from a Sequence, which you can set in the **Delete Bars** window that appears.

Click the **Sequence** drop-down menu to select the desired Sequence. Click and drag the **First Bar** and **Last Bar** fields up or down to set the range of bars you want to delete.

Click **Do It** to confirm your choice or **Cancel** to cancel the operation.

**Hardware:** To remove a range of bars from a Sequence:

1. Press **Seq Edit** to open the **Edit Sequence** window.
2. Press **Pad 02 (Delete Bars)** to open the **Delete Bars** window.
3. Use the **Cursor Buttons** to select the desired field and use the **Data Dial** or **+/− buttons** to adjust them.
   - **Sequence:** Use this field to select the desired Sequence.
   - **First Bar / Last Bar:** Use these fields to set the range of bars you want to delete.
4. Press **F5 (Do It)** to confirm your choice or **F4 (Back)** to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier *User Guide*.)
Copy Bars: This lets you copy a range of bars from a Sequence and add them to another at a specified point, which you can set in the Copy Bars window that appears.

Click: **Replace** to overwrite the designated bars of the destination Sequence; **Merge** to add the copied events to the designated bars of the destination Sequence without erasing anything; or **Cancel** to cancel the operation.

- **Copy Bars From:**
  - **Sequence:** Click this drop-down menu and select the "source" Sequence.
  - **First Bar / Last Bar:** Click and drag these fields up or down to set the range of bars you want to copy.

- **Copy Bars To:**
  - **Sequence:** Click this drop-down menu and select the "destination" Sequence.
  - **After Bar:** Click and drag this field up or down to set the bar of the Sequence after which you want to add the copied bars.
  - **Copies:** Click and drag this field up or down to select how many instances of the copied bars you want to add.

**Hardware:** To copy a range of bars of a Sequence and add them to another at a specified point:

1. Press **Seq Edit** to open the **Edit Sequence** window.
2. Press **Pad 03 (Copy Bars)** to open the **Copy Bars From** window.
3. Use the **Cursor Buttons** to select the desired field and use the **Data Dial** or **–/+** buttons to adjust them.

The **Copy Bars** window in the MPC hardware display.
**Copy Bars From: Sequence:** Use this field to select the "source" Sequence.

**First Bar / Last Bar:** Use these fields to set the range of bars you want to delete.

**Copy Bars To: Sequence:** Use this field to select the "destination" Sequence.

**After Bar:** Use this field to set the bar of the Sequence after which you want to add the copied bars.

**Copies:** Use this field to set how many instances of the copied bars you want to add.

4. Press: **F4 (Replace)** to overwrite the designated bars of the destination Sequence; **F5 (Merge)** to add the copied events to the designated bars of the destination Sequence without erasing anything; or **F3 (Back)** to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier *User Guide.*)
Copy Events: This lets you copy a range of events from a Sequence and add them to another at a specified point, which you can set in the Copy Events window that appears.

Click: Replace to overwrite the designated time range of the destination Sequence; Merge to add the copied events to the designated time range of the destination Sequence without erasing anything; or Cancel to cancel the operation.

- Copy Events From:
  - **Sequence**: Click this drop-down menu and select the "source" Sequence.
  - **Track**: Click this drop-down menu and select the Track containing the "source" Sequence.
  - **Time / To**: Click and drag these fields up or down to set the time range (in bars: beats: ticks) of the "source" Sequence. Alternatively, double-click the field and type in a number.

- Copy Events To:
  - **Sequence**: Click this drop-down menu and select the "destination" Sequence.
  - **Track**: Click this drop-down menu and select the Track containing the "destination" Sequence.
  - **To**: Click and drag these fields up or down to set the point (in bars: beats: ticks) in the "destination" Sequence after which you want to add the copied events. Alternatively, double-click the field and type in a number.
  - **Copies**: Click and drag this field up or down to select how many instances of the copied events you want to add.

Hardware: To copy a range of events from a Sequence and add them to another at a specified point:
1. Press Seq Edit to open the Edit Sequence window.
2. Press Pad 04 (Copy Events) to open the Copy Events From window.
3. Use the Cursor Buttons to select the desired field and use the Data Dial or +/- buttons to adjust them.
The Copy Events From window in the MPC hardware display.

- **Copy Events From: Sequence**: Use this field to select the "source" Sequence.
- **Copy Events From: Track**: Use this field to select the Track containing the "source" Sequence.
- **Time / To**: Use these fields to set the time range (in bars: beats: ticks) of the "source" Sequence.
- **Copy Events To: Sequence**: Use this field to select the "destination" Sequence.
- **To**: Use this field to set the point (in bars: beats: ticks) in the "destination" Sequence after which you want to add the copied events.
- **Copies**: Use this field to set how many instances of the copied events you want to add.

4. Press: **F4 (Replace)** to overwrite the designated time range of the destination Sequence; **F5 (Merge)** to add the copied events to the designated time range of the destination Sequence without erasing anything; or **F3 (Back)** to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier User Guide.)
Copy Sequence: This lets you copy the contents of one Sequence to another, which you can set in the Copy Sequence window that appears.

Click the Copy Contents of Sequence drop-down menu to select the "source" Sequence, and click the Over Contents of Sequence drop-down menu to select the "destination" Sequence.

Click Do It to confirm your choice or Cancel to cancel the operation.

Hardware: To copy the contents of one Sequence to another:
1. Press Seq Edit to open the Edit Sequence window.
2. Press Pad 05 (Copy a Sequence) to open the Copy Sequence window.
3. Use the Cursor Buttons to select the desired field and use the Data Dial or +/- buttons to adjust them.

   Copy Contents of Sequence: Use this field to select the "source" Sequence.
   Over Contents of Sequence: Use this field to select the "destination" Sequence.

4. Press F5 (Do It) to confirm your choice or F4 (Back) to cancel the operation.

The Edit Current Sequence window in the MPC hardware display.
Alternatively:
1. Use the Cursor Buttons to select the Seq field.
2. Press Window to open the Edit Current Sequence window.
4. Use the Cursor Buttons to select the desired field and use the Data Dial or +/- buttons to adjust them.
   - **Copy Contents of Sequence**: Use this field to select the "source" Sequence.
   - **Over Contents of Sequence**: Use this field to select the "destination" Sequence.
5. Press F5 (Do It) to confirm your choice or F4 (Back) to cancel the operation.

(These functions on your MPC hardware have existed in earlier releases but were not described in the earlier User Guide.)

The **Edit Current Sequence** window in the MPC hardware display.
**Copy Track:** This lets you copy the contents of one Track to another, which you can set in the **Copy Track** window that appears.

Click the **Copy Contents of Track** drop-down menu to select the "source" Track, and click the **Over Contents of Track** drop-down menu to select the "destination" Track.

Click **Do It** to confirm your choice or **Cancel** to cancel the operation.

**Hardware:** To copy the contents of one Track to another:

1. Press **Seq Edit** to open the **Edit Sequence** window.
2. Press Pad 08 (**Copy Track**) to open the **Copy Track** window.
3. Use the **Cursor Buttons** to select the desired field and use the **Data Dial** or +/- buttons to adjust them.
   - **Copy Contents of Track:** Use this field to select the "source" Track.
   - **Over Contents of Track:** Use this field to select the "destination" Track.
4. Press **F5 (Do It)** to confirm your choice or **F4 (Back)** to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier **User Guide**.)
Transpose: This lets you transpose a range of events in a Sequence on a Track, which you can set in the **Transpose Events** window that appears. The events within the specified range will be shifted accordingly within the grid. Click **Do It** to confirm your choice or **Cancel** to cancel the operation.

- **Sequence:** Click this drop-down menu and select the desired Sequence.
- **Track:** Click this drop-down menu and select the Track containing the desired Sequence.
- **Time / To:** Click and drag these fields up or down to set the time range (in bars: beats: ticks) of the events in the desired Sequence. Alternatively, double-click the field and type in a number.
- **From Pad / To Pad** (for Drum Programs): Click and drag these fields up or down to set the “source” pad (whose events you want to move) and the “destination” pad (where the events will be placed).
- **Range** (for Keygroup Programs, MIDI Programs, and Plugin Programs): Click and drag these fields up or down to set the range of notes of the events you want to transpose. Events within this note range will be transposed while events outside of this range will remain unchanged.
- **Transpose** (for Keygroup Programs, MIDI Programs, and Plugin Programs): Click and drag this field up or down to set how many semitones up or down you want to transpose the events.

**Hardware:** To transpose the current Sequence:

1. Press **Seq Edit** to open the **Edit Sequence** window.
2. Press **Pad 06 (Transpose)** to open the **Transpose** window.
3. Use the **Cursor Buttons** to select the desired field and use the **Data Dial** or **–/+** buttons to adjust them. For numeric values, you can also use the **numeric keypad** to type in a value. For pad numbers, you can simply press the desired pad.
Sequence: Use this field to select the desired Sequence.

Track: Use this field to select the Track containing the desired Sequence.

Time / To: Use these fields to set the time range (in bars: beats: ticks) of the events in the
desired Sequence.

From Pad / To Pad (for Drum Programs): Use these fields to set the "source" pad (whose events
you want to move) and the "destination" pad (where the events will be placed). You can press
the desired pad when the field is selected.

Range (for Keygroup Programs, MIDI Programs, and Plugin Programs): Use these fields to set the
range of notes of the events you want to transpose. Events within this note range will be
transposed while events outside of this range will remain unchanged.

Transpose (for Keygroup Programs, MIDI Programs, and Plugin Programs): Use this field to set
how many semitones up or down you want to transpose the events.

4. Press F5 (Do It) to confirm your choice or F4 (Back) to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier
User Guide.)
Erase: This lets you erase all or part of a Sequence on a specific Track, which you can set in the **Erase** window that appears.

Click **Do It** to confirm your choice or **Cancel** to cancel the operation.

- **Sequence**: Click this drop-down menu and select the desired Sequence.
- **Track**: Click this drop-down menu and select the Track containing the desired Sequence.
- **Time / To**: Click and drag these fields up or down to set the time range (in bars: beats: ticks) of the desired Sequence. Alternatively, double-click the field and type in a number.
- **Erase**: Click this drop-down menu and select one of these options:
  - **All** erases all pad events from the designated time range and reset all of its settings.
  - **Note** erases only specific pad events from the designated time range. In the diagram of the eight pad banks that appears, click each pad to select or deselect its notes.
  - **Except Note** erases everything except pad events from the designated time range.

**Hardware**: To erase the current Sequence:

1. Press **Seq Edit** to open the **Edit Sequence** window.
2. Press **Pad 07 (Erase)** to open the **Erase** window.
3. Use the **Cursor Buttons** to select the desired field and use the **Data Dial** or **–/+** buttons to adjust them. For numeric values, you can also use the **numeric keypad** to type in a value.

The **Erase** window in the MPC hardware display.
**Sequence:** Use this field to select the desired Sequence.

**Track:** Use this field to select the Track containing the desired Sequence.

**Time / To:** Use these fields to set the time range (in bars: beats: ticks) of the desired Sequence.

**Erase:** Use this field to select one of these options:

- **All** erases all pad events from the designated time range and reset all of its settings.
- **Note** erases only specific pad events from the designated time range. Press the pads whose events you want to erase to select or deselect them (their numbers will appear in the Pads field).
- **Except Note** erases everything except pad events from the designated time range.

4. Press **F5 (Do It)** to confirm your choice or **F4 (Back)** to cancel the operation.

(This function on your MPC hardware has existed in earlier releases but was not described in the earlier User Guide.)
Program Edit Mode

Master Section
The Master Section now has knobs to control the pad’s Level and Pan. These affect the entire pad. Click and drag them up or down to adjust them.

Hardware: In the Master tab, there are now options for Pad Level and Pad Pan. Use Q-Link Knobs Q10 and Q11 to adjust their respective values. Alternatively, use the Cursor Buttons to select the desired field and use the Data Dial or +/- buttons to adjust them, or use the numeric keypad to type in a value.

The Master tab (with Level and Pan controls) in Program Edit Mode in the MPC hardware display.
Layer Section

There are several new settings in the Layer section that affect how the sample plays when you trigger its pad. Click the All tab (with the "list-and-arrow" icon) to show all of them simultaneously. Alternatively, click Tab 1, 2, 3, or 4 to show a set of the new settings next to the Sample drop-down menu for each layer. Tab 1 contains the original Semi, Fine, and Level knobs while Tabs 2–4 contain the new settings’ controls.

**Important:** Please note that these new controls do not change the sample itself; all changes are non-destructive. This is due to how MPC 1.8 handles sample editing and playback:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the pad/layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice number in the original sample. Playing that pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have to clutter your Project with a new sample for every slice (though you can still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead of the slice number), and the Pad Start and Pad End points will correspond to the slice markers in the original sample.

![Layer Section Diagram](image-url)
• **Slice:** Click this drop-down menu to select what part(s) of the sample will play:
  o **All:** The entire sample will play.
  o **Pad:** The sample will play from the **Pad Start** position to the **Pad End** position, described below. This also lets you activate **Pad Loop**.
  o **Slice 1, 2, 3, etc.:** If you have sliced the sample in Chop Mode, you can select which slice will play when you trigger the pad.

• **Dir:** Click this drop-down menu to select in which direction the sample will play:
  o **Fwd:** The sample will play in the normal forward direction.
  o **Rev:** The sample will play in reverse.

• **Offset:** Click and drag this field up or down to determine a time offset for the sample's playback. Alternatively, double-click the field and type in a number.
  o **Positive values** (right of center): When the pad is played, playback will start immediately but at a later point in the sample specified by the offset value.
  o **Negative values** (left of center): When the pad is played, playback will be delayed by the amount specified by the offset value.
• **Pad Start:** Click and drag this field up or down to determine the position (in samples) where the pad’s playback will start. Alternatively, double-click the field and type in a number. The minimum value is 0, and the maximum value is the **Pad End** value.

• **Pad End:** Click and drag this field up or down to determine the position (in samples) where the pad’s playback will stop. Alternatively, double-click the field and type in a number. The minimum value is the **Pad Start** value, and the maximum value is the sample’s total length (in samples).

• **Pad Loop:** Click this box to activate or deactivate Pad Loop. When activated, you can hold down the pad to cause that sample to repeat from the Loop Position (**Loop Pos**) to the end of the sample. Release the pad to stop the repeating playback.

  **Important:** For Pad Loop to work, you must set **Sample Play** (in the Pad Play Modes section) to **Note On** instead of **One Shot**.

• **Loop Pos** (position): Click and drag this field up or down to determine the position (in samples) where the pad’s playback will repeat when Pad Loop is activated. Alternatively, double-click the field and type in a number.
Hardware: There are several new settings in the Samples tab that affect how the sample plays when you trigger its pad.

To edit the new Samples settings:
1. Press Prog Edit to enter Program Edit Mode.
2. Press F2 (Samples) to select the Samples tab.

Press F2 to cycle through the available four pages of the tab.

Use the Cursor Buttons to select a parameter. Use the Data Dial or +/- buttons to adjust the parameter value:

Slice: This determines what part(s) of the sample will play:
- All: The entire sample will play.
- Pad: The sample will play from the Pad Start position to the Pad End position, described below. This also lets you activate Pad Loop.
- Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you trigger the pad.

Dir: This determines which direction the sample will play:
- Fwd: The sample will play in the normal forward direction.
- Rev: The sample will play in reverse.

Offset: This determines a time offset for the sample's playback.

Positive values: When the pad is played, playback will start immediately but at a later point in the sample specified by the offset value.

Negative values: When the pad is played, playback will be delayed by the amount specified by the offset value.
Pad Start: This determines the position (in samples) where the pad’s playback will start. The minimum value is 0, and the maximum value is the Pad End value.

Pad End: This determines the position (in samples) where the pad’s playback will stop. The minimum value is the Pad Start value, and the maximum value is the sample’s total length (in samples).

Pad Loop: This activates or deactivates Pad Loop. When On, you can hold down the pad to cause that sample to repeat from the Loop Position (Loop Pos) to the end of the sample. Release the pad to stop the repeating playback. This option is disabled (–) if Slice is not set to Pad.

For Pad Loop to work, you must set the Sample field (in the Lfo Mod tab (F5)) to NoteOn instead of OneSh (One Shot).

Pad Loop Pos: Click and drag this field up or down to determine the position (in samples) where the pad’s playback will repeat when Pad Loop is activated.
Sample Record Mode

General

Input insert effects now allow you to apply effects to incoming audio. You can do this while recording samples and while recording with the looper.

You can also choose to record samples as mono audio or stereo audio. To select mono or stereo recording, click the (mono) or (stereo) button under the insert effect slots.

**Tip:** Use this to send a mono audio source through a stereo plugin as a mono signal, and then record the plugin’s output as a stereo signal.

Looper

Sample Record Mode now has a built-in looper, letting you record and overdub in real time. You can also export the loop as a sample for use in your project.
To switch between the looper and the normal sampler, click **Looper** or **Sampler** above the Q-Link Knobs.

**Hardware:** To switch between the looper and the normal sampler, press F1 (**Sampler** or **Looper**).

To set the length of your loop, click and drag the **Num Bars** field up or down.

**Hardware:** To set the length of your loop, use the **Cursor Buttons** to select the **Bars** field, and use the **Data Dial** or **-/+** buttons to adjust the value. Alternatively, use the numeric keypad to enter a value.

The **Looper** tab in **Sample Record Mode** in the MPC hardware display.
To set the loop recording behavior, click the **Rec Loop** drop-down menu and select **Play** or **Overdub**.

- **Play**: When you start recording a loop, the looper will record the incoming audio signal during the first time through the loop. After that (when the loop repeats), the loop will play back without recording.

- **Overdub**: When you start recording a loop, the looper will record the incoming audio signal every time the loop plays, including when the loop repeats, overdubbing it onto the existing loop.

**Hardware**: To set the length of your loop, use the **Cursor Buttons** to select the **Rec To** field, and use the **Data Dial** or +/- buttons to select **Play** or **Over**:

- **Play**: When you start recording a loop, the looper will record the incoming audio signal during the first time through the loop. After that (when the loop repeats), the loop will play back without recording.

- **Over**: When you start recording a loop, the looper will record the incoming audio signal every time the loop plays, including when the loop repeats, overdubbing it onto the existing loop.

To sync or unsync the looper with Sequence playback, click **Seq Sync**. When Seq Sync is on, the looper will stay in step with your current Sequence. When you play or record into the looper, it will wait until the Sequence starts playing **Bar 1** again to start.

**Hardware**: To sync or unsync the looper with Sequence playback, use the **Cursor Buttons** to select the **Sync** field, and use the **Data Dial** or +/- buttons to select **On** or **Off**. When Sync is on, the looper will stay in step with your current Sequence. When you play or record into the looper, it will wait until the Sequence starts playing **Bar 1** again to start.
To start recording a loop:

- If **Seq Sync** is on, click **Record** in the **Looper** section to record-arm the looper. To start recording, click the software transport section’s **Play** button. To erase the recording, click **Clear**.

- If **Seq Sync** is off, click **Record** in the **Looper** section. Recording will start immediately.

**Important:** When **+Overdub** is on, the looper will record without erasing any audio you’ve already recorded in the loop. When **Replace** is on, the looper will record and overwrite any audio you’ve already recorded in the loop.

**Hardware:** To start recording a loop:

- If **Sync** is On, press F6 (**Record**) to record-arm the looper. To start recording, press the **Play** button on your hardware’s transport control. To erase the recording, press and hold **Shift** and press F6 (**Clear**).

- If **Sync** is Off, press F6 (**Record**). Recording will start immediately.

**Important:** When **Overdub** is on, the looper will record without erasing any audio you’ve already recorded in the loop. When **Replace** is on, the looper will record and overwrite any audio you’ve already recorded in the loop.

Hardware Tip: Use a footswitch with MPC Renaissance to speed up your looper workflow. Connect a footswitch (sold separately) to MPC Renaissance’s **Footswitch 1** or **Footswitch 2** input, and then set that footswitch to send the desired transport command in the Preferences.
To play or stop the loop, click ▶ Play in the Looper section.

**Hardware:** To play or stop the loop, press F4 (Play).

To reverse loop playback, click ● Reverse in the Looper section. If Seq Sync is on, playback will reverse once the looper’s playhead reaches the end of the loop. If Seq Sync is off, playback will reverse immediately.

**Hardware:** To reverse loop playback, press F3 (Reverse). If Seq Sync is on, playback will reverse once the looper’s playhead reaches the end of the loop. If Seq Sync is off, playback will reverse immediately.

To erase the loop, click Clear in the Looper section. The loop will be erased immediately.

**Hardware:** To erase the loop, press and hold Shift, and then press F6 (Clear). The loop will be erased immediately.

To export the loop as a sample:

1. Click Export in the Looper section to open the Export Loop as a Sample window.
2. Click the New Name field and enter a name for the sample.
3. **Optional:** Click the Program drop-down menu and select a Program to assign it to. To ignore this feature, select <none>.
4. **Optional:** If you’re assigning the sample to a Program, click and drag the Assign to Pad field up or down to select the desired pad. To ignore this feature, select Off.
5. Click and drag the Root Note field up or down to select the sample’s root note.
6. **Optional:** Click and hold Play to play the sample.
7. Click Do It to confirm your choice or Cancel to cancel.

When your loop is done exporting, it will appear under Project Information with the name you entered and will be assigned to the Program and pad you selected (if any).
Sample Edit Mode

General

The sample timeline above the sample waveform now lets you select whether it is shown in **Beats** (which displays as `bars.beats.ticks`) as well as the previously available **Time** (which displays as `seconds.milliseconds`) or **Samples**. To set this, click the left-most part of the timeline or right-click any other place of the timeline.

When you enter Sample Edit Mode, the sample currently selected in **Project Information** will automatically appear in the sample waveform for editing.

When you press a pad in Main Mode, the sample assigned to Layer 1 will be selected in **Project Information**.

**Hardware Tip:** To quickly prepare a sample to edit, press its assigned pad (if it’s assigned to the pad’s Layer 1) and then press **Sample Edit** to enter Sample Edit Mode.

**Hardware:** When adjusting the start point, end point, or loop point of a sample or slice, turning the **Data Dial** to change the value is now scaled based on the zoom level. Zoom in for very fine sample-level control or zoom out for coarser adjustments.
The Sample Process section has been reorganized.

Trim Mode

You can now audition the sample (as it has been edited) using one of two modes:

- **One Shot**: Click Pad 10 to start playback and press it again to stop.
- **Note On**: Click and hold Pad 11 to start playback and release it to stop.

**Hardware**: You can now audition the entire sample using one of two modes:

- **One Shot**: Press Pad 10 to start playback, and press it again to stop.
- **Note On**: Press and hold Pad 11 to start playback and release it to stop.
You can now retune a sample to the tempo of its current sequence.

**To tune a sample to that of its current sequence:**

1. Click **Sample Edit** to enter Sample Edit Mode.
2. Click **From BPM** in the Process section to open the Calculate BPM window.
3. Click and drag the **Number Of Beats** field up or down to match the number of beats in the desired Sequence. Alternatively, double-click the field and type in a number.
4. Click **Match**. The **Tempo** field will adjust to match that your current Sequence’s tempo, and the **Tune** field will adjust automatically. The sample is now tuned to the current Sequence.
5. Click **Close** to exit the window.

**Hardware:** To tune a sample to that of its current sequence:

1. In Trim Mode, use the **Cursor Buttons** to select **Tune**.
2. Press **Window** to open the Calculate BPM window.
3. Use the **Cursor Buttons** to select the **Number Of Beats** field and use the **Data Dial** or +/- buttons to adjust the value to match the number of beats in the desired Sequence. Alternatively, use the **numeric keypad** to enter a value.
4. Press **F3 (Match)**. The **Tempo** field will adjust to match that your current Sequence’s tempo, and the **Tune** field will adjust automatically. The sample is now tuned to the current Sequence.
5. Click **F4 (Close)** to exit the window.

The Calculate BPM window in Sample Edit Mode in the MPC hardware display.
You can now use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the slice. You can easily switch between Trim Mode and Chop Mode while doing this.

**To use Trim Mode to edit a slice of a sample:**

1. Click Chop to enter Chop Mode.
2. Click the Chop To drop-down menu to select how the sample is sliced. Set the other fields below it as desired.
3. In the sample waveform above, click the desired slice.
4. Click Trim to enter Trim Mode. The region you are now editing is indicated by the normal start point and end point markers rather than slice markers.
5. Click Chop at any time to return to Chop Mode.

**Hardware:** To use Trim Mode to edit a slice of a sample:

1. If the tab above F1 says Trim, press it so it says Chop.
2. Use the Cursor Buttons to select the Chop To field and use the Data Dial or +/- buttons to select how the sample is sliced. Set the other fields next to it as desired.
3. Use the Cursor Buttons to select the Slice field and use the Data Dial or +/- buttons to select the desired slice. Alternatively, use the numeric keypad to enter a value.
4. Press F1 (Chop) to enter Trim Mode. The region you are now editing is indicated by the normal start point and end point markers rather than slice markers.
5. Press F1 (Trim) to at any time to return to Chop Mode.
The **Time Stretch** process now has a **Ratio** setting, letting you easily calculate the time stretch factor.

**To use the Ratio setting:**

1. Click **Time Stretch** to open the **Process Sample** window.
2. Click and drag the **Number Of Beats** field up or down to the desired value. Alternatively, double-click the field and type in a number.
3. Click and drag the **New** field up or down to the desired new tempo. Alternatively, double-click the field and type in a number. The **Ratio** field will change automatically to indicate the time stretch factor.

To adjust the ratio instead, click and drag the **Ratio** field up or down to the desired ratio. Alternatively, double-click the field and type in a number. The **New** field will change automatically based on the new time stretch factor.

**Hardware:** The **Time Stretch** process now has a **Ratio** setting, letting you easily calculate the time stretch factor.

**To use the Ratio setting:**

1. In Trim Mode, press **F6 (Process)** to open the **Process Sample** window.
2. Use the **Data Dial** or –/+ buttons to set the **Function** field to **Time Stretch**.
3. Use the **Cursor Buttons** to select the **New** field and use the **Data Dial** or –/+ buttons to set the desired value. Alternatively, use the **numeric keypad** to enter a value. The **Ratio** field will change automatically to indicate the time stretch factor.

To adjust the ratio instead, use the **Cursor Buttons** to select the **Ratio** field and use the **Data Dial** or –/+ buttons to set the desired value. Alternatively, use the **numeric keypad** to enter a value. The **New** field will change automatically based on the new time stretch factor.

4. Click **F5 (Do It)** or **F4 (Cancel)** to confirm or cancel the operation and exit the window.

---

The **Time Stretch** process now has a **Ratio** setting, letting you easily calculate the time stretch factor.

**To use the Ratio setting:**

1. Click **Time Stretch** to open the **Process Sample** window.
2. Click and drag the **Number Of Beats** field up or down to the desired value. Alternatively, double-click the field and type in a number.
3. Click and drag the **New** field up or down to the desired new tempo. Alternatively, double-click the field and type in a number. The **Ratio** field will change automatically to indicate the time stretch factor.

To adjust the ratio instead, click and drag the **Ratio** field up or down to the desired ratio. Alternatively, double-click the field and type in a number. The **New** field will change automatically based on the new time stretch factor.

**Hardware:** The **Time Stretch** process now has a **Ratio** setting, letting you easily calculate the time stretch factor.

**To use the Ratio setting:**

1. In Trim Mode, press **F6 (Process)** to open the **Process Sample** window.
2. Use the **Data Dial** or –/+ buttons to set the **Function** field to **Time Stretch**.
3. Use the **Cursor Buttons** to select the **New** field and use the **Data Dial** or –/+ buttons to set the desired value. Alternatively, use the **numeric keypad** to enter a value. The **Ratio** field will change automatically to indicate the time stretch factor.

To adjust the ratio instead, use the **Cursor Buttons** to select the **Ratio** field and use the **Data Dial** or –/+ buttons to set the desired value. Alternatively, use the **numeric keypad** to enter a value. The **New** field will change automatically based on the new time stretch factor.

4. Click **F5 (Do It)** or **F4 (Cancel)** to confirm or cancel the operation and exit the window.
Chop Mode

Chop Mode is now non-destructive: You can choose the slice/edit behavior in Chop Mode (in Sample Edit Mode) without destroying your original sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the slice data in another project.

See Program Edit Mode > Layer Section of this addendum to learn more about setting a pad to play the entire sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

The slice markers above the sample waveform now show their slice numbers and are clearer and easier to move. Red slice markers indicate the slice you are editing using the hardware. Green slice markers are used for all other slices.

Also, slice markers are now “adaptively” displayed: The end marker is shown only for the currently selected slice.

Furthermore, slices no longer have to be sequential or contiguous. They can even overlap.

**Important:** Link Slices must be deactivated to make slices nonsequential, noncontiguous, or overlapping.

**Hardware:** When selecting the slicing mode (Threshold, Regions, or BPM), the display will now show these options in a new screen where you can cancel or confirm your selection. This prevents any accidental deletion or shifting of your slice markers.

**To select the slice mode:**

1. Use the Cursor Buttons to select the Chop To field.
2. Press Window or use the Data Dial or +/- buttons to open the Chop Mode window.
3. Use the Data Dial or +/- buttons to select the desired slicing mode.
4. Press F5 (Do It) to confirm your choice or F4 (Close) to cancel.
Some features have remained the same but have been reorganized or are accessible in multiple places:

- **Settings Section:** This section is no longer uses that name as it contains many other functions including slice conversion and assignment.
- **Select Slice:** This feature is now assigned to Q-Link Knob Q16 rather than Q15.
- **Zero Snap (previously Snap to Zero):** This button is now above the Q-Link Knobs rather than in the Settings Section.
- **Link Slices:** This button is now above the Q-Link Knobs rather than in the Settings Section.
- **Audition** and **One Shot / Note On:** The earlier Audition feature, which assigned each slice to a pad, is now always activated. The One Shot / Note On menu, which determines how the pads play their slices, is now labeled Pad Audition.

There is now a cue playhead, which is useful when manually inserting slice markers. You can set its position and behavior to suit your workflow. To quickly place it, click the desired location in the grey timeline. You can also click and drag it to adjust it further.

**To use the cue playhead:**

1. Click the desired location in the grey timeline to quickly place it at that point in the sample waveform. You can also click and drag it to adjust it further. The Cue field will show the current position (in samples). Alternatively, double-click the Cue field and type in the desired position (in samples).
2. Click the **Cue Audition** drop-down menu and select one of the following:
   - **One Shot:** Clicking Cue Play (► Play) will play the entire sample from the cue playhead.
   - **Toggle:** Clicking Cue Play (► Play) once will start playback from cue playhead. Clicking it once more will stop playback. **Note:** The Pad Audition button is the same as the Audition button in earlier MPC releases’ Settings Section.
3. Click Cue Play (► Play) to play the sample from the cue playhead.
4. If you want to set a slice marker at that position, click + Slice. If you want to adjust the slice marker further, repeat Steps 1 and 3 as desired.
To set what audio (if any) plays while you move the cue playhead or a slice marker:

Click the **Edit** menu, select **Preferences**, and click the **Other** tab. Click each of these drop-down menus to set them, then click **OK**.

- **Cue Preview**: This is useful for precise placement of the cue playhead. As you move the cue playhead through the sample waveform, you can set it to play the small part of the sample **Before** the cue playhead, play the small part of the sample **After** the cue playhead, or not play at all (**Off**).

- **Slice Preview**: This is useful for precise placement of a slice marker. As you move the slice marker through the sample waveform, you can set it to play the small part of the sample **Before** the slice marker, play the small part of the sample **After** the slice marker, or not play at all (**Off**).
Hardware: There is now a cue playhead, which is useful when manually inserting slice markers. You can set its position and behavior to suit your workflow.

To use the cue playhead:

1. Turn Q-Link Knob Q15 to move the white cue playhead to the desired position in the sample waveform. (By default, it is at the very start of the sample). The Cue field will show the current position (in samples). Alternatively, use the Cursor Buttons to select the Cue field and turn the Data Dial or +/- buttons, or type in a value using the numeric keypad.

2. Use the Cursor Buttons to select the Start, End, or Cue field.
3. Press Window to open the Cue Play Mode window.
4. Use the Cursor Buttons to select a field and use the Data Dial or +/- buttons to select the setting:

   **Cue Play Mode:**
   
   - **One Shot**: Pressing F5 (Play Cue) will play the entire sample from the cue playhead.
   - **Toggle**: Pressing F5 (Play Cue) once will start playback from cue playhead. Pressing it once more will stop playback.
   - **Cue Preview**: This is useful for precise placement of the cue playhead. As you move the cue playhead through the sample waveform, you can set it to play the small part of the sample Before the cue playhead, play the small part of the sample After the cue playhead, or not play at all (Off).
   - **Slice Preview**: This is useful for precise placement of a slice marker. As you move the slice marker through the sample waveform, you can set it to play the small part of the sample Before the slice marker, play the small part of the sample After the slice marker, or not play at all (Off).

5. Press F4 (Close) to close the window.
6. Press F5 (Play Cue) to play the sample from the cue playhead.
7. If you want to set a slice marker at that position, press F6 (Slice +).
You can now add slice markers to a sample as it plays, letting you edit easily in real time. To do this, click +Slice at any point during sample playback.

**Hardware:** You can now add slice markers to a sample as it plays, letting you edit easily in real time. To do this, press F6 (Slice +) at any point during sample playback.

You can now quickly split or combine slices.

**To split the current slice into two slices,** click the + button to the right of the Slice field.

**To combine the current slice and the previous one,** click the – button to the right of the Slice field.

**Hardware:** You can now quickly split or combine slices.

**To split or combine slices:**
1. In Chop Mode, use the Cursor Buttons to select the Slice field.
2. Use the Data Dial or –/+ buttons to select the desired slice.
3. Press Window to open the Split/Combine Region window.
4. Press F4 (Split) to split the current slice into two slices, press F5 (Combine) to combine the current slice and previous one, or press F2 (Back) to cancel the operation.

The Split/Combine Region window in Sample Edit Mode in the MPC hardware display.
You can also remove all slices from a sample. To do this, click **All**.

**Hardware:** You can now remove all slices in a sample. To do this, press and hold **Shift** and press **F5** (**Clear All**).

The second bank of Chop Mode tabs in **Sample Edit Mode** in the MPC hardware display.
You can now easily convert and assign a slice or sample to a pad or Program. In earlier releases, you had to click the **Convert** button in the Process section. Now, it’s conveniently under the other slice and audition controls.

Clicking any of these five buttons will open the **Convert or Assign Slices** window. After making your selections, click **Do It** to complete the process or **Close** to cancel the operation.

**Note:** After the window is open, you can still select a new conversion/assignment process by clicking the **Convert To** drop-down menu and selecting a different one.

**Hardware:** You can now easily convert and assign a slice or sample to a pad or Program. In earlier releases, it was an option in the **Process Sample** page. Now, it’s conveniently accessible as a **Function Button** with the other slice and audition controls.

To access the **Convert or Assign Slices window**, press **Shift + F4 (Convert)**. After the window is open, use the **Convert To** field to select one of the 5 conversion/assignment processes.

Use the **Cursor Buttons** to navigate through the window.

Use the **Data Dial** or **–/+** buttons to change the current setting or value. For numerical values, you can also use the **numeric keypad** to enter a value.

The **Convert or Assign Slices window** in **Sample Edit Mode** in the MPC hardware display.
Non-Destructive Convert: Slice to Pad

**Note:** This is same as clicking the Convert To drop-down menu and selecting Assign Slice to Pad.

This feature will assign the current slice to a pad, similar to applying the Convert process in v1.7 and selecting Assign Slice. This option, however, doesn’t clutter your Program Information with lots of sample slices; the pad will simply refer to the slice in this sample instead of creating a new sample.

- **Pad:** Click this drop-down menu and select the desired pad.
- **Slice Type:** Click this drop-down menu to select how the desired pad’s Layer section settings in Program Edit Mode will be set when the slice is assigned to it (see this addendum’s Program Edit Mode > Layer Section to learn more about how these settings work):
  - Non-Destructive Slice: The pad’s Slice setting will be set to the slice number.
  - Pad Parameters: The pad’s Slice setting will be set to Pad. The Pad Start and Pad End parameters will be set to the slice’s start point and end point values, and the Loop Pos parameter will be set to the slice’s start point but with Pad Loop deactivated.
- **Program:** Click this drop-down menu to specify a Program to which you want to add the slice.

**Important:** Clicking Do It will replace the sample on the first Layer of the pad.
Hardware: Assign Slice to Pad will assign the current slice to a pad, similar to applying the Convert process in v1.7 and selecting Assign Slice. This option, however, doesn’t clutter your Project with lots of sample slices; the pad will simply refer to the slice in this sample instead of creating a new sample.

Convert To: This will be set to Assign Slice to Pad. You can use this field to select a different conversion/assignment process.

Pad: Press the desired pad to select it.

Slice Type: Use this field to select how the desired pad’s Layer section settings in Program Edit Mode will be set when the slice is assigned to it (see this addendum’s Program Edit Mode > Layer Section to learn more about how these settings work):

Non-Destructive Slice: The pad’s Slice setting will be set to the slice number.

Pad Parameters: The pad’s Slice setting will be set to Pad. The Pad Start and Pad End parameters will be set to the slice’s start point and end point values, and the Loop Pos parameter will be set to the slice’s start point but with Pad Loop deactivated.

Program: Use this field to specify a Program to which you want to add the slice.

Press F5 (Do It) to confirm your choice or F4 (Cancel) or cancel the operation.

Important: Pressing F5 (Do It) will replace the sample on the first Layer of the pad.
Non-Destructive Convert: New Program

**Note:** This is same as clicking the Convert To drop-down menu and selecting New Program Using Slices.

This feature will create a new Program and assign the current sample’s slices to its pads. The new Program will be named after the sample and appended with `ch`.

This is similar to applying the Convert process in v1.7 and selecting Sliced Samples with Create New Program checked. This option, however, doesn’t clutter your Program Information with lots of sample slices; each pad will simply refer to a slice in this sample instead of creating a new sample.

- **Slice Type:** Click this drop-down menu to select how each pad’s Layer section settings in Program Edit Mode will be set when the slice is assigned to it (see this addendum’s Program Edit Mode > Layer Section to learn more about how these settings work):
  - Non-Destructive Slice: Each pad’s Slice setting will be set to the slice number.
  - Pad Parameters: Each pad’s Slice setting will be set to Pad. The Pad Start and Pad End parameters will be set to the slice’s start point and end point values, and the Loop Pos parameter will be set to the slice’s start point but with Pad Loop deactivated.

- **Create Events:** Check this box to create a new Program in which each slice results in a sample and is automatically assigned to a pad. Furthermore, it will automatically create a new Track in which each pad plays its corresponding slice in ascending sequence by pad number.

- **Number of Bars** (available only if Create Events is checked): Click and drag this field up or down to set how many bars the slices’ events will occupy.
Hardware: *New Program Using Slices* will assign the current slice to a pad, similar to applying the *Convert* process in v1.7 and selecting *Sliced Samples* with *Create New Program* selected. This option, however, doesn’t clutter your Project with lots of sample slices; each pad will simply refer to the slice in this sample instead of creating a new sample.

**Convert To:** This will be set to *New Program Using Slices*. You can use this field to select a different conversion/assignment process.

**Slice Type:** Use this field to select how each pad’s *Layer* section settings in Program Edit Mode will be set when the slice is assigned to it (see this addendum’s *Program Edit Mode > Layer Section* to learn more about these settings):

- **Non-Destructive Slice:** Each pad’s *Slice* setting will be set to the slice number.
- **Pad Parameters:** Each pad’s *Slice* setting will be set to *Pad*. The *Pad Start* and *Pad End* parameters will be set to the slice’s start point and end point values, and the *Loop Pos* parameter will be set to the slice’s start point but with *Pad Loop* deactivated.

**Create Events:** Set this to *On* to create a new Program in which each slice results in a sample and is automatically assigned to a pad. Furthermore, it will automatically create a new Track in which each pad plays its corresponding slice in ascending sequence by pad number.

**Number of Bars** (available only if *Create Events* is *On*): This field determines how many bars the slices’ events will occupy.

Press **F5 (Do It)** to confirm your choice or **F4 (Cancel)** or cancel the operation.

![New Program Using Slices in the MPC hardware display.](image)
Extract New Samples: Sample to Pad

**Note:** This is same as clicking the **Convert To** drop-down menu and selecting **New Sample to Pad**.

This feature will create a new sample from the current one and assign it to a pad. The new sample will have the same name as the original one but appended with -# (where # is a consecutive number).

- **Pad:** Click this drop-down menu and select the desired pad.
- **Crop Sample:** Check this box to delete the unused parts from the sample when it’s created and assigned. This feature is destructive (though the Project will still contain your original sample).

  Leave this box unchecked to keep the unused parts of the sample when it’s created and assigned. This is essentially like editing a sample in Trim Mode and assigning it to a pad, but this method creates a new sample, so you will still be able to further edit the entire sample even though you are using only part of it at the moment.

- **Program:** Click this drop-down menu to specify a Program to which you want to add the sample.

  **Important:** Clicking **Do It** will replace the sample on the first Layer of the pad.
Hardware: *New Sample to Pad* will create a new sample from the current one and assign it to a pad. The new sample will have the same name as the original one but appended with -# (where # is a consecutive number).

**Convert To:** This will be set to *New Sample to Pad*. You can use this field to select a different conversion/assignment process.

**Pad:** Press the desired pad to select it.

**Crop Sample:** Set this to *On* to delete the unused parts from the sample when it’s created and assigned. This feature is destructive (though the Project will still contain your original sample).

Set this to *Off* to keep the unused parts of the sample when it’s created and assigned. This is essentially like editing a sample in Trim Mode and assigning it to a pad, but this method creates a new sample, so you will still be able to further edit the entire sample even though you are using only part of it at the moment.

**Program:** Use this field to specify a Program to which you want to add the slice.

Press F5 *(Do It)* to confirm your choice or F4 *(Cancel)* or cancel the operation.
Extract New Samples: New Program

**Note:** This is same as clicking the Convert To drop-down menu and selecting New Program With New Samples. This feature will create new samples from the current one and assign them to pads in a new Program. The new Program will be named after the sample and appended with **ch**. The new samples will be appended with **SI-#** (where # is a consecutive number).

This is similar to applying the Convert process in v1.7 and selecting Sliced Samples with Create New Program checked.

- **Crop Samples:** Check this box to delete the unused parts from the samples when they're created and assigned. This feature is destructive (though the Project will still contain your original sample).
  
  Leave this box unchecked to keep the unused parts of the samples when they're created and assigned. This is essentially like editing samples in Trim Mode and assigning them to pads, but this method creates new samples, so you will still be able to further edit the entirety of each sample even though you are using only part of it at the moment.

- **Create New Program:** Check this box to create a new Program in which each slice results in a sample and is automatically assigned to a pad. The new Program will be named after the sample and appended with **ch**.

- **Create Events** (available only if Create New Program is checked): Check this box to create a new Program in which each slice results in a sample and is automatically assigned to a pad. Furthermore, it will automatically create a new Track in which each pad plays its corresponding slice in ascending sequence by pad number.

- **Number of Bars** (available only if Create Events is checked): Click and drag this field up or down to set how many bars the slices' events will occupy.

---

335
Hardware: New Program With New Samples will create new samples from the current one and assign them to pads in a new Program. The new Program will be named after the sample and appended with ch. The new samples will be appended with SI-# (where # is a consecutive number). This is similar to applying the Convert process in v1.7 and selecting Sliced Samples with Create New Program selected.

Convert To: This will be set to New Program With New Samples. You can use this field to to select a different conversion/assignment process.

Crop Samples: Set this to On to delete the unused parts from the samples when they’re created and assigned. This feature is destructive (though the Project will still contain your original sample).

Set this to Off to keep the unused parts of the samples when they’re created and assigned. This is essentially like editing samples in Trim Mode and assigning them to pads, but this method creates new samples, so you will still be able to further edit the entirety of each sample even though you are using only part of it at the moment.

Create New Program: Set this to On to create a new Program in which each slice results in a sample and is automatically assigned to a pad. The new Program will be named after the sample and appended with ch.

Create Events (available only if Create New Program is On): Set this to On to create a new Program in which each slice results in a sample and is automatically assigned to a pad. Furthermore, it will automatically create a new Track in which each pad plays its corresponding slice in ascending sequence by pad number.

Number of Bars (available only if Create Events is On): This field determines how many bars the slices’ events will occupy.

Press F5 (Do It) to confirm your choice or F4 (Cancel) or cancel the operation.
Patched Phrase

Note: This is same as clicking the Convert To drop-down menu and selecting Patched Phrase.

This is identical to applying the Convert process in v1.7 and selecting Patched Phrase: It creates a new sample that will play based on the tempo of your Sequence, and places it in the current Project. The patched phrase will have the same name as the original sample but appended with pp and will use a different icon in your Project Information.

- Number of Bars: Click and drag this field up or down to set how many bars long the patched phrase is meant to be.

Hardware: Patched Phrase is identical to applying the Convert process in v1.7 and selecting Patched Phrase: It creates a new sample that will play based on the tempo of your Sequence, and places it in the current Project. The patched phrase will have the same name as the original sample but appended with pp.

Convert To: This will be set to Patched Phrase. You can use this field to select a different conversion/assignment process.

Number of Bars: This field determines how many bars long the patched phrase will be.

Press F5 (Do It) to confirm your choice or F4 (Cancel) or cancel the operation.

Patched Phrase in the MPC hardware display.
Program Mode

You can now edit a sample in the context of the Program in which you'll use it. In this mode, you can adjust the pad parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound in the Program’s audio path.

To do this:
1. In Sample Edit Mode, click the Program Mode button above the Q-Link Knobs. The pads will show their assigned samples in the current Program.
2. Click a pad to hear its sample(s). The sample on its first layer will automatically appear in the sample waveform for editing and will be selected in Project Information.
   You can still use the Q-Link Knobs as you normally would in Trim Mode.

Hardware: To use Program Mode:
1. In Sample Edit Mode, press F2 (Program).
2. Press a pad to hear its sample(s). The sample on its first layer will automatically appear in the sample waveform for editing and be selected in the Sample field.
   You can still use the Q-Link Knobs and Function Buttons as you normally would in Trim Mode.
Step Sequence Mode

Pad Select

**Hardware:** You can now use **Pad Select** to switch to step sequence events on different pads. When Pad Select is activated, press a pad to select it and hear its sound instead of entering a pad event. When Pad Select is deactivated, press a pad to enter a step for the current pad, like normal.

To activate or deactivate Pad Select, press **F4 (Pad Select)**.

Pad Select in Step Sequence Mode in the MPC hardware display.
Pad Perform Mode

Pad Perform Mode lets you assign musical scales/modes, chords, or progressions to the pads for more creative performance.

**Hardware:** To use Pad Perform Mode, press Pad Assign while using a Keygroup Program, MIDI Program, or Plugin Program. The display will show the current pad bank's mapping of notes or chords.

Use the Cursor Buttons to select a field. Use the Data Dial or +/- buttons to change the setting/value. Use the Function Buttons (described below) to access shortcuts to these and other features.

**Type:** This determines what will be mapped over the pads:

- **Notes:** Each pad is assigned a note, ascending by one scale degree with each pad.

- **Chords:** Each pad is assigned a chord, the root note ascending by one scale degree with each pad. All available chords will play in the key determined by the Scale.

- **Chromatic Chords:** Each pad is assigned a chord, the root note ascending by one scale degree with each pad. You can play any chord type regardless of the key determined by the Scale. Essentially, this is like the Chords setting but with more options to play chords out of the set key.

- **Progressions:** Each pad is assigned a chord in a chord progression. You can play the pads in (or out of) order to construct songs quickly. The available chords are determined by the Chord field.

![Playing notes in Pad Perform Mode](image1.png)  
![Playing chords in Pad Perform Mode](image2.png)  
![Playing chromatic chords in Pad Perform Mode](image3.png)  
![Playing progressions in Pad Perform Mode](image4.png)
Scale: These two fields determine the root note and the scale type.

Root Note: This is the starting point of the scale. The available notes are all chromatic notes across the range of the pads. The pad that’s assigned the root note will be lit differently (and highlighted in the display) to indicate where the scale starts in each octave.

Scale Type: This is the scale or mode based on the root note. (This is disabled when Type is set to Progressions.) The available scales are:

- Major Gypsy Dorian
- Minor (melodic) Hungarian Gypsy Phrygian
- Pentatonic Major Persian Lydian
- Pentatonic Minor Major Bebop Mixolydian
- Blues (minor) Whole Tone Aeolian
- Flamenco Chromatic Locrian

Chord: This determines what chord type will play when pressing a pad. The resulting chord will use those scale degrees based off of the pad’s root note.

When the Type is set to Chords, the available chords are:

- 1-3-5 (major/minor)
- 1-3-5-7 (major7/minor7)
- 1-4-5 (sus4)
- 1-3-5-7b (dominant)
- 1-2-5 (sus2)

When the Type is set to Chromatic Chords, the available chords are:

- Major Sus2 Major7 Major9 Augmented
- Minor Sus4 Minor7 Minor9 Diminished

Banks: This determines how the notes are mapped across the pad banks.

Start on root ensures that Pad 01 is always the root note of the scale in every pad bank.

Continuous ensures that Pad 01 of one bank is always one scale degree higher than Pad 16 of the previous bank.
Alternatively, use the Function Buttons to quickly select different Types and Chords:

**F1 (Notes):** This automatically sets the Type to Notes.

**F2 (1-3-5):** This automatically sets the Type to Chords and sets the Chord to 1-3-5 (major/minor).

**F3 (1-3-5-7):** This automatically sets the Type to Chords and sets the Chord to 1-3-5-7 (major7/minor7).

**F4 (Progrsn):** This automatically sets the Type to Progressions.

**F5 (Octave –) and F6 (Octave +):** This shifts the pad assignments down or up by an octave.

**Shift + F2 (1-4-5):** This automatically sets the Type to Chords and sets the Chord to 1-4-5 (sus4).

**Shift + F3 (1-3-5-7b):** This automatically sets the Type to Chords and sets the Chord to 1-3-5-7b (dominant).

**Shift + F5 (Note–) and Shift + F6 (Note+):** This shifts the pad assignments down or up by a scale degree.

---

First bank of buttons in **Pad Perform Mode** in the MPC hardware display.

Second bank of buttons in **Pad Perform Mode** in the MPC hardware display.
Input insert effects allow you to apply effects to incoming audio. You can do this while recording samples and while recording with the looper.

Vintage Mode effects are now available for all users. These effects emulate the Vintage Mode of the MPC Renaissance.

**To apply a Vintage Mode effect:**
1. When selecting an effect, click the + next to **Vintage Effects**.
2. Click the desired Vintage Mode effect.
3. Click **Select** to confirm your choice or **Close** to cancel.
Hardware: To apply a Vintage Mode effect:

1. When selecting an effect in the Select Effect window, use the Data Dial or –/+ buttons to move through the list. The Vintage Mode effects are at the bottom of the list of Akai Professional effects.

2. Press F4 (Select) to confirm your choice or F3 (Back) to cancel.

![Select Effect Window](image.png)

Vintage Mode effects in the Select Effect window in the MPC hardware display.
Improvements in MPC v1.8

- To open files, you can now drag them from your **Explorer** (Windows) or **Finder** (Mac OS X) anywhere into the MPC software window.
- The file browser will hide the [ProjectData] directories when Project filter (Proj) is activated.
- Windows that open in the software (e.g., Preferences, History, etc.) are now contained in the main software window rather than spilling outside of it.
- Sample Record Mode now has a larger VU meter for better signal visibility and **Threshold** control.
- In Sample Edit Mode, the pad colors in Trim Mode and Chop Mode have been updated for easier viewing.
- Slices created in Chop Mode (in Sample Edit Mode) are now saved into audio file itself; you can drag that file into a new Project and retain all of the slices from its previous Project.
- Improved audio path performance.
- Various bug fixes and stability enhancements.

**Hardware:**

- Many minor workflow improvements for MPC Renaissance and MPC Studio users.
- The display shows improved **Function Buttons**.
- +/-, on/off states, and tab selections are clearer.
- Various bug fixes and stability enhancements.
**Corrections for the MPC v1.7 User Guide**

**Keygroup Programs:** *User Guide 1.7* previously stated that Keygroup Programs have only one channel strip. This has been corrected in *Program Mixer Mode (Page 150).*

Keygroup Programs actually have a channel strip for each individual Keygroup (up to 128).

**Auto Scroll:** *User Guide v1.7* previously did not have a description of the Auto Scroll button. This has been added to *General Features > Mode Tab Section (Page 72).*

Click the **Auto Scroll** button to switch between **Follow**, **Page**, and **Off**.

- When set to **Follow**, depending on the zoom setting, the grid will scroll along in the background, keeping the position marker centered.
- When set to **Page**, the grid display will "turn over" to follow the position marker.
- When set to **Off**, the grid will not move at all.

These functions also apply to the sample waveform in Sample Edit Mode.

**Loading Audio CD Tracks from File Browser:** *User Guide v1.7* previously did not have a description of loading tracks from an audio CD. This has been added to *General Features > Browsers > File Browser (Page 65).*

To load a track from an audio CD into your Project, click and drag it from the File Browser onto the software window.

**Edit Sequence Window (Hardware):** *User Guide v1.7* did not have a description of the **Edit Sequence** window (shown in the MPC hardware display only). This has been added to this addendum’s *Main Mode > Sequence and Track Editing* section.
Q-Link (Hardware): *User Guide* v1.7 did not have a description of the Q-Link window (shown in the MPC hardware display only).

The explanation of the Q-Link Knob section in the software itself is in *Main Mode > Q-Link Section (Page 113)*.

**Hardware:**

1. To open the Q-Link window, press *Shift + Prog Edit / Q-Link*.
2. Use the **Cursor Buttons** to select a field. Use the **Data Dial** or −/+ buttons to change the setting/value.
3. Use the **Cursor Buttons** to select the **Program** field at the top of the window. Use the **Data Dial** or −/+ buttons to select the Program whose Q-Link Knobs you want to assign.
4. To start assigning **Program** parameters to the Q-Link Knobs, press **F1 (Prog Q)**.
   - To start assigning **effect** parameters to the Q-Link Knobs, press **F2 (FX Q)**.
5. To select a Q-Link Knob, use the **Cursor Buttons** or simply touch the corresponding **Q-Link Knob** on your MPC hardware. (The 16 fields correspond visually to the 16 Q-Link Knobs.)
6. To quickly assign a parameter to the current Q-Link Knob, make sure the **Params** button is lit (if it isn’t, press **F5 (Params)**), and then use the **Data Dial** or −/+ buttons to select a parameter.

| Prog Q tab of the Q-Link window in the MPC hardware display. | FX Q tab of the Q-Link window in the MPC hardware display. |
To edit even more parameters for the current Q-Link Knob, press **F4** (**Edit**). This opens the **Program Q-Link Edit** window:

- **Program** (for Program parameters): Use this field to select the Program whose parameters you want to assign.
- **Effect** (for effect parameters): Use this field to select the effect whose parameters you want to assign. (You have to load an effect before its parameters can be assigned to the Q-Link Knobs. All effects loaded to the pads or to the Track, independent from their routing, can have their parameter assigned. See the **Effects** chapter for more information about loading effects.)
- **QLink**: Use this field to select the desired Q-Link Knob, or simply touch the corresponding Q-Link Knob on your MPC hardware.
- **Change** (for Program parameters): Use this field to select the condition for changing a parameter. In most cases, you should select **Real Time**, which changes the sound immediately when the Q-Link Knob is moved. If **Note On** is selected, the Q-Link Knob’s position will affect the sound only when its corresponding pad is pressed.
- **Pad** (for Program parameters): Use this field to select the desired pad you want to control, or simply press the corresponding pad on your MPC hardware.
- **Param**: Use this field to select the parameter you want to assign to the Q-Link Knob.
- **Touch To**: Use this field to select how the Q-Link Knob will respond when you touch it. When you hold down the **Q-Link Trigger** button and touch the top of the Q-Link Knob, the assigned parameter will jump to either its minimum (**Min**) or maximum (**Max**) value.

Press **F4** (**Close**) to return to the main **Q-Link** window.

7. To set the values of the Q-Link Knobs, make sure the **Values** button is lit (if it isn’t, press **F6** (**Values**), and then turn the corresponding **Q-Link Knobs** on your MPC hardware. Alternatively, you can use the **Cursor Buttons** to select one and then use **Data Dial** or **+-** buttons to set a value.
Effects (Hardware): User Guide v1.7 did not have a description of the Effects window (shown in the MPC hardware display only). The Send and Insert tabs have been moved from F4 and F5 to F1 and F2, as well.

The explanation of the Effects in the software itself (and corrections due to updates in 1.8) is in Effects > Send Effects (Page 232) and in Effects > Master Effects (Page 236).

Hardware:

1. To open the Effects window, press Shift + Seq Edit / Effects.
2. To load or adjust send effects, press F1 (Send).
   To load or adjust master insert effects, press F2 (Insert).
3. Use the Cursor Buttons to select the desired effect slot.
4. Use the Data Dial or +/- buttons to open another page to select an effect. Press F4 (Select) to load it, or press F3 (Back) to close the page.
5. Send effects only: To set the return level, use the Cursor Buttons to select the desired Level effect slot. Use the Data Dial or +/- buttons to set the level.
6. To make further adjustments to the effect parameters, select it, and then press Window to open its parameter window or F6 (Edit).

Appendix: Effects and Parameters: User Guide v1.7 previously had a few incorrect default parameter values and Q-Link Knob numbers. These have been corrected in the Appendix > Effects and Parameters (Page 242).
Other (Hardware): User Guide v1.7 did not have a description of the Other window (shown in the MPC hardware display only).

Hardware:
1. To open the Other window, press Shift + Song / Other.
2. To switch between the Preferences tab and MIDI Control tab, press F1 (Prefs or MidiCtrl).
3. Use the Cursor Buttons to select a field. Use the Data Dial or +/- buttons to change the setting/value.

The Preferences tab in the Other window in MPC hardware display.

The Preferences tab shows some of the settings available in the software’s Preferences window (in the Hardware and Other tabs) and other settings not available in the software:

Auto Button: Use this field to set the Q-Link Trigger button to cycle through automation states for just for each Program or globally (Global). Learn about automation for Programs in Program Edit Mode > Master Section. Learn more about global automation in General Features > Mode Tab Section.

Number of Taps: Use this field to set how many times you have to press your MPC hardware’s Tap Tempo button until the new tempo is recognized.

Pad Threshold: Use this field to select a threshold that must be exceeded to trigger the pad.

Pad Sensitivity: Use this field menu to set how sensitively your MPC hardware’s pads respond to your touch. At lower values, you need to use more force to generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use much force while pressing a pad.

Pad Curve: Use this field to set how your playing is translated into velocity values, starting from A to D. An A pad curve is essentially linear, while the B, C, and D pad curves are exponential. (See the diagram in General Features > Software Menus > Edit Menu > Preferences: Hardware Tab.)
Footswitch 1 / Footswitch 2: Use these fields to select the functionality of footswitches connected to your MPC hardware. You can select either transport commands (e.g., Play or Stop) or trigger commands for pads and the Function Buttons.

Sampling Bit Depth: Use this field to set the bit depth of the audio recorded from a sample.

Display Resolution: Use this field to set the resolution of your MPC’s hardware display.

Program Change Target: Use this field to select what an incoming MIDI Program Change message will change: a Program, Sequence, or Track, or turn this feature Off.

The MIDI Control tab in the Other window in the MPC hardware display.

Control: This determines what message the control sends to the software (e.g., acting as a specific Q-Link Knob, acting as a specific pad, entering a specific mode, revealing or hiding the File Browser, Undo, Tap Tempo, etc.).

Light LED: This determines how the control’s LED (or multiple LEDs) on the hardware will behave. When set to Never, the LED will always be off.

When set to MIDI Input, the LED will light up when the software receives a MIDI message that matches that control.

When set to Local, the LED will light up when you use that control and/or MIDI input is received.

Midi Channel: This determines over which MIDI channel (from 1–16) the control will send MIDI messages to the software.

CC Number: (buttons and Q-Link Knobs only): This determines what Control Change the control will send to the software.
Mode (Q-Link Knobs only): This determines how the Q-Link Knob will control its parameter.

- When set to Absolute, the Q-Link Knob's current position is what determines its parameter's value; moving the Q-Link Knob may cause its parameter to "snap" to a new position when using the Q-Link Knob to control different parameters between different modes.
- When set to Relative, moving the Q-Link Knob will adjust its parameter upward or downward regardless of its position.

Low Range (Q-Link Knobs only): This is the Q-Link Knob's lowest possible value (0–127).

High Range (Q-Link Knobs only): This is the Q-Link Knob's highest possible value (0–127).

Touch Sense (Q-Link Knobs only): This activates or deactivates the Q-Link Knob's touch-capacitive circuitry.

- When set to On, you can touch the Q-Link Knob to send a Note On message to the software (this is how your MPC hardware normally works).
- When set to Off, the Q-Link Knob will not send any Note On messages; it will only send CC messages when you turn it.

Touch Note (Q-Link Knobs only): This is the MIDI note number the Q-Link Knob will send to the software when you touch it (0–127 or C-2 to G8). Touch Sense must be On for this to work.

Type (buttons only): This determines whether the button will behave as a Momentary switch or Toggle (latching) switch.

Note (pads only): This is the MIDI note number the pad will send to the software when you press it (0–127 or C-2 to G8).

Bank (pads only): This is the pad bank the pad belongs to. If Set All is On, the pad's messages and parameters will be identical across all eight banks.

Velocity (pads only): This determines whether the pad will be velocity-sensitive (On) or not (Off). When set to Off, pressing the pad will send a note at full-level (127) always.

Aftertouch (pads only): This determines how the pad's aftertouch (pressure applied to the pad after the initial press) behaves.

- When set to Off, the pad will not send any aftertouch messages.
- When set to Channel, if you press multiple pads that have this setting, the aftertouch messages they send will be identical.
- When set to Poly, if you press multiple pads, the aftertouch message each pad sends will be independent from the others'.

Set All (pads only): When On, the pad's messages and parameters will be identical across all eight banks.
**Pad Copy:** User Guide v1.7 previously had a description of the Pad Copy button that was obsolete due to subsequent software improvements. This has been corrected in MPC Hardware Overview > MPC Renaissance > Top Panel (Page 19) and in MPC Hardware Overview > MPC Studio > Top Panel (Page 28).

User Guide v1.7 also did not have a description of the Copy Pad window or function as shown in the MPC hardware display:

![Copy Pad Window](image)

The Copy Pad window in the MPC hardware display.

**Hardware:** To copy one pad (sample and parameters) to another:

1. Press Shift + Pad Assign / Pad Copy to open the Copy Pad window.
2. Use the Cursor Buttons to select the From Pad field. Press the "destination" pad.
3. Use the Cursor Buttons to select the To Pads field. Press select or deselect "destination" pads.
4. Press F5 (Do It) to confirm your choice or F4 (Close) to cancel the operation.
Addendum for MPC v1.9

This chapter is an addendum that explains new features and improvements in MPC v1.9. We also updated certain sections of the earlier pages of the User Guide to correct previous errors.

Some of the most important new features include enhancements in Track Mixer Mode, where you can now view and use channel strips for returns, submixes, and master outputs.

Track lengths can now be independent of Sequence lengths, which means that you don’t have to copy and paste content in a Track just so its length matches up with others in the Sequence. For instance, a 2-bar drum pattern on one Track will loop under an 8-bar bass line on another Track.

We’ve added an easy way to assign pad colors in the software and placed other useful Program editing processes in the Edit Menu, as well. We’ve also added Project Notes where you can quickly write notes to yourself and save with each Project.

Please see the Table of Contents: Addendum for MPC v1.9 to learn more about the additions and improvements in the MPC software.

We hope you enjoy these new features!

Akai Professional
**Table of Contents: Addendum for MPC v1.9**

### New Features in MPC v1.9

- Support for MPC Touch ................................................................. 357
- Program Edit Processes ................................................................. 357
- Swap Pad Contents ........................................................................ 358
- Pad Colors ..................................................................................... 359
- Independent Track Lengths .......................................................... 361
- Independent Insert Effect Bypass ............................................... 362
- Project Notes .................................................................................. 363

### Program Edit Mode

- Submix Channel Strips ................................................................. 365
- Return Channel Strips ................................................................. 366
- Master Channel Strips ................................................................. 366
Sample Edit Mode

Trim Mode

Program Mode

Preferences

Project Tab

Screensaver Disable

Improvements in MPC v1.9

Corrections for the MPC v1.8 *User Guide*
New Features in MPC v1.9

General

Support for MPC Touch

This release provides support for Akai Professional’s revolutionary new MPC Touch. You can now get hands-on with your music using MPC Touch’s large multi-touch display and new hardware controls.

Learn more at akaipro.com.

Program Edit Processes

You can now edit certain aspects of the Program in the Edit Menu.

To do this, click the Edit Menu, and select Program to show the following options:

- **Pad Color**: Select this to open the Pad Color window—an easier way to set the colors of the pads in your Program. See Pad Colors below to learn about this.

- **Duplicate**: Select this to duplicate the current Program to another one. The new Program will be appended with -# (where # is a consecutive number).
• **Duplicate to New Track:** Select this to duplicate the current Program to another one and create a new Track that uses it. The new Program will be appended with \(-\#\) (where \# is a consecutive number).

• **Merge:** Select this to merge the pads of one Program with another. In the Merge Programs window that appears, click the Pads from Program menu to select the “source” Program, and click the Into Program menu to select the “destination” Program where the two will be merged. Check the **Start on Next Bank** box if you want the source Program’s pad assignments to start in the next completely empty bank in the destination Program (this is helpful if you have already assigned your pads to specific locations of the 4x4 pad grid). Click OK to continue or Cancel to cancel.

• **Delete:** Select this to delete the Program. You will be asked to confirm or cancel your choice in a new window.

• **Rename:** Select this to rename the Program. You will be asked to confirm or cancel your choice in a new window.

**Swap Pad Contents**

When the Pad Bank section in the lower half of the screen shows their assigned samples, you can now swap the contents and settings of two pads by pressing and holding **Alt** on your computer keyboard, and then dragging one pad to another.
Pad Colors

There’s now an easier way to set the colors of the pads in your Program.

To open the Pad Color window, click the Edit Menu, select Program, and select Pad Color.

The Program field shows the Program whose pad colors you are setting. To select a different Program, close this window, select a different Program, and then open the window again.

To select a pad to edit, click it on the right, or press it on your MPC hardware.

To select how the pad lights will display, click the Display As field:

- **Off:** The pads will be unlit whether you are playing them or not.
- **Classic Velocity:** The pads will be unlit while you are not playing them. When you press them, they will light with colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity.
- **Fixed:** The pads will be lit with their assigned colors whether you are playing them or not.
- **Off->Velocity:** The pads will be unlit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
- **Dim->Velocity:** The pads will be dimly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
- **Bright->Velocity:** The pads will be brightly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
To select how the empty pads will display, click the Empty Pads field:

- **Empty pads off**: Pads without any sounds will remain off.
- **Empty pads dim**: Pads without any sounds will remain more dimly lit than pads with sounds assigned.
- **Empty pads normal**: Pads without any sounds will appear the same as pads with sounds assigned.

To determine whether you want to edit all pads or just one pad, click the Pads field and select Edit All Pads or Edit Single Pads.

To show or hide the RGB (red, green, blue) palette of colors, click the Show RGB Palette box.

To select a color for the pad, click a color button.

**Hardware**: Lime green is now an available pad color.
Independent Track Lengths

Track lengths are now independent of Sequence lengths. In earlier versions, you would have to ensure all Tracks in a Sequence are identical lengths even if it meant the first half of a Track is identical to its second half (e.g., a 4-bar drum pattern in an 8-bar Sequence would have to be doubled). Now, you can set a Track length to be different from the Sequence length. If the Track is shorter than the overall Sequence, it will loop when it reaches the end as the rest of the Sequence continues. You can also set the Track to match the Sequence, as normal.

You can do this in Main Mode, Program Edit Mode, Program Mixer Mode, Track View Mode, Pad Mute Mode, and Step Sequence Mode.

To set the Track length, click and drag the Track Len field (in the upper-right corner) up or down. This defines the number of beats the Track will use during playback. After those beats pass, the Track will return to its Beat 1 as the other Tracks continue. The beats of the Track that are disabled will appear as darker in the display.

Set it to the minimum setting, Seq, for the Track to follow the length of the overall Sequence.
Independent Insert Effect Bypass

You can now enable or disable individual insert effects independently of the others on the same channel. In other words, you no longer have to use the On/Off button to enable or disable all of them at once.

To enable or disable an insert effect slot, do either of the following:

- Press and hold Shift on your computer keyboard, and then click the insert slot above the channel strip.
- Double-click the insert effect slot to open its parameters, and then click the On/Off button in the upper-left corner.

Hardware: To enable or disable an insert effect slot, move the cursor over it, and then press Window.
Project Notes

Each Project now has notes associated with it, which you can use to write notes or other information for later reference. These notes are stored in the Project.

To show the Project Notes window, do either of the following:

- Click the Edit Menu, and then select Show Project Notes.
- On your computer keyboard, press Ctrl+Alt+Shift+N (Windows) or ⌘+Alt+Shift+N (Mac OS X).
Program Edit Mode

In Program Edit Mode, you can now set independent polyphony limits for each pad in a Program and/or for the entire Program. You can set either to Poly, Mono, or a specific number of voices. You can do this for Drum Programs or Keygroup Programs only.

To set the polyphony for a pad in a Drum Program, click the Pad Polyphony drop-down menu in the Pad Play Modes section.

To set the polyphony for a keygroup in a Keygroup Program, click the KG Poly drop-down menu in the Key Group section.

To set the polyphony for an entire Program, click the Polyphony drop-down menu in the Master section.
Track Mixer Mode

Track Mixer Mode now has channel strips for all 8 submixes, 4 returns, and 16 master outputs.

Submix Channel Strips

The submix channel strips operate similarly to other channel strips: each has 4 insert slots, send level controls, routing selector, a pan knob, a mute button (M), a level slider, and a level meter.

To show or hide the submix channel strips, click the downward arrow icon on the left side of the channel strip area.
Return Channel Strips

The return channel strips operate similarly to other channel strips: each has 4 insert slots, routing selector, a pan knob, a mute button (M), a level slider, and a level meter.

Because each return channel now has 4 insert slots, you are no longer limited to only 1 effect per send. Each send is now routed through up to 4 insert effects on each return.

To show or hide the return channel strips, click the triangular arrow icon on the left side of the channel strip area.

Master Channel Strips

The master channel strips operate similarly to other channel strips: each has 4 insert slots, a pan knob, a mute button (M), a level slider, and a level meter.

Normally, the channel strip for only the first master output (Out 1,2) is shown (in the lower-right corner of the window). Now, you can click and drag to expand the area that shows the channel strips for the subsequent master outputs.

To show or hide the master channel strips, click the crown icon on the left side of the channel strip area.
Sample Edit Mode

Trim Mode

While using Trim Mode, you can now play the sample as a continuous loop while simultaneously adjusting its start and end points. This is useful if you don’t want to keep playing the sample each time you make an adjustment.

To continuously play or stop the sample, click Pad 16 (Play Loop Continuous).

Program Mode

While using Program Mode, you can quickly load a single slice (or all slices) to a pad along with the current start point, end point, and other settings.

To load a slice to a pad with the current settings:

1. Press the desired pad on your MPC hardware.
2. Click and drag the Slice menu up or down to select the desired slice.
3. Make sure the other settings (start point, loop point, end point, etc.) are what you want.
4. Click the To Pad button. The pad will now use those settings from that slice, and the pad will now use Pad Parameters instead of Non-Destructive Slice. (In other words, in Program Edit Mode, the pad’s Slice menu in its Layers section will be set to Pad instead of a slice number. Also, it will use the start point, end point, and loop point you set in Step 3.)
Preferences

Project Tab

The Preferences window now has a Project tab where you can set default settings for each project:

- **Default Tempo**: Click and drag this field up or down to set the default tempo.

- **Default Master Tempo**: Click this button to select whether or not the default tempo applies to Sequences (Off) or to a Master Tempo (On).

- **Default Sequence Bars**: Click and drag this field up or down to set the default number of bars for new Sequences.

- **Default Time Signature**: Click and drag each of these field up or down to set the default time signature for new Sequences.

- **Default Pad Slice**: Click this drop-down menu to select how new samples will play when you load them or record them into the Project. When set to Pad, the Slice menu in Program Edit Mode will be set to Pad, which lets you set the start point, end point, etc. for the layer. When set to All, the Slice menu in Program Edit Mode will be set to All, in which the entire sample plays (the default behavior in MPC 1.8.2 and earlier versions).
The Other tab now has an option where you can disable your computer’s screensaver when MPC software is running:

- **Never**: Your computer’s screensaver will function normally.

- **When hardware attached**: As long as your MPC hardware is connected to your computer and powered on, your computer’s screensaver will be disabled. It will function normally again if you power off or disconnect your MPC hardware from your computer.

- **Always**: Your computer’s screensaver will be disabled as long as the MPC software is open (whether or not your MPC hardware is connected or powered on).
Improvements in MPC v1.9

- Whenever a Sequence starts or repeats, its sample zone cycle now resets to Layer 1.
- Pads for Keygroup Programs, Plugin Program, and MIDI Programs now display the note name and MIDI note number.
- Improved Keygroup Program editing.
- In Pad Mute Mode, the pad lights now flash more brightly to indicate what’s being played so you can better visualise what to mute.
- Enhanced “note-stealing” algorithms so your Projects play better.
- Significantly improved audio performance with a reworked internal audio path.
- Improved software install system.
- Various bug fixes and stability enhancements.

Important:

- MPC software now collects anonymous usage information that will help us improve its stability. If you want to opt out of this service, please deselect Collect usage statistics in the Other tab of the Preferences.
- MPC 1.9 no longer supports RTAS plugin formats. A 32-bit AAX plugin is available for Pro Tools® 10 alongside the 64-bit AAX for Pro Tools 11 and higher.

Hardware:

- To switch the master tempo on or off, press Shift+Tap Tempo.
- In Sample Record Mode, if the recording duration is more than 60 seconds, the time is now shown in minutes:secs.
- To view the master outputs, press Shift+Seq Edit. This page shows the Vintage Mode state, insert effects, mute state, level, and panning for each master output.
- Minor workflow improvements for MPC Renaissance and MPC Studio users.
- Various bug fixes and stability enhancements.
Corrections for the MPC v1.8 User Guide

Vintage Mode Availability: User Guide 1.8 previously stated that MPC Renaissance users must be using MPC Renaissance as their computer’s sound card in order to use Vintage Mode effects. This is actually not true; Vintage Mode effects are available regardless of your computer’s sound card setting. This has been corrected in Operation > General Features > Transport Section Section (Page 76).

Truncation Duration: User Guide 1.8 did not include an explanation of Truncation Duration for the Sequencer tab in the Preferences.
Click the Truncation Duration drop-down menu to select if/how events are cropped if they exceed the length of the current Sequence:

- **To Sequence Length**: An event will be truncated if it exceeds the Sequence length. This ensures that the note will not overlap itself when the Sequence loops.
- **To Sequence End**: An event will be truncated to the end of the current Sequence if it exceeds the Sequence length. The event will stop playing when the Sequence loops.
- **As Played**: An event will play back exactly as it was recorded—even if events overlap themselves when the Sequence loops.

Number of Available Tracks: User Guide 1.8 previously stated that each Sequence could hold up to 64 Tracks. Each Sequence can actually hold up to **128** Tracks. This has been corrected in Operation > Track Mixer Mode (Page 156).
Trim Mode Pad Section: *User Guide* 1.8 contained outdated information about the Pad Section while using Trim Mode in Sample Edit Mode. This has been updated in *Operation > Sample Edit Mode > Trim Mode > Pad Section (Page 187)*.

**Keyboard Shortcuts:** *User Guide* 1.8 previously stated that Steinberg Cubase users need to combine all keyboard shortcuts with pressing *Alt*. This applies to Ableton Live 9 users, as well. This has been corrected in *Appendix > Keyboard Shortcuts (Page 238)*:

**Important:** When running MPC as a plugin in Ableton Live 9 or Steinberg Cubase, all keyboard shortcuts need to be combined with *Alt*. 